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Copyright © 2015 Telestream, LLC. All rights reserved. No part of this publication may
be reproduced, transmitted, transcribed, altered, or translated into any languages
without the written permission of Telestream. Information and specifications in this
document are subject to change without notice and do not represent a commitment
on the part of Telestream.

Telestream, Episode, Flip4AMac, FlipFactory, Flip Player, Lightspeed, ScreenFlow,
Vantage, Wirecast, GraphicsFactory, MetaFlip, MotionResolve, and Split-and-Stitch are
registered trademarks and Pipeline, Launch, and Videocue are trademarks of
Telestream, LLC. All other trademarks are the property of their respective owners.

QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour logo,
and the Bonjour symbol are trademarks of Apple, Inc.

MainConcept is a registered trademark of MainConcept LLC and MainConcept AG.
Copyright 2004 MainConcept Multimedia Technologies.

Microsoft, Windows 7 | 8 | Server 2008 | Server 2012, Media Player, Media Encoder, .Net,
Internet Explorer, SQL Server 2005 Express Edition, and Windows Media Technologies
are trademarks of Microsoft Corporation.

This product is manufactured by Telestream under license from Avid to pending patent
applications.

This product is manufactured by Telestream under license from VoiceAge Corporation
Dolby and the double-D symbol are registered trademarks of Dolby Laboratories.

Other brands, product names, and company names are trademarks of their respective
holders, and are used for identification purpose only.
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Third Party Library Notices

Episode 6.5

The following notices are required by third party software and libraries used in Episode.
The software may have been modified by Telestream as permitted by the license or
permission to use the software.

X264
Episode includes software whose copyright is owned by, or licensed from, x264 LLC.
SharpSSH2

SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. Redistribution and
use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors
may be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SQLite

The SQLite website includes the following copyright notice: http://www.sqlite.org/
copyright.html. In part, this notice states:

Anyone is free to copy, modify, publish, use, compile, sell, or distribute the original
SQLite code, either in source code form or as a compiled binary, for any purpose, com-
mercial or non-commercial, and by any means.

Libxml2

Libxml2 by xmlsoft.org is the XML C parser and toolkit developed for the Ghome
project. The website refers to the Open Source Initiative website for the following
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licensing notice for Libxml2: http://www.opensource.org/licenses/mit-license.html.
This notice states:

Copyright (c) 2011 xmlsoft.org

Permission is hereby granted, free of charge, to any person obtaining a copy of this soft-
ware and associated documentation files (the "Software"), to deal in the Software with-
out restriction, including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARIS-
ING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

PCRE

The PCRE software library supplied by pcre.org includes the following license
statement:

PCRE LICENCE

PCRE is a library of functions to support regular expressions whose syntax and seman-
tics are as close as possible to those of the Perl 5 language. Release 8 of PCRE is distrib-
uted under the terms of the “BSD” licence, as specified below. The documentation for
PCRE, supplied in the “doc” directory, is distributed under the same terms as the soft-
ware itself. The basic library functions are written in C and are freestanding. Also
included in the distribution is a set of C++ wrapper functions.

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel

Email local part: ph10

Email domain: cam.ac.uk

University of Cambridge Computing Service,
Cambridge, England.

Copyright (c) 1997-2010 University of Cambridge. All rights reserved.
THE C++ WRAPPER FUNCTIONS

Contributed by: Google Inc.

Copyright (c) 2007-2010, Google Inc. All rights reserved.
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THE "BSD" LICENCE

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of con-
ditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google Inc. nor the
names of their contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBU-
TORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARIS-
ING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSI-
BILITY OF SUCH DAMAGE.

Boost C++ Libraries

The Boost C++ Libraries supplied by boost.org are licensed at the following Web site:
http://www.boost.org/users/license.ntml. The license reads as follows:

Boost Software License—Version 1.0—August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a
copy of the software and accompanying documentation covered by this license (the
“Software”) to use, reproduce, display, distribute, execute, and transmit the Software,
and to prepare derivative works of the Software, and to permit third-parties to whom
the Software is furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above
license grant, this restriction and the following disclaimer, must be included in all cop-
ies of the Software, in whole or in part, and all derivative works of the Software, unless
such copies or derivative works are solely in the form of machine-executable object
code generated by a source language processor.

THE SOFTWARE IS PROVIDED “AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT
SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE
FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHER-
WISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.
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Libevent

The libevent software library supplied by monkey.org is licensed at the following
website: http://monkey.org/~provos/libevent/LICENSE. The license reads as follows:

Libevent is covered by a 3-clause BSD license. Below is an example. Individual files may
have different authors.

Copyright (c) 2000-2007 Niels Provos <provos@citi.umich.edu> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR “"AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.

IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLI-
GENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project

The FreeType Project libraries supplied by freetype.org are licensed at the following
website: http://www.freetype.org/FTL.TXT. The license reads in part as follows:
Copyright 1996-2002, 2006 by David Turner, Robert Wilhelm, and Werner Lemberg

We specifically permit and encourage the inclusion of this software, with or without
modifications, in commercial products. We disclaim all warranties covering The Free-
Type Project and assume no liability related to The FreeType Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in com-
pliance with this license. We thus encourage you to use the following text:

Portions of this software are copyright © 2011 The FreeType Project (www.free-
type.org). All rights reserved.
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Samba

Samba code supplied by samba.org is licensed at the following website: http://
samba.org/samba/docs/GPL.html. The license is a GNU General Public License as
published by the Free Software Foundation and is also listed at this website: http://
www.gnu.org/licenses/. Because of the length of the license statement, the license
agreement is not repeated here.

Ogg Vorbis

The Ogg Vorbis software supplied by Xiph.org is licensed at the following website:
http://www.xiph.org/licenses/bsd/. The license reads as follows:

© 2011, Xiph.Org Foundation

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

«Redistributions of source code must retain the above copyright notice, this list of con-
ditions and the following disclaimer.

«Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of the Xiph.org Foundation nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior
written permission.

This software is provided by the copyright holders and contributors “as is” and any
express or implied warranties, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose are disclaimed. In no event shall the
foundation or contributors be liable for any direct, indirect, incidental, special, exem-
plary, or consequential damages (including, but not limited to, procurement of substi-
tute goods or services; loss of use, data, or profits; or business interruption) however
caused and on any theory of liability, whether in contract, strict liability, or tort (includ-
ing negligence or otherwise) arising in any way out of the use of this software, even if
advised of the possibility of such damage.

LibTIFF

The LibTIFF software library provided by libtiff.org is licensed at the following website:
www.libtiff.org/misc.ntml. The copyright and use permission statement reads as follows:
Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation
for any purpose is hereby granted without fee, provided that (i) the above copyright
notices and this permission notice appear in all copies of the software and related doc-
umentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in
any advertising or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.
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THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY
OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

zlib

The zlib.h general purpose compression library provided zlib.net is licensed at the
following website: http://www.zlib.net/zlib_license.html. The license reads as follows:
Copyright (C) 1995-2010 Jean-loup Gailly and Mark Adler

This software is provided 'as-is, without any express or implied warranty. In no event
will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including com-
mercial applications, and to alter it and redistribute it freely, subject to the following
restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you
wrote the original software. If you use this software in a product, an acknowledgment
in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepre-
sented as being the original software.

3. This notice may not be removed or altered from any source distribution.
Jean-loup Gailly, Mark Adler

LAME

The LAME MPEG Audio Layer Ill (MP3) encoder software available at
lame.sourceforge.net is licensed under the GNU Lesser Public License (LGPL) at this
website www.gnu.org/copyleft/lesser.html and summarized by the LAME developers at
this website: lame.sourceforge.net/license.txt. The summary reads as follows:

Can | use LAME in my commercial program?

Yes, you can, under the restrictions of the LGPL. The easiest way to do this is to:

1. Link to LAME as separate library (libmp3lame.a on unix or lame_enc.dll on windows).
2. Fully acknowledge that you are using LAME, and give a link to our web site,
www.mp3dev.org.

3. If you make modifications to LAME, you *must* release these modifications back to
the LAME project, under the LGPL.

*** IMPORTANT NOTE ***

The decoding functions provided in LAME use a version of the mpglib decoding engine
which is under the GPL. They may not be used by any program not released under the

GPL unless you obtain such permission from the MPG123 project (www.mpg123.de).
(yes, we know MPG123 is currently under the LGPL, but we use an older version that
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was released under the former license and, until someone tweaks the current MPG123
to suit some of LAME's specific needs, it'll continue being licensed under the GPL).

MPEG Disclaimers

Episode 6.5

MPEGLA MPEG2 Patent

ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM
MPEG LA, LLC, 6312 S. Fiddlers Green circle, Suite 400E, Greenwood Village, Colorado
80111 US.A.

MPEGLA MPEG4 VISUAL

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN
COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO") AND/OR (ii) DECODE AVC VIDEO
THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-
COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED
TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY
OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE
HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON
ATITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA,
LLC. SEE <HTTP://WWW.MPEGLA.COM> FOR ADDITIONAL DETAILS.
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Limited Warranty and Disclaimers

Telestream, LLC (the Company) warrants to the original registered end user that the
product will perform as stated below for a period of one (1) year from the date of
shipment from factory:

Hardware and Media. The Product hardware components, if any, including equipment
supplied but not manufactured by the Company but NOT including any third party
equipment that has been substituted by the Distributor for such equipment (the
“Hardware”), is free from defects in materials and workmanship under normal
operating conditions and use.

Warranty Remedies

Your sole remedies under this limited warranty are as follows:

Hardware and Media. The Company will either repair or replace (at its option) any
defective Hardware component or part, or Software Media, with new or like new
Hardware components or Software Media. Components may not be necessarily the
same, but will be of equivalent operation and quality.

Software. If software is supplied as part of the product and it fails to substantially
confirm to its specifications as stated in the product user's guide, the Company shall, at
its own expense, use its best efforts to correct (with due allowance made for the nature
and complexity of the problem) such defect, error or nonconformity.

Software Updates. If software is supplied as part of the product, the Company will
supply the registered purchaser/licensee with maintenance releases of the Company’s
proprietary Software Version Release in manufacture at the time of license for a period
of one year from the date of license or until such time as the Company issues a new
Version Release of the Software, whichever first occurs. To clarify the difference
between a Software Version Release and a maintenance release, a maintenance release
generally corrects minor operational deficiencies (previously non-implemented
features and software errors) contained in the Software, whereas a Software Version
Release adds new features and functionality. The Company shall have no obligation to
supply you with any new Software Version Release of Telestream software or third party
software during the warranty period, other than maintenance releases.

Restrictions and Conditions of Limited Warranty

This Limited Warranty will be void and of no force and effect if (i) Product Hardware or
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration,
neglect, or shipping, or as a result of service or modification by a party other than the
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties

THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral
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or written information or advice given by the Company, its distributors, dealers or
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty. This limited warranty is valid only within the
country in which the Product is purchased/licensed.

Limitations on Remedies. YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any
Limited Warranty by the Company shall be the recovery of reasonable damages which,
in the aggregate, shall not exceed the total amount of the combined license fee and
purchase price paid by you for the Product.

Damages

TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream

848 Gold Flat Road

Nevada City, CA 95959

You can call Telestream at (530) 470-1300.
Part number: 161755
Publication date: May 18, 2015
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Preface

To obtain product information, technical support, or provide comments on this guide,
contact us using our web site, email, or phone number as listed in Table 1.

Table 1. Telestream Contact Information

Resource Contact Information
Technical Support | Web Site: http://www.telestream.net/telestream-
Information | support/episode-6/support.htm

Assistance | FAQs |

Support Web Mail. www.telestream.net/telestream-
Forums | Upgrades

support/episode-6/contact-support.htm

Telestream Web Site: www.telestream.net
Sales and Marketing Email: info@telestream.net

Telestream

848 Gold Flat Road

Nevada City, CA. USA 95959
530-470-1300

International Web Site: www.telestream.net

Distributor Support  gee the Telestream Web site for your regional authorized

Telestream distributor.

Telestream Technical Email: techwriter@telestream.net

Writers If you have comments or suggestions about improving

this document, or other Telestream documents—or if
you've discovered an error or omission, please email us.
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About Episode

Episode is a powerful application for transcoding video and audio files. It supports a
wide variety of media formats (both input and output), and enables you to modify
frame rate, audio levels, and other metrics, and perform many quality-improvement
operations.

Episode can ingest media files for transcoding directly from local disks, as well as
network file servers and hardware-based media systems. Episode can save transcoded
media files locally or on network file servers.

Episode is scalable: It can be installed on multiple computers to form a transcoding
cluster for parallel transcoding power and maximum speed via Telestream’s unique
Split-and-Stitch™ distributed encoding technology.

m Episode’s Major Features
m Three Episode Editions
m Episode Components

m Extended Media Format Support

Note: This guide is intended for users who are using the Episode graphic user
interface application. For users who are using the CLI or XML/RPC interface, or who are
using advanced features not available in the Episode graphic user interface
application, or who want information about Episode’s system architecture and
components, please refer to the Episode Advanced User’s Guide.
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Episode’s Major Features

Episode’s Major Features

Telestream Episode is an all-in-one, multi-format, cross-platform video and audio
encoding application for post-production and new media workflows. The following list
summarizes the most essential Episode features:

T~
telestream

Transcodes many compressed and HD formats:

AVC-Intra  Blackmagic « D-10/IMX « Discard « DV « Flash 8 Video (VP6) ¢« H.263 «
H.264 (MainConcept) « H.264 (x264) « HDV « HEVC « Image Sequences (DPX/JPEG/
TGA/TIFF) « MJPEG-1/2/4 » Pass Through ¢ QuickTime ¢ RGB Levels ¢ Targa Cine YUV
* VP8 & VP9 « Windows Media Video 9 « Windows Media Video VC-1 « Windows RGB
* XAVC « XDCAM HD « YCbCr Codec, and many other formats. ProRes is available for
MacOS X and also Windows Server 2008 |12, for Episode Engine.

Allows advanced conversions such as NTSC-PAL standards conversion and telecine
insertion and removal.

Includes full 10-bit 4:2:2:4 pro format support for optimized picture quality.

Provides an easy-to-use graphical workflow builder with pre-made templates that
monitors Watch Folders, automatically transcodes files as they are dropped in, and
delivers them to specified output folders.

Supports Adobe Premiere Pro with a plug-in panel that allows you to import and
select Episode encode and deployment tasks from within Premiere.

Includes one-click clustering with built-in file sharing and parallel batch processing
S0 you can assign multiple Episode instances on networked computers to work on
transcoding tasks simultaneously, enhancing transcoding speed.

Provides Split-and-Stitch distributed and segmented encoding that you can use to
split up a large video file into smaller, segmented encoding tasks that operate in
parallel. The video segments can be worked on by several nodes in a cluster and
then stitched back together to more quickly provide finished output.

Includes fully configurable advanced preprocessing filters, such as black and white
restoration, HSV and gamma correction, noise removal, image sharpening, as well
as audio normalization, balance, fade in/out, and others.

Provides preview functionality for before and after comparison.
Allows adding bumper and trailer intro and outro movies to content.
Permits adding picture-in-picture animation or movie watermarks.

Greatly improved audio channel mapping with automatic and preconfigured selec-
tions. Supports 5.1 and 7.1 channel surround sound encoding and easy up or down
conversion.

Optional, licensed Pro Audio option adds support for Dolby AC-3, AAC-HE, AAC-LC,
and AMR audio codecs.

Offers improved closed caption support.
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Three Episode Editions

Episode is offered in three editions, plus an enhanced audio option, to better meet your
encoding requirements:

Episode encodes your video files one file at a time and includes many workflow
options, clustering capabilities, and codecs. For details on supported input and output
media formats, see Media Containers/Formats.

Episode Pro adds support for encoding files in parallel, provides the VC-1 codec, image
sequences, multi-bit rate (MBR) streaming file support and additional output formats:
GXF, MPEG-2 Transport Streams, and MXF.

Episode Engine includes all the formats of Episode Pro and adds maximum parallel
encoding, plus Split-and-Stitch encoding to fully utilize the power of high-
performance, multi-core computers.

Pro Audio Option—all editions of Episode can be enhanced with the Pro Audio Option,
adding support for AMR, Dolby AC-3, ATSC A/52, and High Efficiency AAC audio codecs.

Episode Components

Generally, you can think of Episode as a desktop program with a graphical user
interface used to configure workflows and encode media. However, Episode also
consists of several underlying services—a set of several independent, cooperative
processes (programs without a user interface):

» Episode Assistant Service performs various user interface support tasks, such as
processing workflow changes, exporting files, and so on.

» Episode IOserver Service makes files available to other nodes in the cluster.

» Episode Node Service communicates with other nodes in the cluster and starts
EpisodeWorker processes to perform encoding tasks.

» Episode Client Proxy Service provides the interface between client programs
including Episode (the graphic user interface program), programs utilizing the
XML-RPC interface, and the command line interface (episodectl).

» Episode XML-RPC Service interfaces between client programs which implement
the XML-RPC interface and communicate with Episode Engine.

Extended Media Format Support

Episode 6.5

Support for media formats (input and output) can also be extended by installing
Telestream and third-party QuickTime components, such as Flip4Mac Windows Media
Components for QuickTime.

Episode can also ingest files from Telestream's Pipeline—a powerful, network-based,
real-time media processing—appliance. For more details, see the Pipeline topic on our
Web site: www.telestream.net.
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Installing Episode

Use this chapter to install, upgrade, or uninstall Episode, Episode Pro, or Episode Engine
for Windows.

During installation and upgrade, it is important to review and perform the tasks in each
topicin order:

m Platform Requirements

m Pre-requisite Subsystems

m Downloading and Installing Episode

m Installing an Episode Cluster

m Configuring Episode

m Purchasing a License & Registering Episode

m Upgrading Episode

m Removing Episode from your Computer

Note: Telestream recommends that you do not install Episode on a computer that is
currently hosting FlipFactory, Vantage, or other media processing applications:
intense disk and CPU consumption can interfere with proper operation of both
programs.

Be sure to review and meet platform requirements before installation.

S
telestream



34 | Installing Episode
Platform Requirements

Platform Requirements

All Episode editions for Windows have the following minimum system requirements:
» Windows 7, 8.1, or Server 2012: 1.5 GHz, 32-bit (x86), 4 GB RAM, 40 GB hard drive
QuickTime v7.6.2 or higher

Bonjour Print Services for Windows v2.0.2
.Net Framework 3.5 SP 1
.NET Framework 4.0

* Online Help Browser: Internet Explorer 8 or higher, or Firefox 6 or higher

Make sure that your computer meets these requirements before installing Episode.

Cluster Platform Requirements

When running Episode in a mixed-platform cluster, jobs requiring QuickTime are only
submitted to nodes running on the same platform as the submitting node, because
QuickTime does not support the same codecs across platforms.

If you are using third-party QuickTime components, make sure that the same
components are installed on all nodes on each platform.

All computers in an Episode cluster must be on the same subnet.

Pre-requisite Subsystems

The following subsystems are required before installing Episode for Windows:

QuickTime

Episode requires QuickTime 7.6.2 for Windows or higher. Before installing/updating
QuickTime, stop Episode installation if it is in process. Install or update QuickTime for
Windows from Apple’s Web site (www.apple.com/quicktime/download/).

Bonjour for Windows

Episode requires Bonjour for Windows. Before installing/updating Bonjour, stop
Episode installation if it is in process (if Bonjour is not installed, the Episode installer will
not complete). Obtain Bonjour Print Services for Windows v2.0.2 or later from Apple’s
Web site (support.apple.com/kb/dI999), and install it.

.Net Framework

Episode for Windows requires .Net Framework 3.5 Service Pack Tand .NET Framework
4.0. Before installing/updating .Net, stop Episode installation if in process. Obtain .Net
from Microsoft's Web site (microsoft.com).
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Pre-requisite Subsystems

Next, proceed to Downloading and Installing Episode.

Note: If you stopped installation to install a subsystem, restart the installer.
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Downloading and Installing Episode

When you install Episode, it installs the program and related software, then creates a
program entry in All Programs > Telestream > Episode. It also places an Episode
shortcut on the desktop.

Note: If your computer is not connected to the Internet, download the installer using
an Internet-connected computer and move the installer to the target computer.

Downloading the Installer

The Episode installer is located on Telestream’s Web site (www.telestream.net/episode/
overview.htm) as a zip file.

To download and install Episode (after verifying that you have met the platform
requirements and installed the required subsystems), follow these steps:

1. Download the installer zip file (Episode_V_MM_DD_YYYY.zip) to your desktop or
other folder.

2, Right-click on the folder and select Extract All to run the Extraction Wizard and
follow the steps to extract the installer files.

3. When extraction completes, Windows displays the extracted files in the new folder
(Episode_V_MM_DD_YYYY).

4, Open and read the Release Notes text file.

5. Double-click the installer file (Episode<Version>setup.exe) to run the Episode Setup
Wizard.

6. Follow the steps in the Episode installer to install Episode for Windows.

Note: Be sure to read the entire End-User License Agreement, and only click the |
accept the terms in the License agreement button and continue if you do agree with
the entire terms of the agreement.

If installation is interrupted because of a missing or obsolete subsystem, install/update
the subsystem and then restart the installer.
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Installing an Episode Cluster

Installing multiple copies of Episode (where each installation is referred to as a node) as

a cluster requires that all computers in the cluster must be part of the same subnet or
reachable by IP address or DNS host name of the cluster master.

Follow the steps for installing Episode on each computer that comprises the cluster.

During operation, each node automatically identifies and communicates with each
other instance in the cluster.

Each node that you intend to use as an encoder (rather than editing workflows and
submitting them to other nodes) must be registered.

Note: If you have multiple computers running on an XSAN or other shared storage
system, Episode may invoke its 10 Server and send the media over a slower network
connection. To prevent this behavior, make sure the shared storages have the same
mount points on all computers. For more information, see Episode clustering and file
sharing don’t work.

Installing the Episode Premiere Plug-in

Follow these steps to install the Episode Adobe Premiere Pro Create Cloud plug-in:
1. Install Adobe Premiere Pro on your computer according to Adobe’s instructions.

2. Install Episode on the same or a different computer according to the instruction
guide. Episode also requires QuickTime and .NET 3.5 SP1.

3. Install Bonjour Print Services on the Premiere and Episode computers.
4, Install the Episode Premiere Pro Plug-in on the Premiere Pro computer.

Once installation is complete, the plug-in is ready to use with Premiere and should
simply be present and functioning when you open Premiere the next time.

Uninstalling the Episode Premiere Plug-in

Episode 6.5

On Windows, if you need to uninstall the plug-in, use Control Panel > Programs and
Features, select the Episode Premiere Pro Plug-in, and select Uninstall.

On the Macintosh, you need to run a special uninstaller program:
1. Open a Terminal window.
2. Type the following to access and run the uninstaller program:
a. cd Library/Application Support/Adobe/Episode/
b. sh uninstall.sh

The plug-in will be removed, but any epitasks you've created will remain.
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Configuring Episode

In most cases, no setup is required after you install Episode. However, some versions of
Windows or uses of Episode may require some setup tasks.

Windows Server 2012 DEP Setup

When using Windows Server 2012, you may encounter an issue in which the Episode
application does not have permission to run. To resolve this, you can set the Windows
Data Execution Prevention (DEP) option to allow Episode to run.

1. Open the Windows System control panel.
2. Select Advanced System Settings. The System Properties panel opens.

3. In the System Properties panel, select the Advanced tab and click Settings. The
Performance Options panel opens.

4. In the Performance Options panel, select the Data Execution Prevention tab.

5. In the Data Execution Prevention tab, select the top option: Turn on DEP for
essential Windows programs and services only. This allows programs that are not
part of the Windows operating system, including Episode, to run without DEP
monitoring.

Alternatively, if you need the extra security provided by DEP for your other programs,
you can leave DEP on but enter Episode as an exception that gets excluded from DEP
monitoring:
6. Follow the steps above, but select the bottom option in the DEP tab: Turn on DEP
for all programs and services, except those | select.

7. Click Add, browse for Episode, and double-click on Episode.exe. The default path
for Episode is C:/Program Files/Telestream/Episode 6/bin/Episode.exe. When
properly selected, Episode appears with a check mark in the DEP panel list.

8. Click OK to save the new setting and close the Performance Options panel, and also
click OK to save and close the System Properties panel.

Running Episode as an Administrator

In order for Episode Windows services to run correctly, the Episode user usually needs
to have Local Administrator or Administrator privileges. If you already have these
privileges, no further action is required. If you are unsure and need to check or change
your privileges, follow these steps:

1. In the Windows User Accounts control panel, click Manage User Accounts.

2. In the User Accounts panel, click your user name and then Properties. The Group
Membership panel opens. If you cannot display this panel, your system
administrator may need to make this change for you.

3. In the Group Membership panel, select the Administrator button. This assigns
administrator privileges to your user account.
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Running Episode as a Non-Administrator User

Episode 6.5

For security purposes, your organization may not allow your user account to have
administrator privileges.

If Episode is not running under a user with administrator privileges, you can not make
changes in Preferences.

When not running Episode as an administrator, an administrator can set Windows to
run only the Episode services as an administrator from a non-administrator user
account, although this method of accessing Episode is not recommended and may
produce unexpected results.

To set up non-administrator access, an administrator can specify the administrator user
directly in Episode > Using the Advanced Tab, or outside of Episode, using the Windows
Services control panel. The user should now be able to run Episode without being an
administrator, and Episode itself will log in with administrative rights.
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Purchasing a License & Registering Episode

An unlicensed copy of Episode is fully functional and allows you to build workflows and
submit media for transcoding testing. In a cluster, you can also use unlicensed copies of
Episode to build workflows and submit media to other nodes which are licensed, for
transcoding.

Note: Copies of Episode in a cluster that are only used to edit workflows and submit
jobs do not require that you purchase a license.

However, when encoding without a registered license, Episode places a watermark on
the video in the output file, and video pass through is not allowed. Episode encodes
audio files for up to 30 seconds or one half of the duration if less than 30 seconds.

If your computer is connected to the Internet, the easiest way to register is to purchase
a serial number directly in Episode—proceed to Purchasing a License Directly in Episode
and Registering It.

You can also purchase a serial number via a Web browser (go to www.telestream.net/
episode/overview.htm) and then register it in Episode—proceed to Registering Episode
with a Separately Purchased License.

Note: If your computer does not have Internet access, do not use this section. Instead,
use a separate computer with Internet access to open the Manual Activation Guide on
the Telestream Web site (http://www.telestream.net/pdfs/user-guides/
Manual_Activation_Guide.pdf). The guide provides a step-by-step procedure to
manually activate Episode after purchasing a license.

m Purchasing a License Directly in Episode and Registering It

m Registering Episode with a Separately Purchased License
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Purchasing a License Directly in Episode and Registering It

1. To purchase a license directly in Episode, follow these steps: Select Tools >
Preferences and click on the License tab.

Figure 1. License Tab

57 Preferences

General Cluster Update Advanced

License Key | Status | Serial Number

Episode Engine Activated
Pro Audio Option Activated
Advanced API Option Activated
X264 Option Activated

L Click Add to purchase or enter a license and activate it.

2, Click Add to display the Add License dialog.

Figure 2. Add License Dialog
o7 Add License ﬂ

Serial Number:  PE61100-XC00X-XXXX-XHXX-X00-X000C Purchasz

Ok

Click Purchase to obtain a license, ~——

3. Click Purchase to display the online Telestream Store main page, which is an e-
commerce site with a standard shopping cart interface.

4, Follow the steps in the store to purchase Episode for your platform plus Episode
options. When the transaction for your order is complete, the store displays a
receipt (which you should print and save), and includes the serial number.

5. Close the order receipt window—Episode automatically enters the serial number
you received into the Serial Number field.

6. Click OK to activate the license for this copy of Episode, and close the dialog. Then,
click OK to close the Preferences window.

Quit Episode (File > Exit) and re-start it to use it in activated mode.

This copy of Episode is now registered and you can encode media without the
watermark or time limits.

/'_'\
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Registering Episode with a Separately Purchased License

Use this section to enter and activate a license you purchased separately.

1. Select Tools > Preferences and click on the License tab.

Figure 3. License Tab

57 Preferences

General Cluster Update Advanced

License Key | Status | Serial Number

Episode Engine Activated

io Option Activated
Advanced API Option Activated
X264 Option Activated

L Click Add to purchase or enter a license and activate it.

2. Click Add to display the Add License dialog.

Figure 4. License Tab

wr Add License

Serial Number:  PE61100-XC00X-XXXX-XHX0-X00-X000C Purchase

Ok

Click OK after entering the license. —

3. Enter the serial number into the Serial Number field.

4, Click OK to activate the license for this copy of Episode, and close the dialog. Then,
click OK to close the Preferences window.

5. Quit Episode (File > Exit) and re-start it to use it in activated mode.

This copy of Episode is now registered and you can encode media without the
watermark or time limits.
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Upgrading Episode

Episode upgrades are periodically posted on the Telestream site at
www.telestream.net/episode/overview.htm. Go to that page and click Support >
Episode > Upgrade—upgrades are displayed in the right column.

Download the upgrade you want to install. Before upgrading the version, be sure to
remove the previous version of Episode. See Removing Episode from your Computer,
below.

Then follow the instructions in Downloading and Installing Episode to install the new
version of Episode on your computer.
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Removing Episode from your Computer

To uninstall Episode from your Windows computer, display Control Panel > Add/
Remove programs. Select Episode and click Remove.

Note: If uninstalling Episode fails, open the Services control panel and manually stop
each Episode service, then retry.

If you have installed an Episode cluster (individual copies of Episode on more than one
Windows computer), perform this task on each computer where Episode is installed.

For details about removing Episode for MacOS X nodes, see the Episode for MacOS X
User’s Guide > Installing Episode > Removing Episode from your Computer.

Removing the Episode program from a computer does not remove any workflows
you've made, or any media you've saved on the computer.
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Getting Started

The more you know about Episode, the better it can meet your encoding requirements.

The best way to get up and running quickly is to jump right in. In these short guided
tours, you'll learn how Episode is designed to work.

When you've completed the tours, you'll be ready to design and implement workflows
for the kinds of encoding work you want to perform.

You'll be able to submit media manually and automatically, and jobs as Episode goes to

work—transcoding and delivering your media—in the right format, to the right place,
at the right time.

m Tour 1: Episode Concepts

m Tour 2: Encoding Your First Media File

m Tour 3: Editing Workflows

m Tour 4: Automating Workflows with Watch Folders
m Tour 5: Cluster Encoding
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Tour 1: Episode Concepts

This tour introduces the main components of Episode. If you haven't yet done so, start
Episode and take a minute to explore the panels of Episode’s main window.

Figure 5. Main Episode Window

Media browser panel. Library Tabbed Tasks panel. Inspector panel.

Status panel. Workflow panel.

Episode’s main window is comprised of five panels.

The Media Browser on the left is a two-level panel where you can create and browse
bookmarks of key directories on your local computer and network servers. These
bookmarks allow you to gain quick access to the media files and folders you use in your
encoding workflows.

The top center Library Tasks panel provides tabs for Workflows, Sources, Encoders, and
Deployments (you'll be introduced to these in Tour 2).

Directly below the Library Tasks panel is the Workflow panel, where you can view, create
and edit workflows—combining tasks into a workflow, which specifies (among other
things) how to encode a source file and where to save the output file or files.

The right panel is the Inspector panel, where you review and configure the settings of
the currently-selected task to customize your workflow.

The Status panel displays all of your jobs and their details. On the Mac, the Status panel
opens in a separate window when you click Submit or select Window > Show Status.
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Workflows

The way you specify how you want to encode your media in Episode is the workflow. A
workflow describes where new source files to encode are located, how files are
encoded, and where the newly-encoded file or files are saved. When a new file is
identified, a job is created for each source file, containing all the tasks in the workflow.
Then Episode goes to work - decoding the source file, encoding it per your Encode task
configuration, and deploying the file to the location you've specified.

At a minimum, a useful workflow consists of three tasks: a source, an encoder, and a
deployment. You can customize all three types of tasks to accomplish your specific
transcoding purposes.

Figure 6. Typical Three-task Workflow

File List Encoder Deployment

T pre—
1 Files 5 TUMP3 192kbic y

A source task may consist of a single file or a list of files. It may also use a Watch Folder
on local disk, an FTP server, or a network server. New media files placed in this directory
are retrieved (localized) and encoded.

Figure 7. Typical Watch Folder Source Task

Watch Folder

Incoming

A Watch Folder (named “Incoming” in the figures) is checked at regular (user-settable)
intervals for new files. When a file is saved in the Watch Folder, it is identified and a job
is scheduled for encoding. However, writing the entire media file to the folder takes
time and the file cannot be encoded until the file transfer is complete, so Episode polls
the file to see when it has been completely written and released. Only then is the
encoding job submitted.

While it is possible to set up multiple Watch Folders to watch the same folder, this is
both inefficient and error-prone. It is better to set up a single Watch Folder for the
folder you want to watch and connect multiple encoders to that Watch Folder in one
workflow.
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Figure 8. Watch Folder with Default Settings

Encoder Tasks

Each encoder task contains a specification of how a source file should be encoded,
providing the output file format, which codecs should be used for encoding video and/
or audio data, what filtering operations should be applied to the data and whether or
not encoding should be performed as a Split-and-Stitch job.

While a workflow always contains a single source task (which may contain multiple
files), the source can be connected to an arbitrary number of encoder tasks, so that
each source file is transcoded into multiple output files.

Settings files from earlier Episode versions can be used, but you should always verify
that they have been correctly imported. For example, if the settings specify the use of
AAC audio and you don't have the Pro Audio Option, you must adjust the encoder
accordingly. You should also save legacy settings files to the Library and then drag
them from the Library to use them; this upgrades the files to the current settings file
format and changes any discontinued settings to the closest available alternative.

Figure 9. Typical Encoder Task

Encoder
P

iPod_240p
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Split-and-Stitch Encoding

In Split-and-Stitch jobs, the source media is split into several segments, which are
encoded in parallel utilizing all available nodes in your cluster. The resulting output
segments are then stitched back together to form the output file, using all available
resources to reduce total transcoding time. Formats that have the hinted streaming
option checked cannot be processed using Split-and-Stitch. These formats are
automatically encoded as a regular job even if you specify Split-and-Stitch.

Note: In Split & Stitch jobs, deployment tasks execute on the same server as the stitch
task. This is done to minimize network file transfer inefficiencies. The only way to
disable this feature is to use the XML/RPC interface.

The decision to use Split-and-Stitch depends on what kind of jobs you typically
encounter. If you have a steady influx of many files, the files will be encoded in parallel
anyway, so you can make the best use of resources by avoiding the overhead of Split-
and-Stitch. Additionally, if your source files are relatively small, little time will be gained
from employing Split-and-Stitch.

However, if you have many Episode nodes and you often process single large files, or
process a few large files simultaneously, and you need them encoded as quickly as
possible, then Split-and-Stitch is the right choice.

Jobs that shouldn’t be held up by long-running Split-and-Stitch jobs can be run at a
higher priority, enabling these jobs to go to the head of the queue.

If you have several Episode installations, you can divide your computers into two or
more Episode clusters, and dedicate one cluster to high-priority jobs.

Figure 10. Split-and-Stitch Example
- S —— PP ChucksAppleTV 1280x720p24 16x9

Encoder

Task Name  ChucksAppleTV 1280x720p24 1603

~  Spiit & Stitch Split-and-Stitch
Split-and-Stitch v
Minimum Split Duration 30
{sec)

Maximum Mumber of Video 15
Splits

Split on GOP size 1

Use Local Cache

Encoder Deployment

—

/_'\
Episode 6.5 telestream



50‘

Getting Started
Tour 1: Episode Concepts
Deployments
A deployment specifies where the output file from an encoder task is stored. The store
may be a directory on local disk or a network server, or it may be an FTP-based Internet
media service, such as YouTube. Each encoder task may be connected to multiple
deployment tasks, so that each output file can be stored in several different places.
Figure 11. Typical Deployment Task
Tasks
Task is the general term for the activities in a workflow and generally refers to source
tasks, encoder tasks, and deployment tasks. Episode offers a variety of predefined tasks,
but you can always modify these tasks (or create your own) and then store these as user
tasks. Tasks are stored as XML files and can be easily sent to other users.
System tasks are located on your system drive, in \Program Files\Telestream\Episode
6\bin\resources\templates\tasks\.
User tasks are located in \Documents and Settings\<User>\My Documents\Episode
6\Tasks\.
Figure 12. Predefined System Encoder Tasks
== Workflows "™ Sources i P Deployments
Ll System Encoders.
Name
P aac 128kbit
P aac 160kbit
P aac seknit
P AC-3 51 384knit
P Ac3 51 s12kbit
Nodes

A node is an instance of Episode running on a computer. A node can either run alone or
it can be associated with a cluster. Any node can create a new cluster, and become the
master for that cluster. Other nodes joining that cluster become participants. Clusters
can be accessed on the local subnet or via IP or DNS host name. Jobs submitted at a
cluster node are routed via the master, which then sends them to a suitable node for
encoding.

If a master node leaves a cluster, no additional jobs can be submitted to that cluster
until the master rejoins the cluster. Also, when the master rejoins, it may not be the
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master, depending on the cause of its leaving the cluster; be sure to check its status
before submitting jobs.

Figure 13. Cluster Browser Showing Episode Nodes

5.7 Cluster Browser l =R éj

This machine (w-chuckp) is private

S Choose An Operation
Clusters Found On Local Network

.-'-.i b w-techpubstest

w-abdull

Nodes in a cluster can run on both MacOS X and Windows computers. Submitted jobs
are processed on any available machine according to the job scheduling policy—see
Setting Preferences—with the restriction that QuickTime encoding can only be
performed on a node running on the same type of platform as the node that submits
the job.

Note: MacOS X and Windows computers that share a SAN cannot directly share files
over that SAN because the path structures are different on the two operating systems.
However, the Named Storage feature of Episode allows files on SANs to be accessed by
both platforms. Please refer to Using Named Storage on page 116 for details.

Summary

In this tour, you learned about the main Episode window panels and components:
workflows, sources and Watched Folders, encoders, deployments, tasks, and nodes.
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Tour 2: Encoding Your First Media File

This tour takes less than 10 minutes and introduces you to using Episode.

Episode provides a wide variety of pre-configured workflows in its workflow library.
These pre-configured workflows are an easy way to get started, a convenient way to
encode most media, and allow you to modify the workflow to meet your needs.
Let's encode your first media file, using one of these pre-configured workflows.

1. If Episode isn't running, start it now.

2. Select the Workflows tab.

3. In the menu directly below, display only the workflows for Apple platforms—select
System Workflows > Apple Devices.

Note: If you don't have enough room to view the list easily, make the main window
larger or resize your panels to suit your needs.

4, Click and drag the iPhone SD workflow onto the Workflow panel below.

The iPhone SD workflow converts a source file into a format for playback on the iPhone
and saves the output in the same folder as the source file, with the proper extension.
This workflow contains a blank source task (far left) and two predefined tasks: an
encoder task (center) and a deployment task (right).

Figure 14. Typical Episode Workflow

5. Now, let’s add a file to be encoded by this workflow—select it from the Media
Browser—the panel on the left.

The top part of the browser displays bookmarks, directories that contain your
media files. Episode by default includes bookmarks for some common media direc-
tories (and you can add your own). To select a file, open a bookmark to display its
directories and files in the bottom panel. Select the file you want to submit by drag-
ging it onto the File List task in the workflow.

6. Open the Computer bookmark and navigate to a short file of your choice on your
computer.

7. Drag and drop the file onto the source box at the far left.

Figure 15. Adding Video to Workflow

VAT
telestream Episode 6.5



Getting Started | 53
Tour 2: Encoding Your First Media File

Notice that when you drop a media file onto the blank source task, Episode assumes
you want this workflow to be used for manual submission, so it automatically adds a
File List task.

8. Click the Submit button (located at the bottom right corner of the center panel) to
start the encoding job.

Episode displays the details of all currently-active encoding jobs in the Status panel. In
the absence of other jobs, your job quickly activates.

Note: If you're using Episode without a license, Episode displays a License Issue
window, notifying you that you do not have a license to encode media, and it applies a
watermark to the video. Click Yes, encode as demo to continue.

9. Select your job to display its progress (you can also display further details by
clicking on the triangle).

Figure 16. Status of Jobs

¥ | Any Workflow Status | ¥ || Any Job Status ¥ | Any Workflow Type | ¥

‘Submitted ¥ Progress
12/10/2013 25005 PM

When the job is finished, you can find the output file with an m4v suffix, in the same
folder as the source file you submitted.

10. Double-click the new output file to play it in QuickTime Player.

Encoding Multiple Files in the Same Workflow

To encode several files at the same time in the same workflow, select and drag all of the
source files onto the Workflow Editor (not the source task) panel. Episode adds the new
file references to the file list (which still includes the existing file), and you can click
Submit (as before) to encode all files.

If you want to remove an existing file from the list, click the file list—the file names are
listed in the far right panel. You can click the Delete button next to the file name, or
right-click on the name and click Remove.

Summary

You just learned how to start Episode, how to review a workflow in the Workflow Editor,
and how to submit a file for transcoding—and transcoded your first file.
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Tour 3: Editing Workflows

As easy as it is to select a pre-configured workflow and encode media, most workflows
must be modified to meet your particular encoding requirements—adding new tasks,
making changes to encoding settings, delivering media to a specific directory, etc.

In this tour, which takes less than 15 minutes, you'll learn how to modify workflows by
adding tasks and changing their settings.

Note: When you make changes to a workflow, Episode displays a diagonal Changed
banner in the upper right corner of the panel, to indicate that you should save your
changes.

In addition to encoding one or more files using the same encoder, you can encode files
with multiple encoders in the same workflow. For example, you can create or modify a
workflow that encodes media for the iPod, and simultaneously encodes the same file to
Flash and Windows Media Video.

Adding Encoder Tasks to a Workflow

1. If you quit Episode, start it again.

2. Select the Workflows tab at the top and display the Apple platforms workflows—
select System Workflows > Apple Devices.

3. Drag the iPhone SD workflow to the workflow editor.
4, Select the Encoders tab.

5. From the dropdown menu, select System Encoders, then scroll down and open the
Web > Download > Flash > Flash 8 folder to display only the encoders in the Flash 8
category.

Figure 17. Encoders—Organized by Category

~ 7] Sy=tem Encoders
[W] Broadeast Devices (GXF. MXF)
¥ ovD and Blu-ray
W] Editing Avid (MXF)
[ Editing Final Cut Pro (MOV) ] Fashs
[ Mobile and Deviges
[ standards Conversian
W] Transport Stresms (MPEG-Z, H264) P Flashs ALV 1280x720 16:9

P Flashe ALV 1920x1080 16x9

Name

P Flashs ALV 480380
P Flashe ALV 640360 169

P Flashs ALV 640x480

P Flashg ALV 3605540 169
» [ Windows Media {vC-1) P Flashs SWF 1280x720 16x3
+ (W] Streaming
I user Encodings

6. Drag the Flash8 FLV 640x480 task to the workflow editor just below the original
iPhone encoder. When you drop the encoder template, the new encoder task
connects to the File List task.
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Figure 18. Adding Encoders to Workflow

File List Encoder Deployment

—— — =
— _ —
1 Fle iPhone 640x4... s B As So

7. Now navigate to the WMV9 (Windows Media) encoders (select System Encoders >
Web > Streaming > WMV9) to display them.

8. Drag the WM9 1MBit task to the workflow editor below the bottom encoder. When
you drop it, the new encoder also connects to the File List task.

Notice that the new encoder tasks you just added don't yet have output destina-
tions. Instead of outputting your encoded files back to the source directory, let's
place the output in another directory.

9. Click and drag the Desktop directory from the Media Browser panel (at the far left)
and drop it directly onto the deployment task outline to the right of each new
encoder task to replace it.

If the encoder already has a destination and you want to add another, drop it below
the current destination. The new one is added to make the encoder send its output
to both destinations.

Note: You can also drop tasks on an existing task to replace it with the new one.

Figure 19. Adding Destinations to a Workflow
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(i Episode Encaded Videos
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~ W CaptureMedia
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B Ben_cD DETAILpng
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... to here to add it to your workflow.
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Editing Encoders

Several pre-configured encoder templates are supplied with Episode, but usually you
need to adjust their settings to suit your particular application or problem.

10. Select the iPhone 640x480 Letterbox encoder in the workflow editor. The inspector
on the right displays the current settings.

11. Select Video Encoder in the Output subpanel to display the codec parameters in
the bottom panel.

12. Change the codec to MPEG-4 using the small arrow at the right of the video codec
selection.

Figure 20. Inspector Panel for Encoders
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13. Change the Average Bit Rate to match the 1600Kbps rate of the other files.

Saving Encoders

When you change an encoder's settings, the change is immediately effective in the
current workflow, but the settings in the original encoder template have not changed.
The next time you add the iPhone 640x480 Letterbox encoder to another workflow, it has
its original settings.

This is an easy way to make changes for testing or one-time usage, but if you've made
extensive changes that you want to re-use, you should save the encoder task with its
new settings to the Library as a different template.

Lets start by renaming the encoder template.

14. Click on the Task Name field at the top of the inspector, and enter a new name. For
example, iPhone 640x480 Letterbox 1600.

15. Click Save as (at the bottom of the Inspector panel). Episode displays an explorer
dialog. You can determine where to save the encoder (by default, it is saved in User
Encoders), and also change the name. Click OK to save it.
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It may be difficult to find your modified encoder templates among all the others, so you
can choose User Encoders in the filter menu to display only the encoders you have
created yourself.

Figure 21. User-modified Encoder Templates

P Deployments

Saving Workflows

When you make changes to a workflow, you need to save it. When you save a workflow
(even with the same name as the system template workflow), it is saved in User
Workflows. To save the workflow using another name, enter the new workflow’s name
in the Name field at the bottom of the workflow panel.

16. Save your workflow by clicking File > Save Workflow As (Control-Shift-S) and
entering a name in the Save As window and clicking OK.

Episode saves your new workflow in Workflows > User Workflows.

Summary

In this tour, you learned how to add new tasks, and learned how to configure them
using the inspector. You also learned how to save encoders as templates, and how to
save workflows.

If you want to continue, just jump right into the next tour.
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Workflows with Watch Folders

Automating Workflows with Watch Folders

Manually submitting a file or list of files as input is useful for one-shot encodings, butin
a production environment you can automatically process source files arriving from
other users or systems. You can achieve this by using Watch Folders. A Watch Folder on
local or remote storage is monitored by an Episode workflow. When a file is saved in the
folder, Episode retrieves the file for processing in the workflow.

Let's configure the iPhone SD workflow with an Watch Folder.
1. Start Episode if it is not already running.

2. Open Workflows > System Workflows > Apple Devices > iPhone_Flash8 WMV_SD.
3. Create a new folder named CaptureMedia on your computer desktop.
4

. Back in Episode, in the Media Browser panel, click Add Bookmark (+). This creates a
new, untitled bookmark for a local folder. (You can also create bookmarks for FTP
servers and network servers).

5. Use the URL Browser Path menu to navigate to the CaptureMedia folder and click
OK. You can also use the drop-down menu to create bookmarks on other servers,
including an FTP server or network share (and SMB server—MacOS X only).

To connect to other servers, you will need to include your user credentials and a port
number (default 21).

If you wish to you use Secure Socket Layer (SSL) encryption for FTP data transfers, select
an option from the SSL Mode drop-down menu. Off does not use SSL. On enables SSL
but drops back to unencrypted mode if SSL fails. Force Control uses SSL encryption and
fails to connect if SSL fails. Force All uses SSL encryption for all traffic.

Figure 22. Adding a Bookmark
¥+ Url Browser [E=SIEl =
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6. To change the name of the bookmark, click the new bookmark, enter CaptureMedia
in the Bookmark Inspector name field and click OK.
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7. Drag the CaptureMedia bookmark from the Media Browser panel to the File List task
in the workflow editor. Because a folder was dragged in as a source task, Episode
knows you intend to create a Watch Folder.

8. Press Submit to start the workflow polling the Watch Folder for new files. Episode
displays the Status panel, and your new task is running.

Files that are added to the target directory are automatically submitted to a workflow.

Summary

In this tour, you've learned some advanced tasks—how to make and use bookmarks,
and how to implement Watch Folders to automate workflow processing.
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Tour 5: Cluster Encoding

If you have multiple copies of Episode running on different computers (nodes) on the
same network, they can form encoding clusters. In a cluster, encoding jobs are
distributed to maximize the throughput of the cluster to scale your processing power
and increase throughput.

Note: When operating as part of a cluster, deployment tasks always execute on the
same server as the encode task in the job. In Split & Stitch jobs, deployment tasks
execute on the same server as the stitch task. This is done to minimize network file
transfer inefficiencies. The only way to disable this feature is to use the XML/RPC
interface.

You can have different editions of Episode in the same cluster, and each one can
encode as many parallel jobs as its edition allows.

Joining a Cluster

1. If Episode is not running, start it again.

2. Display the Cluster Browser window (select View > Cluster Browser) to view the
clusters on your network.

Figure 23. Cluster Browser Window
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Notice that your node is identified as currently private.

To join a cluster, first make sure you don’t have any jobs running.

3. Select the cluster you want to join, and choose Join <cluster name> from the drop-
down menu.

Episode displays a warning: Any jobs currently underway will be stopped.

4, Click Yes to continue.

Note: If the cluster you want to access is not on your local subnet, you can access it by
IP address or DNS host name. Use the gear drop-down menu in the lower right corner
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of the Cluster Browser to select Join or Submit, and enter the address or host name of
the cluster master.

Figure 24. Joined Cluster
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Your computer has been added to the cluster you selected. You can now submit jobs to
the cluster, and other machines on the cluster can submit jobs to your machine. The
jobs are encoded by the best available computer.

Note: If you want to submit jobs from your machine to the cluster for processing, but
you do not want to receive jobs from other machines in the cluster, choose Submit
instead of Join from the drop-down menu.

Summary
In this tour, you learned about scaling up Episode to include several Episode nodes on

different computers, creating a cluster, and joining each node to the cluster to perform
large-scale parallel encoding.
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Use this chapter to learn about using the main Episode window and its panels, plus the
Preview and Cluster windows, setting preferences, and using online help. These topics
are presented:

m Episode’s Workflow Window

m Using the Media Browser Panel

m Using the Library Panel

m Using the Workflow Editor Panel

m Using the Inspector Panel

m Using the Status Panel

m Using the Preview Window

m Using the Cluster Window

m Setting Preferences

m Using the Episode Premiere Plug-in

Note: If you haven't yet taken the tours in Getting Started, we encourage you to do so.
It's a great way to learn the basics of Episode and quickly gain hands-on experience
using the application. After completing the tours, use these topics as reference, for
detailed instructions when using Episode.

Episode’s Workflow Window

The Workflow window is Episode’s main window, where you perform most of your
work. You use the Workflow window to create and edit workflows, submit jobs, monitor
jobs in progress, and manage your source files and output deployments.
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Figure 25. Workflow window
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Status panel

The Workflow window is comprised of five panels, each designed to help you with
workflow creation and management—the Media Browser, Library, Workflow, Inspector,
and Status panels. The main window also includes a toolbar at the top, which is
discussed later in this section. You can adjust the size and layout of each of panel by
grabbing and dragging its border handles to suit your needs.

Using the Media Browser Panel

The left-most panel is the Media Browser panel, a two-level panel where you can browse
directories and files on your local computer and network servers, and create
bookmarks for the directories you use most. These bookmarks provide quick access to
media files and folders to use when creating your workflows.
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Figure 26. Media Browser—Easy Access to Your Media
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You can use the Media Browser panel in the same way you use Windows Explorer.

You can create bookmarks that identify folders on local drives, FTP sites, Wiretap
servers. You can also create bookmarks for shares and using SMB (MacOS X only) to
identify network-based media folders. (If the server is not available, of course the media
files in those directories are not available either.)

Storage devices such as internal and external hard drives, USB storage devices, and
browsable storage on digital cameras are also displayed in the Media browser.

Bookmarks make it easy to submit media for processing. Bookmarks also make it easy
to configure monitored folders for source tasks and destination directories for
deployment tasks. Just add the bookmark, configure it with your target directory, and
drag and drop it in place in your workflow.

You select a bookmark or device to display its files and folders in the bottom half of the
Media Browser. If the bookmark points to an FTP site, Wiretap server, or network share/
SMB server, it may take a moment to connect.

You can drag media from any bookmark in the Media Browser directly onto the
Workflow Editor, and then submit it for processing.

You can optionally use the arrows to expand or collapse the Media Browser panel,
which displays on the left side of the Workflow window. These topics explain the Media
Browser panel:

m Working with Bookmarks

m Configuring FTP, Wiretap, and Share/SMB Bookmarks

m Changing File Views

m Manually Submitting Files to a Workflow

m Configuring Source and Deployment Tasks with Bookmarks
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Working with Bookmarks

The Media Browser panel includes buttons and context menus for various bookmark
functions. You can also access some of these functions in the Media Browser menu at
the top of the Episode main window.

In Episode, you can bookmark a local folder, and FTP or SMB directory (for network and
Internet-based locations), and an Autodesk Wiretap directory. These topics explain how
to work with Bookmarks:

m Adding a Bookmark

m Configuring a Bookmark

m Deleting a Bookmark

m Working with Bookmark Folders

m Working with Files in the Media Browser

Adding a Bookmark

To add a bookmark, use one of the following methods:

» Click and drag a folder from Windows Explorer into the top pane of the Media
Browser

o Select Media Browser > Add Bookmark
 Click the Add Bookmark button at the top of the panel

» Right-click in the Media Browser open area and select Add Bookmark.

Configuring a Bookmark
When you drag a folder from Windows Explorer, you automatically configure it.

When you create a new, untitled bookmark by the other methods, Episode displays the
URL Browser to help you configure it. How you configure it depends on the type of
bookmark you want to create.

To edit an existing bookmark’s settings:

Select it in the Media Browser to display it in the Inspector. Click Edit to display the URL
Browser to view and configure settings.

When you update the settings in the URL Browser, click OK to save the changes or
Cancel to abandon your changes.

VAT
telestream Episode 6.5



Using Episode | 67
Using the Media Browser Panel

Figure 27. Bookmark Inspector and URL Browser (when bookmark is selected)
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Configuring a Local Directory bookmark is simple: optionally, change the name, and
change the location by entering or navigating to and selecting the proper path to the
directory.

Configuring FTP, share/SMB and Autodesk Wiretap bookmarks is more complex. For
details, see Configuring FTP, Wiretap, and Share/SMB Bookmarks.

Deleting a Bookmark

To delete a bookmark, use one of these methods:
 Select the bookmark and press the Delete key
* Select Delete (Del) from the Edit menu
« Right-click the bookmark and select Delete

Deleting a bookmark does not delete files or folders. It just removes the shortcut in
Episode that identifies the source of the bookmark.

Working with Bookmark Folders

To work with bookmark folders:
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Right-click a bookmark to display a context menu with these options:

Add as Watch Folder. Add as a Watched Folder source to the current workflow
Add as Deployment. Add the folder as a deployment to the current workflow
Delete Bookmark. Delete the selected bookmark

Refresh. Update the selected bookmark’s folder contents list

Open in Explorer. Open the bookmark in Explorer

When you highlight a bookmark, information about it and additional options display in
the Bookmark Inspector panel.

FTP, Wiretap servers, and network share (SMB) servers require configuration in the URL
Browser to make bookmarks for them (see Configuring FTP, Wiretap, and Share/SMB
Bookmarks). When these servers are mounted in Windows Explorer, they are treated as
local folders. However, the connection is not automatically reinstated if lost or if the
server is unmounted. For this reason, it is better to make bookmarks that connect
directly to the remote location.

Working with Files in the Media Browser

To work with files in the Media Browser bottom panel:

Right-click a file to view a context menu offering these options:

Add to Workflow. Adds the file as an input file list to the current workflow
Preview. Opens the file for viewing in the Preview window

Open in Explorer. Opens the folder containing the file in Explorer

Open With Associated Program. Opens the file using the program assigned to that
file type by the operating system

When you highlight a file, information about it and additional options appear in the
Inspector panel, including the option to preview the file in the Inspector panel Quick
Preview window for some file types.

Configuring FTP, Wiretap, and Share/SMB Bookmarks

FTP, Wiretap, and SMB/network share bookmarks require more configuration than
bookmarks for local files systems. (Note that directories on an FTP or SMB/network
share server running directly on your computer can be configured using a local
bookmark.)

Episode supports FTPS (encrypted FTP over SSL/TLS) for FTP servers and includes an
SSL Mode selection controlling how SSL is used.

To configure one of these bookmarks, follow these steps:
1. Click Add Bookmark to create a new bookmark and display the URL Browser.
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Figure 28. URL Browser
w7 Url Browser [‘:' = éj

2. In the URL Browser, select the Protocol popup menu and select FTP | Network Share
(SMB) | Autodesk Wiretap. (FTP is shown in the figure.)

3. Configure the settings listed below and click Apply to update the bookmark and
test your connectivity.

Host. Enter the host name or IP address of the server, in the form 792.168.1.7 |
myftpserverdomain.com | myServername.
Don't add the smb.//, ftp://, or wiretap:// prefix to the server name or IP address.

Share. Manually enter the path or navigate to the target folder and select it. A network
share, for example, C:\folder1\folder2\shared could be named Shared assuming Shared
is the share name. You can also double-click the folder if it appears in the contents box,
to add it to the path.

User. Enter the authorized user name to log in to the server.
Domain. Manually enter the domain name for the target share.
Password. Enter password for the user name you supply.

Port. The TCP/IP port number used to connect to the server. Default for SMB: 445, for
FTP: 21, for Wiretap: 7549.

SSL Mode (FTP only). Controls FTP Secure Socket Layer (SSL) for secure data transfer:
Off. Disables SSL. All transmissions occur using an unencrypted FTP connection.
On. Enables SSL encryption and falls back to a clear connection if SSL fails.

Force Control. enables SSL encryption and fails to connect if SSL fails.

/_'\
Episode 6.5 telestream



70 | Using Episode

Using the Media Browser Panel

Force All. Enables SSL encryption and ensures that all traffic is encrypted.

Open. Click Open to attempt to connect. If connection is successful, Episode displays
the directories in the contents pane.

OK/Cancel. Click OK to update and save the bookmark, or click Cancel to cancel the
bookmark.

A yellow exclamation icon indicates incorrect server information. If you can connect, the
Contents list displays the server's folders. If not, correct the configuration and try again.

Proxy servers are not supported for FTP.

Changing File Views

Use the Media Browser Views buttons (in the bottom left corner) to change views in the
file list.

Icons. Select to view files as icons on a grid.  **

List. Select to view files as a list. .=

Manually Submitting Files to a Workflow

To manually submit a file to a workflow:

1. Navigate to and open the directory containing the media using the Media Browser
panel.

2. Drag and drop the media files on the Source task, which becomes a File List (if it
isn't already). You can drag and drop local media files from Windows Explorer to the
source task.

3. Click Submit to start processing your workflow.

Note: To add files or a directory from a network location, it is best to create a
bookmark for that location as described in the next section. Bookmarks completely
define all information required to access a network location. If you drag a file or folder
from Windows Explorer, the location information might be incomplete and the
location unavailable
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Configuring Source and Deployment Tasks with Bookmarks

You can easily configure your source and deployment tasks using a bookmark. You can
add a local, FTP or network share (SMB) directory to a source. You can add a local, FTP,
Network Share (SMB), or Wiretap directory as a deployment.

Drag and drop the selected bookmark from the Media Browser directly on the source or
deployment task placeholder. (You can also drag and drop files directly from Windows
to create local file lists.)

After you add the bookmark to your workflow, you need to configure it for use. For
configuring source monitors, see Configuring a Watch Folder Source Task. For
configuring deployment tasks, see Configuring a Deployment Task.

For information on creating and configuring bookmarks, see Configuring FTP, Wiretap,
and Share/SMB Bookmatrks.

Using the Library Panel

The top center Library panel is tabbed. All of Episode’s workflow resources are stored in
the library, and organized by Workflows, Sources, Encoders, and Deployments tabs.

Figure 29. Library Panel
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Click a tab to see the corresponding lists of system and user resources for each task
type. For example, to see available encoders, click the Encoders tab, and then click the
popup menu below the tab for a list of system and user Encoder resources.

The Library panel is where you save your configured workflows, and your source,
encoder, and deployment tasks for use in other workflows. The library is also where you
browse and display your workflows and individual tasks, making it much easier to
create and assemble new workflows from predefined tasks without the effort of
configuring them.

When you see the resource you want to use, click and drag it to a task box in the
Workflow panel, and the task will use that resource. You can also deploy entire
workflows (system or user-defined) by dragging and dropping them from the Library to
the Workflow panel.
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Episode also provides a wide variety of predefined resources in its library. Episode
provides over 250 predefined encoder tasks for use in your workflows. For a list of all
library commands, see Library Menu.
The following topics describe library management tasks and topics.

m Browsing the Library

m Adding Items to a Workflow

m Adding an Item to the Library

m Removing an Item from the Library

m Modifying Library Items

m Renaming Library Items

m Duplicating Library Items

m Library Context Menu

Browsing the Library

Items in the library are organized by type:
» Workflows
 Source tasks
» Encoder tasks

» Deployment tasks

To view a given type of library item:

Click on its tab or select Library > Browse Workflows | Sources | Encoders |
Deployments.

Items of each type are further organized by category. Episode displays the items of the
selected type, based on the category selected in the Category popup menu, which is
located directly below the tabs.

Allitems are categorized as System and User. Items in the System category are provided
by Episode, and can't be modified. User items are resources that you've created
yourself. Tasks and workflows are displayed in alphabetical order.

Workflow and Encoder library items are further organized by special categories. For
example, workflow items have a special Web Formats category. Encoder items are
subcategorized by file format, usage, and media formats: for example, AAC, XDCAMHD,
Mobile and Devices, and Streaming.

You can restrict the items that display by using the category menu or entering a search
term in the search box at top right.
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Adding Items to a Workflow

To add any item in the library to the current workflow, drag the item into the Workflow
panel or select Library > Add to Workflow. If you drag another workflow from the
Library to the Workflow Editor, the previous workflow is replaced with the new one.

CAUTION: When you drag a workflow from the Library, it replaces the current
workflow in the Workflow Editor, and any changes to the previous workflow are lost
unless you saved them. Be sure to save a workflow first, using the File menu or the
context menu before replacing it with another workflow from the Library.

You can also import tasks into a workflow from previously exported workflows using
the Import option in the File menu.

Adding an Item to the Library

You can create a new item and add it to the library, or you can add an item from the
workflow that you've already configured.

To add a new item to the library from an edited workflow:
1. Select Library > New Source | Encoder | Deployment

Episode creates a new, untitled item of the type selected, and displays its configura-
tion in the Inspector.

2. Configure the item in the Inspector (for details, see the Inspector topic for the
selected item) and click Save to save the item in the library.

To save an item from an already-configured workflow:
3. Select File > Save Task As (Control-Alt-Shift-S) and supply the appropriate name.

You can save existing edited workflows under the same name or you can save edited
workflows under a new name with File > Save Workflow As (Shift-Command-S).

A selected edited task can be saved by right-clicking Save Task As. If you want to send
your workflow/task to someone else to use, you can export them with File > Export
Workflow and File > Export Task respectively.

Workflows are saved as a unit to the following locations:

» System workflows are stored in \Program Files\Telestream\Episode
6\bin\resources\templates\workflows\systemworkflows.

» User workflows are stored in \Documents and Settings\User\My Documents\Epi-
sode 6\Workflows\\userworkflows.

Removing an Item from the Library

To delete an item from the library:
1. Select the item.
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2, Select Library > Remove Item (Control-Delete).
3. Click Remove to confirm.

You cannot delete System items; you can only delete user-created items.

CAUTION: Library items are permanently deleted and cannot be retrieved.

Modifying Library Items

To modify a library item:
1. Select the library item you want to reconfigure.
2, Configure the item in the Inspector.
3. Click Save or Save As to save the item in the library.

System items cannot be saved, but you can modify them and use Save As to save them
as user items.
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Renaming Library Items

To rename a library item:
1. Double-click the item’s name in the library or select the item.
2, Select Library > Rename <ltem Type> to edit the name.

You can also rename an item in the inspector. System items cannot be renamed but
must be duplicated and saved as a user item under a new name.

Duplicating Library Items

To duplicate a library item:
1. Select the item.

2. Select Library > Duplicate <item> (Control-D) to create a new item with the same
name and an incrementing numeric suffix.

3. Now, modify the item and rename it.

Library Context Menu

The Library context menu offers quick access to Library options.

To display the workflow context menu:

Right-click an item in the Library panel to access these commands:

Add to Workflow. (+) Adds the selected library task/workflow to the currently edited
workflow.

Save As <item>. Save the selected library item as a new item.
Duplicate <item>. Create another instance of the selected library item.
Rename <item>. Rename the selected library item.

Remove <item>. Remove the selected library item from the library.

Delete <item>. Delete the selected library item.

Using the Workflow Editor Panel

Directly below the Library panel is the Workflow panel, where you create, edit, and view
workflows. These topics explain the Workflow Editor Panel:

m Overview

m Workflow Panel Context Menu

m Creating a New Workflow

m Creating Source Tasks

m Configuring a File List Source Task
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m Configuring a Watch Folder Source Task

m Configuring Image Sequences

m Configuring an Encoder Task

m Configuring a Deployment Task

m Setting Workflow Priority

m Submitting Workflows

m Using the Preview Window

m Passing Through Captions Embedded in the Source

Overview

A workflow in Episode is a series of tasks you assemble in a specific order and configure
to specify how you want Episode to encode a file and where to save the output. As you
create workflows, you can name and save them using the File > Save Workflow As
menu.

Figure 30. Workflow Editor with Typical Workflow
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Each workflow is a connected set of tasks—encoders and deployments—with an
optional source. You can configure a workflow to determine how your source files are
submitted, how to encode them, and where to save the output files.

Workflows are organized left to right with three columns—the sources (clips) to encode
on the left, the encoders in the middle, and the deployments (destinations) on the
right. Each box in the workflow is called a task.

For each workflow, a single source task is permitted. Often it is convenient to save
workflows without a source task. In this way, standard workflows can be reused, simply
by placing them in the workflow editor and dragging in a new source. Workflows can
have multiple encoders and multiple deployments for the output files from the
encoder.

You can drag and drop local media files from Windows Explorer, the Media Browser
panel, or the Library to the source task in the Workflow panel. When you click on a task,
its detailed information is shown in the Inspector panel.
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Note: To add files or a directory from a network location, it is best to create a
bookmark for that location as described in Configuring FTP, Wiretap, and Share/SMB
Bookmarks. Bookmarks completely define all information required to access a network
location. If you drag a file or folder from Windows Explorer, the location information
might be incomplete and the location unavailable

After creating a workflow, you should provide it a meaningful name using the name
field at the bottom of the panel, and select File > Save As (Control-Shift-S) to save it in
the library. Workflows you create are saved in the library’s User Workflows category.

You also use the workflow editor to submit media to a workflow for transcoding. You
can submit media in two ways: manually, by adding it to the source task’s file list, or
automatically by dragging and dropping files into a directory being monitored by a
running workflow. (The automatic method works only if the workflow has been
submitted and is currently running.)

The workflow name you provide displays in the Status window when you submit media
to it for processing.

Workflow Panel Context Menu

Episode 6.5

The workflow context menu offers quick access to workflow options.

To display the workflow context menu:

Right-click in the Workflow panel to access these commands:

Preview. Displays the Preview window. If one or more files is in the file list, the latest
one added is displayed.

Save Task As. When a task which has unsaved changes is selected, saves the task in the
library.

Save Workflow As. Saves a workflow to the Library (User Workflows) using the name
you specify in the save as dialog.

Export Task. When a task is selected, displays the Save As dialog. Enter a name for this
task or use the existing name, select a location, and click Save to save the task as a
* epitask file.

You can save these files as archives, or move them to another Episode installation and
add them into the library for use in that copy of Episode.

» Export Workflow. Displays the Save dialog. Enter a name for this workflow or use
the existing name, select a location, and click Save to save the workflow as a *.epi-
submission file.

You can save these files as archives, or move them to another Episode installation and
import them into the library for use in that copy of Episode.

¢ Delete. Deletes the selected workflow or task.

e Select All. Selects all tasks in the workflow.
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» Set as Deployment for All Encoders. When a workflow has multiple encoders,
select to add the selected deployment to all encoder tasks.

» Submit Workflow. Submits the job for processing, and displays it in the Status
panel.

Creating a New Workflow

To create a new workflow:

1. If you're working with another workflow, click Clear. If you are working on a
changed workflow, Episode reminds you to save your changes. Episode clears the
workspace and creates a new, untitled workflow.

2. Name the workflow using the name field at the bottom, and click File > Save As to
save it in the library (User Workflows category).

Note: From now on, to save changes to your workflow, you can right-click and select
Save Workflow As from the context menu. This allows you to save over the existing
saved workflow or save the workflow under a new name.

Each workflow has three task placeholders: Source, Encoder, and Deployment.

3. Configure your source task by dragging files from Windows Explorer, bookmarks
from the media browser or sources from library’s Sources tab onto the source task
template.

4. Configure your encoder tasks by dragging an encoder from the library’s encoder
tab onto the Encoder task.

5. Configure your deployment tasks by dragging bookmarks from the media browser
or deployments from library’s Deployment tab onto the deployment task template.

To remove an object from the workflow, select the object, and press Delete.

After configuring your workflow (or even during the design process if you choose), you
should configure each task. You configure each task by selecting it and updating its
settings in the Inspector.
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Creating Source Tasks

Episode 6.5

You can create file list source tasks by adding files from Windows Explorer or adding
bookmarks from the Media Browser—dragging and dropping them onto the source
task box in the Workflow Editor. When the workflow is submitted for processing, the
files are processed in a queue. Files in a file list can remain in a processing queue for up
to 7 days, after which, they time out.

Note: You can only drag and drop files from Windows Explorer if they are on local
storage. If you are using a network volume, you should create and configure a network
watch folder to accept files from this location.

You can also create watch folder source tasks to continually monitor watch folders and
submit files in real time, as they are written into the target folder. You can configure a
watch folder to poll a local directory, or an FTP, network share/SMB, or Autodesk
Wiretap server location.

Folders are continually monitored for activity for one year, with the timer restarting
each time a new file is added; if there is no activity after a year, monitoring stops.

To create a watch folder:
1. First add a bookmark.

2. Then select Media Browser > Add Bookmark or click the Add Bookmark button in
the Media Browser.

3. Select the new, untitled bookmark to display it in the Inspector panel on the right.
You can name the bookmark, specify the type of watch folder (Local Directory, FTP,
Network Share (SMB), or Autodesk Wiretap), and manage its files in the Inspector
panel. Naming is necessary only if you plan to save it in the Library. Just click the
task to see its Inspector panel.

4. Once the bookmark is created and specified, drag it to the source task in a workflow
to make it a watch folder.

Note: Episode replaces the existing source when you drag and drop a new source
folder onto the source task. If you drag and drop a file onto a file source, the new file is
added to the file list. If you drag and drop a folder, a Watch Folder is created, replacing
the previous source, if any.

In summary, to encode multiple files using one workflow, you have two options. You
can place all the files in a single watch folder where Episode will automatically pick
them up and encode them. Or you can keep all the files in separate (non-monitored)
folders and drag the individual files you want encoded into a source file list and
manually submit them for processing.
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Configuring a File List Source Task

To view/edit the details of a file list task:
1. Click the task in the workflow to select it and view its details in the Inspector panel.

2. Make changes in the Inspector. Changes are saved automatically as they are made.

Figure 31. File List Inspector Panel
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The following options are available:
» Task Name. Enter a meaningful name in the text field.

« Files. To add files, you can drag and drop files from your bookmarks or Windows
Explorer directly onto a file list task. You delete files from the task by selecting the
file in the inspector’s File list and clicking the delete (X) button.

Configuring a Watch Folder Source Task

To configure or view a Watch Folder task in the inspector, click the source task in the
workflow to display it in the Inspector panel.

Episode provides the following types of watch folders:
m Local Watch Folder
m FTP, Network Share/SMB/Autodesk Wiretap Watch Folder
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Local Watch Folder

Figure 32. Local Watch Folder Inspector

Task Name  CaptureMedia

General
Watch folder: file: T Users/chuckp/Videos/C  Browse_
Pick up present files

Advanced
Adaptive Safety Threshold: Normal

Watch Folder Poll Interval 5
[seck

File Safety Delay (sec) 10
Recursion depthc 1]
Retry Max Attempts. 40

Encode While Ingest

File Fitter

Add
Workflow Success Actions
Remove source file
Move source file
Workflow Failure Actions

Move source file

Stop other encodes

Task Name. Enter a meaningful name in the text field.

General

Watch Folder. Click to display the Media Browser dialog, and navigate and select a
directory to monitor. Folders are monitored for activity for one year, with the timer
restarting each time a new file is added; if there is no activity after a year, monitoring
stops.

Pickup Present Files. Check to specify that files already present in the directory when
the workflow is submitted for execution are encoded. If unchecked, only files added
after starting the workflow are encoded.

Advanced

Adaptive Safety Threshold. Select the threshold setting to adapt to the update
behavior of the file system. Off: the Safe delay is strictly used. Normal and Double:
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Episode dynamically adapts the delay to the detected intervals between file updates.
Use Double if the watch folder often submits unfinished files.

Watch Folder Poll Interval. Specify in seconds how often to check for new files in the
watch folder.

File Safety Delay. Specify in seconds how long a file has to remain unchanged (file
transfer is complete) before being submitted.

Recursion Depth. Set how many folder levels directly below the monitored directory
to poll when searching for files to encode.

Retry Max Attempts. Set how many times to try to monitor the watch folder before
failing. For example, your computer might be monitoring a Windows share, or an SMB
folder, but your computer is disconnected from the network.

Encode while ingest. Check to encode TIFO streams from Telestream Pipeline.

File Filter. Click Add to add sets of filter criteria. Use the filter criteria drop-down menu
and the text entry field to select a term to filter directories, files, or extensions in or out.

Workflow Success Actions. Set actions following a successful encode.
Remove source file. Check to delete the source files after encoding

Move source file. Set a directory where the source files are moved after encoding. Click
to display the file system browser, and navigate and select a directory. If none is
specified, the source files are not moved.

Workflow Failure Actions. Set actions following an unsuccessful encode.

Move source file. Set a directory where the source files are moved after failing to
encode. Click to display the file system browser, and navigate and select a directory. If
none is specified, the source files are not moved.

Stop other encodes. Stops all other encodes in this workflow.

FTP, Network Share/SMB/Autodesk Wiretap Watch Folder
Add a bookmark pointing to a folder on an FTP server, network share, SMB, or Autodesk
Wiretap location as follows:

1. In the Bookmarks panel, right-click and select Add Bookmark.

2. In the URL Browser, make settings to access the bookmark location. Setting details
are described below.

3. Click Save at the bottom of the inspector.
When you make the above settings and save them, you are saving the connection

details for the bookmark. Episode can then access the remote folder when it runs a
workflow that contains the bookmark as a Watch Folder.

To add the bookmark as a Watch Folder follow these steps:

1. Drag the new bookmark to the Source icon in a workflow to create a Watch Folder
for the bookmarked location.

AP
telestream Episode 6.5



Using Episode | 83
Using the Workflow Editor Panel

2. Edit the settings in the Watch Folder Inspector for the new Watch Folder.

Figure 33. FTP/Network Share (SMB)/Wiretap Server Watch Folder Setup

57 Url Browser F CaptureMedia
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Task Name | CaptureMedia
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Pick up present files
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21
Treat links as:
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Use STAT listing:

Media Browser Adaptive Safety Threshold: Normal
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W 20K Files
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3 ‘Watch Folder Poll Interval ¢
13
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File Safety Delay (sec)
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Recursion depthc
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3
3
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URL: fipe//Anonymous: ettt @oas ymnas21/chudp/CaptureMedia

Cancel

Name. Enter a meaningful name in the text field.

Kind. Select File Transfer Protocol (FTP) | Network Share (SMB) | Autodesk (Wiretap)
from the popup menu.

Note: When you select Wiretap, the Username, Password, and Save password controls
are hidden.

Server. Enter the name of the server. (or localhost if running on this computer.) Do not
use slashes—just enter the server name. For example: ftp.telestream.net

Port. Enter the port number for the server. In most cases the default port is correct.
Username (FTP/SMB only). Enter the username of the FTP account you're using
Password (FTP/SMB only). Enter the password for this account, if any.

. CPath. Enter the path to the folder you want to watch. Start the path with a back slash
(\).

Save. Click Save to save the bookmark settings. Once you click save, other settings
display in the panel.
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General

Watch folder—use the browse button or directly edit the path to select the folder you
want to watch.

Pickup present files—check this option if you want to pick up and process files
already in the watch folder.

Advanced

Adaptive Safety Threshold. This is an amount of time Episode automatically adds to
the Safe Delay wait time to ensure that a file has been completely written to the watch
location before encoding. Set to Off if you have a fast network or are working locally on
a fast machine. Set to Normal for a typical network, and set to Double if the network
tends to be slow or you have trouble with files being picked up and encoding
attempted before the files are done being written.

Watch Poll Interval (sec). Enter the number of seconds Episode should wait between
checks of the watch folder to detect new or updated files. The default is 2 seconds.

File Safety Delay (sec). Enter the number of seconds Episode should delay after
detecting no changes in a new or updated file before encoding the file. This ensures
the file is done being written before encoding.

Recursion depth. Set how many folder levels directly below the watched folder to poll
when searching for files to encode.

Retry Max Attempts. Enter the successive number of times Episode should attempt to
connect and properly process the folder before stopping.

SSL Mode. Enables or disables FTP Secure Socket Layer (SSL) for secure data transfer:
— Off—Disables SSL. All transmissions occur using an unencrypted FTP connection.
— On—Enables SSL encryption and falls back to a clear connection if SSL fails.
— Force Control—Enables SSL encryption and fails to connect if SSL fails.
— Force All—Enables SSL encryption and ensures that all traffic is encrypted.

Note: Displaying network-accessible folders, and local folders containing significant
volumes of files (for example, 100 or more) can take considerable time and network
bandwidth. To prevent problems including failed jobs, consider setting the Watch Poll
Interval to 10 seconds (or more as necessary), and increasing the File Safety Delay to 3
times the watch poll interval: In this example, 30 seconds.
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Configuring Image Sequences

Episode 6.5

Episode Pro and Engine include the ability to encode numbered image sequences,
such as those produced in compositing or animation, into a movie in virtually any video
format available in Episode. This feature has been present in the command line for
quite some time, and now it is available in the user interface as well.

These are the accepted image input file formats: DPX, TGA, TIFF, and JPEG. Formats
cannot be mixed in the same job.

There are two methods for creating an image sequence workflow: (1) drag and drop a
file in an existing sequence on the Source task in a workflow, or (2) set up a Watch
Source task on a folder that will receive the sequence input files.

To drag and drop an image sequence:

1. Select File > New > Source > Image Sequence (Windows), or drag an Image
Sequence source onto the workflow Source task.
The Source task changes to Image Sequence and an untitled Image Sequence
inspector panel opens.

2, Give the image sequence a Task Name and fill in the other inspector fields (see
Image Sequence Selections below for details).

. Drop an image from the sequence onto the workflow Source task.
. Select and configure a video encoder in the workflow Encoder task.
. Select and configure the workflow Deployment task for the output location.

O U1 AW

. Submit the workflow to start encoding the image sequence.
Episode recognizes all the images in the sequence based on the numbering (all
must be in the same folder) and processes them in the workflow.

To create an image sequence Watch on a folder:

1. Select File > New > Source > Watch folder (Windows), or drag a Watch Folder
source onto the workflow Source task.

2. Check the Image Sequence option in the inspector panel, give the Watch Folder a
Task Name, select the watch folder, and fill in the other inspector fields.

3. Select and configure a video encoder in the workflow Encoder task.
4. Select and configure the workflow Deployment task for the output location.

5. Submit the workflow to start watching the folder forimage sequences.
When image sequence files are dropped into the source folder, Episode processes
them.

Image Sequence Selections
Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default
value is 1, meaning that one missing number in a sequence is treated as the end of the
sequence. If set to another number, that number of sequence numbers must be
missing to be considered the end of a sequence.
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Safety files. Controls how many files after any given file need to be present in the
sequence before processing of the file begins. This does not apply to the first file in a
sequence. This only has practical implications if Encode While Ingest is enabled. Setting
this to 0 (zero) may significantly decrease the time the encoder has to wait when the
end of the sequence is reached, but depending on file system and file format, may
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device
that produces an image sequence over time. Wait times between received files can be
specified in the following wait fields.

Encode while ingest waits (sec). Specifies the number of seconds to wait before
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to
wait for files during encode while ingest. The default is 5 times. If no files are received
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

Revert. Restores the Image Sequence settings to what they were before they were
changed.

Save As. Saves the Image Sequence configuration to a file.
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Configuring an Encoder Task

The encoders task box only accepts encoders. An encoder defines how the source is to
be transformed (encoded) by the codec using the settings you choose. You drag and
drop preset encoders from the Encoders tab or from the Explorer. You can also create a
new default encoder with File > New > Encoder.

To add encoders to a workflow:

You can drag and drop multiple encoders into a workflow. As you drag and drop them,
they all connect to the source task. All files in the source are encoded with each
encoder in the workflow.

You can also add a new, untitled encoder task to your workflow by selecting File > New
> Encoder.

Because of the complexity of configuring an encoder task, it may be simpler and faster
to select a similar encoder from the library and make changes in the Inspector.

To view and change encoder settings:

Select the encoder and view its settings in the Inspector panel. In the Inspector, you can
set Format options, including Container, Video Encoder, Audio Encoder, In/Out points
(on your source file), Timecode to use, Intro and Outro, etc. When you're done, click
Save As to save the encoder under a new name.

Configuring a Deployment Task

Episode 6.5

Deployment tasks are similar to watch folders in that they reference directories, locally
or on a server. Episode supports multiple deployments per encoder.

If you have several encoders, each of them has its own set of deployment tasks.
Therefore, if you want all new files in the workflow to be saved in the same directory,
you should add the same deployment to each encoder. Add the deployment task to
one encoder, and then right-click on the deployment task and select Set as
Deployment for All Encoders from the context menu.

To deploy the output from a single encoder to multiple locations:

Drag and drop the appropriate deployment from the library near the right edge of the
target encoder to connect it to the encoder.

To view and change deployment settings:

Select the deployment and display the Inspector panel.
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Setting Workflow Priority

You can set workflow processing priorities so some workflows process ahead of others.

To set workflow processing priority (-10 to 10):

Use the slider, or enter the value in the field to the left of the Submit button. (Currently-
executing jobs are not affected.)

Submitting Workflows

Workflows do not begin encoding media until they are submitted for processing.

To submit media for processing:
1. Display the workflow you want to use in the Workflow panel. (Make sure it is saved).

2. Click Submit or select Tools > Submit Workflow to submit it for processing.

If this workflow has a file list as a source, the files are queued and each is encoded as
soon as other jobs ahead of it are complete, or there is a free slot in the cluster you
are attached to. If the source is an watch folder, the job is activated, and encoding is
performed whenever there are files to be processed in the watched folder.

Using the Inspector Panel

The right-most panel is the Inspector panel. The Inspector displays configuration details
about selected items and enables you to change their settings.

Note: You can only change user items, not system-defined items.

The Inspector panel’s title and contents change as you select different objects, allowing
you to review and configure the settings of the selected object—a bookmark, a library
resource, or a task in your workflow. For example, when you select a bookmark, the
Inspector displays details for the bookmark, including its name and file path. When you
select an encoder in the library or the workflow, the Inspector displays the details about
the selected encoder, such as specifics and selections regarding the format, video, and
audio. You can also enter metadata, or set up a Split-and-Stitch job.

Split-and-Stitch (at the bottom of the Inspector panel when an encoder is selected)
allows you to distribute processing of a long source clip to multiple computers in your
Episode computer cluster. By allowing multiple computers to work simultaneously on a
piece of the clip and then stitch it back together into a single clip when they are done,
processing time can be sped up greatly.

The Split-and-Stitch subpanel allows you to set the minimum duration of a clip before
Split-and-Stitch will be used and also set the maximum number of video splits or pieces
to divide the clip into.

To save an edited item in the Inspector:
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After you edit an item, you can save changes by clicking the Save/Save As button at the
bottom of the panel or selecting the Save Task As context menu (right-click). If you
change your mind before saving it, just click the Revert button—this restores the item
to the last saved version (if the workflow or task was previously saved).
These topics describe the Inspector panels

m Using the Media Inspector

m Configuring Source Tasks

m Configuring Encoder Tasks

m Configuring Deployment Tasks

m Configuring Closed Captions
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Using the Media Inspector

The Media Inspector displays when you navigate to and select a media file in the Media
Browser. The Media Inspector provides a preview player, and displays an icon when you
are previewing media with only an audio track, along with file details. If Episode can not
load the selected file, it displays an error message.

Figure 34. Media Inspector Panel

filey/DyTechDocs/Media/
ColorTest_00E.wmv

1549 kB

Media Information

Duration:
Video Tracks:
Index: 1
Width: T20 pixels
Height 480 pixels
Frame Rate: 30.0000305175781 fps
Start Time: D sec
Duration: 2734 sec

Audio Tracks:

Index
Bit Depth:

Sample Rate:

Number of Channels:
Start Time:
Duration:

The Media Inspector provides the following fields and controls:

File Information

Name. The name of the file you're inspecting.

URL. The fully-qualified URL to the file.

Size. The size of the file as reported by the operating system, in kilobytes.

Below the preview panel, video and audio track details are displayed. This information
can assist you in applying filters, and setting up encoding configurations, for example.
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Note: FTP and Wiretap sources are not analyzed.
Player Controls
Audio Volume. Hover over the audio volume control to the left of the scrubber to
display it. You can mute the volume by clicking the icon; click it again to turn it back on.
Drag the volume button to decrease or increase volume.
Play/Pause/Scrub. Click the Play button to preview the file at normal speed; click it
again to pause it. Drag the scrubber button to move forward and backward in the file.
Loopback. Click the Loopback button (to the right of the play bar) to loop the file
during preview; click it again to disable loopback.
VAT
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Configuring Source Tasks

Source task configuration for file lists consists only of setting the name and saving the
task in the Inspector. For local and network watch folder source tasks, more options are
available.

Figure 35. Source/Watch Folder and Image Sequence Inspector Panels

™ CaptureMedia
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Task Name  CaptureMedia
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File Safety Delay {sec) 10 Bierstadt Kern River Valley jpg
Recursion depthc 1]

Retry Max Attempts. 40

Encode While Ingest

File Fitter

Add
Workflow Success Actions
Remove source file
Move source file
Workflow Failure Actions

Move source file

Stop other encodes

To configure source tasks:

Click the source task in the Workflow window. The Inspector displays the available
options:

Task Name. Enter a name for the task before saving.

General

Watch Folder. Use the browse button or directly edit the path to select the folder you
want to watch.

Pickup present files. Check this option if you want to pick up and process files already
in the watch folder.
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Advanced

Adaptive Safety Threshold. This is an amount of time Episode automatically adds to
the Safe Delay wait time to ensure that a file has been completely written to the
watched location before encoding. Set to Off if you have a fast network or are working
locally on a fast machine. Set to Normal for a typical network, and set to Double if the
network tends to be slow or you have trouble with files being picked up and encoding
attempted before the files are done being written.

Watch Poll Interval (sec). Enter the number of seconds Episode should wait between
checks of the monitor source folder to detect new or updated files. The default is 2
seconds.

File Safety Delay (sec). Enter the number of seconds Episode should delay after
detecting no changes in a new or updated file before encoding the file. This ensures
the file is done being written before encoding.

Recursion depth. Set how many folder levels directly below the monitored directory to
poll when searching for files to encode.

Retry Max Attempts. Enter the successive number of times Episode should attempt to
connect and properly process the folder before stopping.

Encode While Ingest. Use this option with Telestream Pipeline to encode TIFO files as
they are being written to disk. To use this feature, you must have your Pipeline
delivering its content in a TIFO container to the same location being monitored by
Episode.

File Filter. Click Add/+ to add sets of filter criteria. Use the filter criteria drop-down
menu and the text entry field to select a term to filter directories, files, or extensions in
or out. Many filter terms are available, including contains, is equal to, begins with, ends
with, the converse of each of those terms, and so on.

Workflow Success Actions

Configure these options to specify how to operate on the source file after the workflow
completes successfully:

Remove Source File. Check to delete the source file.

Move Source File. Use the popup menu to specify an optional location for copying the
source file.

Workflow Failure Actions

Configure these options to specify how to operate on the source file if the workflow
fails on any action:

Move Source File. Use the popup menu to specify an optional location for copying the
source file.

Stop Other Encodes. Check to stop other encodes in the same workflow.

Delete picked up source files. Choose this option if you want Episode to delete the
source files after encoding completes.
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Move picked up files to. Choose this option if you want Episode to move files to a new
location after encoding. This can be very handy if you want to ensure you keep already-
encoded files separate from files waiting for encoding.

Revert. Select this option before saving to restore the selections in this panel to the last
saved state before the most recent changes.

Save As. Select to save changes.

Image Sequence

If the source task is an image sequence, the following inspector selections are
presented rather than the watch folder options.

Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default
value is 1, meaning that one missing number in a sequence is treated as the end of the
sequence. If set to another number, that number of sequence numbers must be
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the
sequence before processing of the file begins. This does not apply to the first file in a
sequence. This only has practical implications if Encode While Ingest is enabled. Setting
this to 0 (zero) may significantly decrease the time the encoder has to wait when the
end of the sequence is reached, but depending on file system and file format, may
result in errors. Default is O.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device
that produces an image sequence over time. Wait times between received files can be
specified in the following wait fields.

Encode while ingest waits (sec). Specifies the number of seconds to wait before
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to
wait for files during encode while ingest. The default is 5 times. If no files are received
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

Revert. Restores the Image Sequence settings to what they were before they were
changed.

Save As. Saves the Image Sequence configuration to a file.
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Configuring Encoder Tasks

Encoder tasks include five main categories of configuration that you can edit in the
Inspector panel: Format, Video Filters, Audio Filters, Split-and-Stitch, and Metadata.
These categories are presented in expandable subpanels.

To view a subpanel:
Click the triangle next to it. To close an expanded subpanel, click the triangle again.

Figure 36. Encoder Inspector Panel

PP H264 640x480

Encoder

TaskMame {264 640x480

Each subpanel includes extensive selections, including check boxes and data entry
fields that provide comprehensive control over the encoding process. Some of the
subpanels contain additional subpanels that can be expanded further to provide
access to more configuration selections and adjustments.

For details explaining the details of each selection for each encoder, refer to the file
formats, video and audio codec, and filter chapters later in this guide. The following
figure provides an example of a partially expanded Encoder Inspector panel, and the
following topics present a summary description of each panel.
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Figure 37. Partially Expanded Encoder Inspector Panel
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The following topics describe Encoder task configuration:
m General Panel
m Format Panel
m Setting In/Out Points
m Configuring Timecode
m Adding Intro & Outro Clips
m Using Video Filters
m Using Audio Filters
m Enabling Split-and-Stitch
m Adding Metadata

General Panel

The General panel at the top only includes the encoder’s name, which you can change
and then save using the Save As button at the bottom of the Inspector to create
another variation of an item.
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Format Panel
The format panel organizes and displays the following categories:
Container.

Select the container format of the output file from the dropdown list. The container
format you select determines which video and audio are available. Container settings
are listed and described in detail in Media Containers/Formats.

Video Encoder (Codec). Select the video codec for any video tracks in the output file. If
you uncheck the box, even if video is present in the input file, no video tracks are added
to the output file.

When you choose the Pass Through option, the video stream is inserted into the output
file untouched, provided that the format is supported in the output container format
you selected. For video codec settings, see Video Codecs.

Audio Encoder (Codec). Select the codec for any audio tracks in the output file. If you
uncheck the box, no audio tracks are added to the output file.

When you choose the Pass Through option, the audio stream is inserted into the output
file untouched, provided that the format is supported in the output container format
you selected. For audio codec settings, see Audio Codecs.

Audio & Video Streaming. For media formats (with video/audio codecs as well) that
can be streamed (sent out in real time from a server), check to enable the output file from
Episode to be streamable. Displays only when streaming is supported.

QuickTime and MPEG-4 streaming media require special hint tracks that tell the
streaming server how to packetize the media for transmission.

Streaming settings are listed by container in Media Containers/Formats.

Container and codec combinations that can be streamed:

Table 2. Supported Streaming Containers and Codecs

Container Video and Audio Codecs

3GPP H.263, H.264, MPEG-4, AAC, AMR
3GPP2 H.263, H.264, MPEG-4, AAC, AMR
MPEG-4 H.264, MPEG-4, AAC

QuickTime H.263, H.264, MPEG-4, AAC, AMR
Windows Media WMV9, VC-1, WMA

Setting In/Out Points

Check the In/Out Points option to set the encoding in and out times when you only
want to encode a segment of the source into the output file.
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Figure 38. In/Out Points Settings

In

Out

In/Out Points. Set the in and out times to only encode a segment of the source.
Timecode is specified as follows: <hours>:<minutes>:<seconds>:<hundredths sec>.

To enter the entire In/Out point timecode:

Click once to select it and type in the timecode without colons. You can enter each
value segment manually by clicking directly on a segment to select it and type in the
numbers. Or you can adjust the number using the up/down arrows to the right of the
field. Note that you can set in/out points only if the source files contain valid timecode.

Configuring Timecode

If the source file has a timecode track, the timecode track is automatically added to the
output file (providing the selected container format supports timecode).

If you want a different timecode track starting value than is in the source or the source
has no timecode track and you want a timecode track in the output (providing the
selected container format supports timecode):

Check Timecode and set the starting timecode value to place in the output file.

Figure 39. Timecode Settings

Timecode:

Time Code. Enter a time code in the format HH:MM:SS:HS to set the starting time for
the timecode track.

For formats that do not support a timecode track, you can combine the timecode filter
with the burn timecode filter to add the timecode directly to the video track, rather
than as a separate timecode track. This enables you to use timecodes in any file format.
See Burn Timecode Filter.

CAUTION: The burn timecode filter permanently changes the video. Once the
timecode has been added to the video it cannot be removed.

Adding Intro & Outro Clips
To add Intro and Outro clips to your output file:
Check the intro and outro selection and choose from the revealed settings.

Intro and outro clips (bumpers and trailers) are added before and after the main source
media. They are set to the same format, size and frame rate as the output file but are
not otherwise transformed. In particular, they are not de-interlaced if the output is
progressive and vice versa.
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These clips must have video and audio tracks corresponding to the video and audio
tracks of the output. For example, output with both video and audio requires clips with
both video and audio, but video-only output does not require audio tracks in the clips.

Figure 40. Intro & Outro Settings

Using Video Filters

You can implement video filters to affect the video in various ways: changing its size,
frame rate, color, or other metrics. Video filters are applied to baseband video after
decoding.

The video codec encodes the video after all video filters have been applied, and may
entail additional changes.

You can apply one or more video filters to your video. However, be certain that you
understand when and how to use a filter; some filters are not appropriate for certain
video formats, and some video filter combinations are not appropriate. You can use the
Preview Window Right/Left Preview Filters features to see the effects of filters alongside
unaltered video.

Video filters (when enabled) are applied in the order they are listed in the inspector.

Figure 41. Video Filters Panel
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Check a video filter to apply it. Next, click on it to select it and display its settings in the
edit panel at the bottom, and configure the settings to meet your needs. Episode
automatically saves your settings.

You can undo and redo changes to a setting by selecting Edit > Undo | Redo.

For details about video filters, see Video Filters.

Using Audio Filters

You can implement audio filters to affect the audio track in various ways: changing its
volume, speed, sample rate, or other metrics. Like video filters, audio filters are also
applied in the order they are listed in the inspector. Audio filters are applied to
baseband audio after decoding.

The audio codec encodes the audio after all video filters have been applied, and may
entail additional changes.

You can apply one or more filters to your audio. However, be certain that you
understand when and how to use a filter; some filters are not appropriate for certain
audio, and some audio filter combinations are not appropriate.

For details about audio filters, see Audio Filters.

Figure 42. Audio Filters Panel
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Enabling Split-and-Stitch

This feature is available when you have a license for Episode Engine. In a Split-and-
Stitch job, the source is split into a number of segments that are encoded in parallel on
all available nodes in your cluster. The resulting output segments from multiple
computers are then stitched back together to form a single final output file. This
method spreads the processing load and greatly reduces the total transcoding time.

Note: Some video formats cannot be processed using Split-and-Stitch. These formats
are automatically encoded as a regular job even if you specify Split-and-Stitch.
Also,3GP, MP4, and MOV files can not be processed using Split-and-Stitch when audio
or video streaming is enabled.
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In Split & Stitch jobs, deployment tasks execute on the same server as the stitch task.
This is done to minimize network file transfer inefficiencies. The only way to disable
this feature is to use the XML/RPC interface.

To enable Split-and-Stitch jobs:
Expand the panel and check the Split-And-Stitch option. For details, see Getting Started.

Figure 43. Split-and-Stitch Panel

Split-and-Stitch v

Minimum Split Duration 30
(seq)

Maximum Mumber of Video 15
Splits

Split on GOP size 1

Use Local Cache

Minimum Split Duration. Enter a an integer value (in seconds) to specify the minimum
size of split segments (default: 30). The minimum allowed duration is 9 seconds; the
maximum is 3600.

Maximum Number of Video Splits. Enter an integer value to specify the maximum
number of video split segments (default: 16). The minimum number of video splits is 2;
the maximum is 32.

Split on GOP Size. Enter a number that evenly divides the number of frames in a Group
of Pictures (GOP) for the media you are processing. This will produce a clean split
between GOPs rather than in the middle of a GOP for media that is sensitive to where a
split occurs. For example, if each GOP in your media contains 12 frames, set this number
to 12. The default setting is 1, which allows a split to occur at any position.

Note: This feature does not work with the Advanced Frame Rate Filter. Also note that
this feature does not control the GOP size, which is set using settings in the codec.
Codec settings are made separately when you select an encoder for your workflow.

Limitations of Split-and-Stitch

Split-and-Stitch does not support video and audio streaming. If video or audio
streaming is activated, Episode ignores Split-and-Stitch (if selected) and performs a
regular encode. Similarly, Split-and-Stitch requires files to have timestamps or durations
specified; if not, Split-and-Stitch is ignored and a regular encode is done.

Adding Metadata

Metadata is information about a file, such as copyright information, source file names,
creation date, etc. Many media formats have data fields for metadata. Each format
supports different metadata fields. The inspector automatically identifies the available
fields for the output format and displays them.
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Figure 44. Metadata Panel
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The edit panel displays a Key column (left) and a Value column (right). The Key column
displays available metadata tags. They are disabled until you enter a value in the
corresponding Value field. Double-click to activate the text field and enter your value.
Fields for which you have not entered a value are not added to the output file.
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Configuring Deployment Tasks

Episode 6.5

You can configure Deployment tasks to write your output files to local directories, FTP
servers, network share/SMB servers, or YouTube accounts.

In addition to user-created deployments, Episode provides three different system
deployments you can use in your workflows.

m User Deployments

m System Deployments

m Configuring User and System Source/Desktop Deployments

User Deployments

You can configure your user deployments to set their names, set their destinations, and
determine whether to increment file names with an added numeral as new
deployments with the same name are created or allow new deployments to overwrite
existing deployment files.

System Deployments

Episode provides several predefined (or system) deployments: Same As Source,
Desktop, and YouTube.

Same As Source and Desktop Deployments

A Same As Source deployment uses the source directory as the output directory for a
workflow, hence, the name, Same As Source. A desktop deployment places workflow
outputs on the desktop.

To implement a Same As Source or Desktop deployment task:

Display the Library panel, select the Deployments tab and navigate to System
Deployments. Drag and drop the desired deployment resource onto the Deployment
task template to create a new copy of the task so you can configure it.

YouTube Deployments

You can add the YouTube deployment task to your workflow, configure it for your
workflow, and automatically upload the output file to YouTube.

To implement a YouTube deployment task, display the Library panel, select the
Deployments tab and navigate to System Deployments. Drag and drop the YouTube
task onto the Deployment task box to create a new copy of the task so you can
configure it.
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Figure 45. YouTube Deployment Task

Task Name. Enter a meaningful task name.

Username. Enter your YouTube user name.

Password. Enter your YouTube password.

Video Info Title. Specify the title for the video you're submitting.
Video Info Description. Describe the contents of your video.
Category. Select the category that best fits the contents of your video.
Keywords. Enter keywords summarizing the contents of your video.

Private Video. Check to restrict the distribution of your video, so that it can only be
viewed by invited users.

Configuring User and System Source/Desktop Deployments

To configure a deployment, select it in the workflow or in the library. If you select a
deployment from the library, you must save it as a new task before you can edit it.

Figure 46. Example Deployment Task

g 10.110.108.226
* Deployment

Task Name. Enter a meaningful task name.

Destination Folder. The browse menu allows you to navigate and select the location
where you want output files saved. By default this is the same as the source, or the
desktop, depending on which deployment you use.

File Name. Use this field to enter text (and optionally, variables) to define how the
output file name is to be constructed.
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If you don't provide any text or variables, Episode generates the file name in this format:
source file base name + Workflow ID. For example, Original_File_Name-9045-3AA6-4FAD-
A1BC-29DA158082. If you only enter text, the file name is the name you enter.

You can use the following variables to dynamically compose a file name:

Table 3. File Name Variables

Variable

Description

$deployment.name$

The name of the deployment in this job.

Sencoder.name$

Name of encoder that processed the job.

Sencoder.input-duration-
hms$

Input file length, expressed in timecode format.

$Sencoder.input-duration-s$

Input file length, expressed as seconds.

Sencoder.input-pixel-
dimensions$

Input file frame size, expressed in pixels.

$encoder.input-samplerate$

Input file sample rate, in frames per second.

$Sencoder.output-bitrate-
kbps$

Output file bitrate, expressed in kbits/second.

Sencoder.output-bitrate-
mbps$

Output file bitrate, expressed in Mbits/second.

$encoder.output-duration-
hms$

Output file length, expressed in timecode format.

$source.extension$

Extension of the source file submitted to the job.

$Ssource filename$

Base name of source file submitted to the job.

$Sencoder.output-duration-s$

Output file length, expressed as seconds.

Sencoder.output-pixel-
dimensions$

Output file frame size, express in pixels.

$Sencoder.output-
samplerate$

Output file sample rate, expressed in frames per
second.

$source.name$

The root of the source filename.

$source.type$

The suffix of the source filename.

Ssource.filename$

The source full filename.

$source.parent-dir-name$

The directory of the source file.

$source.grandparent-dir-
name$

The second-level directory of the source file.
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Table 3. File Name Variables

Variable Description

Suuid$ The UUID of the job.

Suuid.uppercase$ The UUID, converted to all upper-case letters.
Suuid.lowercase$ The UUID, converted to all lower-case letters.
Sworkflow.submission- Computer from which the job was submitted.
client$

Sworkflow.submission- hostS Master node in the cluster.

Sworkflow.submission- Workflow that processed the job.
name$

Sworkflow.id$ The ID of this workflow.
Sworkflow.name$ The name of this workflow.
Sworkflow.spawn-time$ The time this workflow job started.

Sworkflow.submission-time$  The time this workflow job was submitted.

Sworkflow.template-id$ The ID of the template for this workflow.

Click the + icon to display a menu of the variables, and click the variable you want to
enter. To delete a variable, click to the right and press Backspace.

Table 4. Dynamic File Name Variables

Variable Variable

$ dynamic.time $ dynamic.day.short-name
$ dynamic.hr-time $ dynamic.day.DD

$ dynamic.year.YY $ dynamic.hours.HH

$ dynamic.year.YYYY $ dynamic.minutes.MM

$ dynamic.month.name $ dynamic.seconds.SS

$ dynamic.month.short-name $ dynamic.hostname

$ dynamic.month.MM $ dynamic.node-id

$ dynamic.day.name $ dynamic.platform

Increment File Names. When checked, output files with the same filename are suffixed
by an incrementing integer. For example, if the first file is File-encoder.mov, the 2nd is
File-encoder (1).mov, the 3rd is File-encoder (2).mov, etc. If unchecked, files encoded with
the same output filename overwrite the existing file without warning.
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Maximum Throughput (KB). When throttling is required, enter the value in kilobytes,
for the maximum amount of data to transmit per second. Some FTP sites require a
maximum throughput, for example.

Recreate Source Sub-directories. When checked, output files are written to the
output directory in the same path as the source, including any intervening
subdirectories, thus, retaining the source subdirectory structure in the output directory
as well.
FTP-only options
SSL Mode. Enables or disables FTP Secure Socket Layer (SSL) for secure data transfer:

» Off—Disables SSL. All transmissions occur using an unencrypted FTP connection.

* On—Enables SSL encryption and falls back to a clear connection if SSL fails.

» Force Control—Enables SSL encryption and fails to connect if SSL fails.

» Force All—Enables SSL encryption and ensures that all traffic is encrypted.

Configuring Closed Captions

Episode 6.5

The Inspector is used to configure closed captioning. Closed captioning works with
ordinary workflows as well as Split and Stitch. Captions may be passed through if they are
already embedded, or they may be embedded during encoding from an scc or mcc file.

These output formats and video codecs support closed captioning:
e MXF (AS-11, Op1a, XDCAM) container
e MPEG-2 codec
* H.264 (MainConcept) and H.264 (x264) codecs

The following topics explain how to configure closed captioning.

Note: Closed caption configuration is done in four places: the Container, the Video
Encoder, the VBI Importer Video Filter, and the Caption Importer Video Filter. Take care
to set each one correctly in order to produce a successfully captioned output.

Adding Captions from a File (.scc or .mcc)

Episode can import .scc or .mcc caption files and embed their closed captioning data in
the transcoded output. Caption files of the .scc type will add EIA-608 SD captions.
MacCaption or CaptionMaker files of the .mcc type will add both EIA-608 SD and EIA-708
HD captions. The source media file and .scc or .mcc files must include QuickTime
timecode starting at 00:00:00:00.

The caption data from the .scc or .mcc file is inserted into the SMPTE TT user data of the
MPEG-2 or H.264 output files.
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To import a .scc or .mcc caption file:

1. Create a workflow to encode a media file into one of the formats supporting
captions: MXF Container, MPEG-2 Video Encoder, or H.264 Video Encoder.

2. Select Video Filters in the Inspector.
3. Select the Caption Importer Filter.

4. Use the File menu in the Caption Importer to browse, select, and import a .scc or
.mcc caption file. Captions from the file will be embedded during encoding.

Note: Because you must explicitly specify a file (and not a file variable), you must
select the file in the filter each time you run the caption import workflow.

5. Enable captions in the encoded output by making one or both of these selections:

— To add the captions to an MXF container file, select the container, and check Add
Ancillary Closed Caption Track.

— To add the captions to an MPEG-2 or H.264 video bitstream, select the Video
Codec and ensure Closed Captioning is set to Same As Source. (Since this is the
default setting, you won't actually have to change anything.)

Passing Through Captions Embedded in the Source

Episode allows EIA-608, EIA-708, or SCTE-20 captions already embedded in the source
media vertical blanking interval (VBI) or user data to be passed-through to the
transcoded output. Settings depend on the source format:

Note: Episode cannot pass through embedded closed captions from MOV sources.

To pass captions embedded in an MXF or MPEG-2 source:
1. Create a workflow to encode the source file containing captions into a format
supporting captions: MXF Container, MPEG-2 Video Encoder, or H.264 Video Encoder.

2. No input Video Filter settings are required. The captions will automatically pass
through to the output.

3. Enable captions in the encoded output by making one or both of these selections:
— To add the captions to an MXF container file, select the container, and check Add
Ancillary Closed Caption Track.

— To add the captions to an MPEG-2 or H.264 video bitstream, select the Video
Codec and ensure Closed Captioning is set to Same As Source. (Since this is the
default setting, you won't actually have to change anything.)

To pass captions embedded in a source other than MXF or MPEG-2:
1. Create a workflow to encode the source file containing captions into a format
supporting captions: MXF Container, MPEG-2 Video Encoder, or H.264 Video Encoder.

2. Select the VBI Importer Video Filter, and check Decode Captions. When set to
Automatic (the default), this will detect and extract the caption data on the input
for embedding in the output. Instead of using Automatic, you have the option of
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setting decoding to Manual and selecting the vertical blanking line number that
contains the caption data.

3. Enable captions in the encoded output by making one or both of these selections:

— To add the extracted captions to an MXF container file, select the container, and
check Add Ancillary Closed Caption Track.

— To add the captions to an MPEG-2 or H.264 video bitstream, select the Video
Codec and ensure Closed Captioning is set to Same As Source. (Since this is the
default setting, you won't actually have to change anything.)

For details about caption outputs, see these format and codec descriptions: MXF AS-11
(.mxf), MXF Op1a (.mxf), MXF XDCAM (.mxf), MPEG-2 Codec or H.264 (x264) Codec.

Using the Status Panel

Episode 6.5

The Status panel displays the status of jobs in queue and in execution on the current
cluster. Depending on your preferences settings, the status of previously executed jobs
may also be displayed, optionally subject to an age limit. See Setting Preferences.

Figure 47. Status Panel

The Status panel opens automatically whenever you submit a workflow for processing.
To open the Status panel, click the Status popup menu icon in the lower left corner of
the Workflow Editor.

The Status panel includes a job/task list on the left, and the status of the specific
selected job on the right. Each side includes multiple information columns that can be
rearranged by clicking and dragging.

Using controls at the bottom of the panel, you can start, stop, or pause workflows and
resubmit the selected job.

Left Side Status Display

The left half of the Status panel lists workflows being processed and displays their
status. The Status panel includes buttons and menus along the top of the panel that
allow you to organize and filter the workflows and jobs you want to see.

To change the status view:

Using the Jobs and Tasks buttons in the upper left corner, you can select between
showing a hierarchical view with workflows on the left and their job details on the right,
or a full-width listing of all individual tasks.
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To filter what is displayed:

Using the top drop-down menus, you can filter the display to only display jobs with a
given submitter, workflow status, or job status. In a hierarchical view you can expand
the detail view to display the component tasks of each job in the workflow and their

status.

The order of jobs or tasks can be sorted by clicking any of the column headings. Click
once to reverse the order and again to restore the original order. Note that if you have
specified two-pass encoding, Episode cycles the progress bar twice—once for each
pass.

To stop, pause, resume:

The Status panel lets you control encoding on the node. In the lower left corner there
are Stop and Pause buttons. They only affect the currently selected workflow/job. You
can also use the context menu (right click) to pause, resume, or stop the selected
workflow/job (or delete the selected workflow).

Note that when you pause a queued workflow to postpone its execution, it still
occupies a slot on the cluster, and blocks execution of other jobs in that slot. (Slots in
general correspond to a CPU core on a node, so you typically have multiple slots on
each node.)

You can change workflow execution priority by selecting the workflow in the list on the
left and adjusting the Priority slider or entering a new priority number in the field next
to the slider. If you want to leave a workflow running but stop it from picking up any
more files for processing, click the Stop button to the right of the Priority slider.

To open the selected workflow in the Workflow Editor, right click and select Open
(Recall) (Command-O).

CAUTION: If jobs are currently processing, do not change the system date and time,
as this can cause the job to fail.

Left Panel Status Selections

The following selections are available in the left jobs panel. Each column label can be
clicked to sort the jobs list.

Jobs/Tasks. Selects between a split display, showing a list of jobs on the left and tasks
on the right, or a single display showing everything.

Client/Machine. Selects whether to show jobs running only on this machine or on all
visible client machines.

Workflow Status. Filters the job display based on workflow status—any (all)
workflows, running workflows, successful workflows, failed workflows, or pending
workflows.

Job Status. Filters the job display based on job status—any (all) jobs, running (active)
jobs, successful (completed) jobs, failed jobs, or pending/idle jobs.
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Workflow Type. Filters the job display to show watch folder workflows, manually
submitted workflows, or any workflows.

Workflow column. Lists workflow names.
Submitted column. Lists date and time submitted for each job.
Progress column. Shows a progress description for each job.

Priority column. Shows a priority setting for each workflow, ranging from -10 to +10.
Adjust the slider or enter a number to change the priority.

Start/Stop button column. Click to start or stop the selected (highlighted) job.

Resume/Pause/Stop (bottom buttons). Use these player-like controls to restart,
pause, or stop activity on the selected (highlighted) job.

Right Side Status Display

The right side displays the detailed job status of the workflow you select on the left.
Column headings and bottom panel start, stop, and pause controls work the same as
they do for the left side display with the addition of a Requeue Job button for
resubmitting jobs to the queue.

The right side status panel includes a search field for entering specific file names whose
status you want to find and view.

To view status details:

The right side columns display the Job and Task Name and show processing Progress
and Priority, as well as helpful information about Current Time spent processing, when
the job started (Start time), when it ended (End time) if it has ended, the length of the
output media file (Media Duration), how many times the job has attempted to run
(Attempt), the machine the job ran on, who submitted the job, and how long the
encoding task took to run (Task Duration).

Right Panel Status Selections

The following selections are available in the right tasks panel. Each column label can be
clicked to sort the tasks list.

Search. Allows entering and searching for a task by file name.

Job. Lists tasks based on task file name and task type.

Task Name. Lists the names of tasks

Progress. Shows the current progress for each task.

Priority. Shows the priority of each task.

Current Time. Shows how much time has been spent so far processing each task.
Pass. Indicates whether each task has passed or failed.

Start time. Shows the time each task was started.
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End (Stop) time. Shows the time that each completed task was finished.
Media Duration. Shows the length of the transcoded output file for each task.
Attempt. Shows how many times the task has attempted to complete.
Machine. Shows which machine the task is running on or has run on.
Submitter. Lists who submitted the associated workflow.

Task Duration. Shows how long the task took to complete.

Resume/Pause/Stop/Requeue Job (bottom buttons). Use these player-like controls
to restart, pause, or stop activity on the selected (highlighted) job. The Requeue Job
button resubmits the job to the queue to repeat processing.

Using the Preview Window

The Preview windows displays the source video, optionally before and after an encoder
has been applied to it. This window works like a simple video player and editor for
viewing a media file or the output of a workflow task before you save and submit the
workflow. The preview is updated in real time, so that you can modify the settings of a
filter and immediately see how different values affect the output.

To open the Preview window, select View > Preview Window (Command-1).

Figure 48. Preview Window
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At the top of the Preview window, controls are provided to change the source and
encoder for the current preview and to change the size of the image in the Preview
window. You can also turn all filters on or off or split the screen to indicate the effect of
filtered compared to unfiltered video. When filtering is on, to move the filter split screen
divider, click on the divider and drag it to the position you want. While filters are on, you
can edit them in the Inspector and watch the preview video change.

The bottom of the window includes buttons for play, step back, step forward, jump to
start, jump to end, set mark in, set mark out, jump to mark in, jump to mark out. The
camera button allows you take a snapshot and save it.

A timeline displays progress as the clip plays, and a Current display displays the current
position of play. Mark In and Mark Out displays show where you have marked encoding
for the clip to start and end so that you encode only the selected portion of the source.
A button below and to the right of the timeline allows magnifying the timeline.

Source. Displays the currently selected source file, or the default preview source if no
media is present. If you have only a single source file, selecting the source box is
enough. If you have multiple source files in your workflow when you open preview, this
box will allow you to select which piece of media you would like to preview. Select a file by
clicking in the file list in the source box. Preview displays the effect of the currently
selected encoder applied to the currently selected source.

Encoder. Enables you to view the results of using different encoders by moving them
into the workflow and previewing your media.

Filters. Displays the filtered view over the entire window. Left and Right display the
filtered view in the left or right part of the window, respectively; dragging the mouse in
the window moves the separator further left or right. Off turns off the filtered view,
except for Deinterlace and Resize.

By default, the full timeline is displayed, but for long video sequences the resolution
may not be enough to allow you to select the precise point you want. Select a suitable
scale with the zoom slider. The zoom is centered around the current point. Use the
scrubber slider to select the region of the timeline to be shown in the scrubber.

Resize. Changes the display size of the image in the Preview window. Select Half Size |
Normal | Double Size | Resize to Window.

Player Controls. In addition to playing the clip and moving to its ends, you can set in
and out points (for restricting encoding duration) directly in the timeline. See Setting In/
Out Points. You can move to the in or out point by clicking the corresponding button.
For a description of each control, see Preview.

Capture Frame. Save the current preview image as a file in BMP | GIF |[JPEG | PNG | TIFF
format.

Using the Cluster Window

The Cluster Browser is a window that displays all Episode nodes on the network, and
their relationship (if any) with each other. The Cluster Browser window allows you to
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view, create, and join Episode clusters to take advantage of multiple computers for
features such as Split-and-Stitch.

Note: You can set cluster processing behavior in Preferences. See Setting Preferences.

The Cluster Browser displays all Episode clusters and nodes visible on the network.
Open the cluster browser with View > Cluster Window (Control-2).

To display the Cluster Browser window, select View > Cluster Browser.

Figure 49. Cluster Browser
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A cluster is a named collection of computers with Episode installed that work together
to process Episode workflows. Each instance of Episode running on a computer is called
a node. You can define a cluster temporarily to process a specific large job, or you can
create clusters and leave them in operation for long periods.

Use the drop-down menu to create clusters, join existing clusters, specify the master of
a cluster, or specify that your machine is working alone. The Cluster Browser displays
the existing clusters, and clicking their popup menus displays the machines in the
cluster.

Each cluster item can be expanded to display the nodes in that cluster.

A list of Machines Working Alone, indicates nodes that are not members of any cluster.
To manage clusters using the drop-down menu:

Operate Alone. Handle all jobs locally.

Create Cluster. Create a new cluster with the current node as master.

Submit to selected cluster. Submit to a cluster, but do not receive submissions.

Join Cluster. Join the selected cluster to submit to and receive from a cluster.

Join or Submit by IP or Host Name

To join or submit to clusters by IP address or DNS host name (for hosts not on your local
subnet), click the gear menu in the lower right corner and select Join or Submit:
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Join Cluster Via IP Address/Host Name. Select this option and enter an IP address or a
DNS host name to join the specified cluster, allowing you to submit jobs to or receive
jobs from the cluster.

Submit To Cluster Via IP Address/Host Name. Select this option and enter an IP
address or DNS host name for the master of the cluster. This will allow you to submit
jobs to the specified cluster, but you will not receive any jobs from the cluster.

After you join or submit, the Cluster Browser window indicates that you are joined to or
submitting to a cluster. To return to working alone, use the top drop-down menu to
select Operate Alone. The Cluster Browser window indicates private operation.

Figure 50. Cluster Browser Join by IP or Name (Submit is similar)
17 Cluster Browser @M
- This machine (w-chuckp) is private

" Choose An Operation

Clusters Found On Local Network
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Using Named Storage

The Named Storage feature allows you to define a storage location, such as a SAN, with
a user-configurable name so that the same physical location can be used across Mac
and Windows platforms even though the local path to that storage is different on each
machine. Named Storage can be used within a cluster to permit access to files by
multiple machines of either platform belonging to the cluster.

Named Storage is implemented using CLI commands, which means that you must have
Episode Pro or Engine with API. For instructions in using the CLI, please refer to the
Episode Advanced User’s Guide. To access CLI help for instructions in using Named
Storage, enter the following in the CLI:

Windows: episodectl ns --help

Mac: ./episodectl ns --help

Named Storage Simple Example
Windows Machine1 accesses a media location on a SAN using a windows path S:\
Mac Machine2 accesses the same location using a mac path /Volumes/MediaSAN/

In order for Episode to recognize both locations as the same physical storage, the CLI
Named Storage feature must be used. You enter a CLI command on each machine that
gives the physical location a name common to both machines. Then when that location
is used, the system compares lists of named storage and matches them up so that the
10 Server is not used and the files are moved directly from that storage. These are the
commands you use for the two Windows and Mac example machines:

On Windows Machinel: episodectl ns --add MediaSAN S:\
On Mac Machine2: ./episodectl ns --add MediaSAN /Volumes/MediaSAN/

Named Storage Cluster Example

You can also set up Named Storage to work with an Episode cluster, as this example
illustrates. Adjust details shown in the example to fit your situation and network.

Note: Named storage must be defined on all machines before they join the cluster.

Starting Conditions
1. A network location is mounted on a Mac with the volume name “studioshares”.

2. Note the folder level where the “root” of this mounted volume is located:
smb://<servername>/<folder1>/<folder2>/studioshares/

3. Also note that once mounted, the path to this location on this machine is this:
/Volumes/studioshares/

4, On Windows, you need to establish and note the full network path to this same
location. In this example, “studioshares” is a shared folder on the server:
\\<servername>\<folder1>\<folder2>\studioshares\
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Named Storage Setup
5. On the Mac, define the named storage:

-/episodectl node storage --add stgservices /Volumes/
studioshares/stgservices/

6. On Windows, define the same named storage but use the full network path:

episodectl node storage --add stgservices \\<server-name>\<fold-
erl>\<folder2>\studioshares\stgservices\

Note: If there are any required user credentials for this server, add them as part of the
path when defining the named storage:
\\<user>:<password>@<servername>\<folderl>\<folder2>\studioshares
\stgservices\

The key detail to remember regarding the named storage defined path is that it

Ta 1

must end in the same directory on all machines. In this case it’s “stgservices”
7. Create the cluster.
8. Join or submit to cluster all client machines.

The cluster should now be operational and the named storage accessible to all
machines in the cluster.

Note: If you need to add new named storage to an existing cluster, you must take
down the cluster first and ensure that all machines are working alone. Then you can
add new named storage to each machine, create a new cluster, and join or submit to
cluster all the machines that you want to include in the cluster.
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Setting Preferences

Select Tools > Preferences to display the Preferences window. The Preferences window
has several tabs: General, Cluster, License, Update, and Advanced.

m Using the General Tab
m Using the Cluster Tab
m Using the License Tab
m Using the Update Tab
m Using the Advanced Tab

Using the General Tab

Use the general tab to set up your preview options, specify the number of
simultaneous encodes, specify how long to keep job history, and reset your user
interface warnings.

Figure 51. Preferences—General Tab

License Update Advanced

v Keep preview window on top

Default Source:

Simultaneous Encodes.

| 32 Recommend

Job History

Keep for 24 hours Clear History

UTWarnings

Reset

Application logging level:  FaTAL v Clear Log File

Preview—Keep Preview Window on Top. Check to always display the Preview
window on top of all other windows in Episode.

Preview—Default Preview Source. Click Browse to navigate and select the source to
display in the Preview window.

Simultaneous Encodes. Use the slider to set the number of jobs that can execute in
parallel on this platform (node). Higher license levels can encode more simultaneous
jobs. With the Engine license, Episode can encode up to 32 simultaneous jobs.

The number of jobs you can run efficiently in parallel is independent of the number of
cores available in the host machine. In a transcode, each component (file parser,
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decoder, filter, encoder and exporter) runs separately and can use separate cores.
Consequently, a typical HD ProRes transcode to H.264 can use 4 or 5 cores or more.

Calculating the optimal number of jobs to run in parallel depends on several factors:
» Cores: Always run fewer jobs than you have hardware cores.
¢ Memory: For HD jobs you need at least 2GB of memory per job.

» Resolution: If you are coding smaller (lower resolution) files, you can run more jobs
in parallel than if you run HD or 4K jobs.

To determine the optimum number of parallel jobs to specify for a typical batch, see
how long the batch takes using the number recommended by Episode. Then first
increase and then decrease the number of parallel jobs to pinpoint the best setting.

Recommend. Click to allow Episode to set the number of simultaneous encodes to the
volume considered best for this platform. The maximum number of simultaneous
encodes are also controlled by your license level.

Keep Job History. The Status window displays submitted jobs in queue, executing, and
also for a given period after they have finished. See Using the Status Panel.
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Select how long you want to keep job history information from the options in the
dropdown menu:

» Keep for 1 hour
» Keep for 24 hours
o Keep for 1 week

« Clear Manually (retains the history indefinitely, until explicitly deleted)

Job history is cached locally on each node. When you connect to a cluster the master
node of that cluster transfers the job history to you.

Clear History. Click to permanently remove the job history information. Deleting the
job history on a cluster’s master node makes the earlier history unavailable to new
nodes, but existing local history caches are retained until purged on those nodes.

Ul Warnings—Reset. Click to reset the user interface warnings to the factory default
settings, so that they start displaying again.

Application Logging Level. Select the level at which you want logging to be active.
When a level is selected, all events at that level and above will be logged.

None—Nothing logged.

Fatal—Only errors that cause Episode to crash.

Error —Standard errors, such as workflows failing etc.

Warn—Any warnings that workflows generate.

Info—General events, minor errors, and state changes pertaining to normal operation
of Episode and workflows.

Debug—All levels of errors, warnings, and events are logged.

Clear Log File. Click to permanently delete the entries in the log file. The log file is
located at C:\Users<user name>\AppData\Local\Telestream\episode_log.txt.

For more information see Edit Menu, Technical Support Information.
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Using the Cluster Tab

Episode 6.5

Use the Cluster tab to set up cluster operational preferences.

Note: When operating as part of a cluster, deployment tasks always execute on the
same server as the encode task in the job. In Split & Stitch jobs, deployment tasks
execute on the same server as the stitch task. This is done to minimize network file
transfer inefficiencies. The only way to disable this feature is to use the XML/RPC

interface.

Figure 52. Preferences Window—Cluster Tab
P e [

General License Update Advanced

Private Mode

V¥ Visible on network

Cluster Participation Mode

Only accept jobs submitted by me

Cluster Master Mode

v Run Jobs

Job Scheduling: Load Balanced

Private Mode—Visible on network. When your node is not part of a cluster, check to
make this node visible in the cluster browsers of other nodes.

Cluster participation mode—Only Accept Jobs Submitted By Me. When your node
is part of a cluster, check to enable this node to submit jobs to other nodes in the
cluster, but only accept submissions from itself.

Run Jobs . When this node is the master node of a cluster, check to determine specify
that this node can also run jobs, or uncheck to just assign them to the other nodes in
the cluster. You can thus use a low-end machine as cluster master, sending jobs to more

powerful nodes.

Job Scheduling [Select from dropdown]. Select to assign jobs to cluster members
and select how to schedule jobs:

Round Robin simply sends jobs to each node in order.

Hardware Balanced is more likely to send jobs to more powerful nodes, as determined
by processor number, speed, and memory size.

Load Balanced uses the same capacity computation as Hardware Balanced but in
addition considers the current CPU load on all nodes.
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Using the License Tab
Use the License tab to add, remove, or deactivate a license on this computer.

If you are purchasing additional licenses for use of Episode on other computers,
Telestream recommends that you purchase them directly from the Telestream Web
store at http://www.telestream.net/purchase/store.htm.

When a license is selected in the list, you can copy it or click the Copy button to place
the license on the clipboard.

Note: If your Episode Engine is connected to a cluster, you must remove it from the
cluster (see Using the Cluster Window) before making license changes. Make the
changes, then add it back to the cluster.

Figure 53. Preferences—License Tab
25 Preferences S

General Cluster Update Advanced

Add. Click Add (+) to open a window where you can enter or purchase a license. Enter
the license serial number in the Serial Number field. If you don't have one, click Purchase
to enter our online store where you can purchase a license and enter it here.

Figure 54. Adding a License
57 Add License M

Serial Number:

Remove. Select a serial number and click Remove (-) to remove it. You should do this if
you intend to move your license to some other computer. It is suggested that you save
the serial number in a text file, so as not to lose it.

Deactivate. Select a serial number and click to deactivate it but leave it available in this
window for later use.
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Using the Update Tab

Use the Update tab to check for and install Episode software updates.

Figure 55. Preferences—Update Tab

-
57 Preferences
General Cluster  License

Update Settings

Episode Checks for new and updated versioned of the software automatically.

Check for Updates:  Weekly v Check Now
Daily

Lo Check Tor Updats T
Monthly

2/27/2015 10:25 AM  Never

Update Settings—Check for Updates. Click the popup menu to set how often
Episode checks for new software versions. You can choose Daily, Weekly, Monthly, or

Never.
Check Now. Check immediately for new versions.

The Last Check for Update field indicates when the last check was made.
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Using the Advanced Tab

Use the Advanced tab to set background processing and other processing options.

Figure 56. Preferences—Advanced Tab
P e [

General Cluster License Update
Background Processing

¥ Start working on computer startup
]

V' Act as a low priority process

Specify Windows User Account for File/Folder Access

Notice: the user account needs administrator rights.
V' Use default

User Name: Example: domain\usemame

Password:

Serve Files To Old Clusters For

Two Davs v

File Cache Path - (a folder called "EpisodaCache’ will be created inside this folder)

Browse... Reset To Default Clear Cache

Background Processing. You can specify whether or not the Episode services run in
the absence of the Episode desktop application. This can be useful if you need to run
Episode interactively as part of an encoding cluster and you want it to keep working

when you are not logged in. See Episode Components.

Start working on computer startup. Check to start and run all Episode processes,
whether a user is logged in or the Episode application is running or not.

Keep working after application quits. Check this to allow Episode to keep processing
workflow tasks even after the user closes the application.

Act as a low priority process. Choosing this option allows Episode to run as a lower
priority process so that it does not draw excessive processing power away from
foreground applications that need to be responsive to user input.

Specify Windows User Account for File/Folder Access. Since Episode services can run
even if a user is not logged in or when running Episode as a non-administrator, you
must specify what access rights should be assumed for the processes. The account that
you specify must be an administrator with a password.

Note: Since all processes run in their own context, they only have access to the UNC
volumes (in the form \\Server\Volume\File) the user has in their password cache.

Use default. Use the access rights of the SYSTEM user (which must be an administrator
with password).

To use Episode to give a non-administrative user administrative access to Episode
Services, start Episode using an administrator account.
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Deselect (uncheck) Use Default in the Specify Windows User Account for File/Folder
Access and enter a username and password (administrator account) that will access
Episode services for the user.

User Name. Enter the name of the administrator account to use, in the form
<domain>\<username>.

Password. Enter the password of the selected account.

Close Episode, restart Windows as the Episode non-administrative user, and open
Episode again. The user should now be able to run Episode without being an
administrator, and Episode itself will log in with administrative rights.

Serve files to old clusters for. Use the popup menu to specify how long Episode will
continue to have access to files on machines that have resigned from a cluster. During
that access time period, the machine that has resigned will continue to supply any files
that are part of a job being processed by the cluster, but the machine will not
participate in processing the jobs.

If you often create ad-hoc clusters for encoding several jobs and then break the cluster
up into machines working alone, this setting will ensure that if a machine serving files
leaves the cluster, those files will still be accessible to the rest of the encoding cluster
even after it has resigned.

File Cache Path. Some encoders write temporary files during encoding, and Split-and-
Stitch jobs write temporary files during processing. If you have a faster disk somewhere
else than the default location you can use a cache directory on that disk.

If you have an Episode cluster, and you are using shared storage (SAN, NAS, etc.) then
you should set the file cache path to the same location on all nodes in the cluster.

Note: You should not change the cache directory, nor clear the cache while jobs are
executing, because it is likely to cause the jobs to fail.

Browse. Set the cache directory.

Clear Cache. Delete all cache files. You should normally never need to do this, unless
for some reason large cache files have not been automatically purged.

Set Default. Set the cache directory to CAWINDOWS\TEMP\,

Using the Episode Premiere Plug-in

There are some preliminary steps and two basic workflows for using the Episode
Premiere plug-in:

m Preliminary Steps
m Exporting and Encoding a Media File
m Encoding Media Files in a Timeline Sequence
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Preliminary Steps

Before you begin using the Episode Premiere Pro Plug-in, there are some steps to
complete:

Make sure the Episode systems you want to access are available on your local net-
work and are configured for your desired workflow.

In Episode, create and export Episode epitasks and deployment epitasks config-
ured to deliver the outputs you desire. These epitasks will be used in the following
Premiere workflows.

Exporting and Encoding a Media File

The following workflow example demonstrates how to use Episode from within Adobe
Premiere:

1.

Start Adobe Premiere Pro and create a new project.

2. In the Media Browser, double-click a media clip. The file opens in Source Monitor.
3.
4. In the Export Settings window, select the following:

Select File > Export > Media. The Export Settings window opens.

- Format: Episode Exporter
— Video tab > Configure Settings button

The Episode Export window opens, and Bonjour scans the network for Episode
instances that you can select to use for encoding.

. In the Episode Export window (see figure below), make the following selections:

a. Use Choose Episode host to select an Episode system or cluster to perform the
encoding.

b. Use Choose Target folder to specify a destination for the encoded file.

c. Select the Encoding Mode (Use Export First, then encode—for 1.0 this is the only
working mode).

d. Select Intermediate Quality to choose the video quality.

e. Use Choose Encoding Task to select an epitask that you created and saved
previously using Episode. You can use the Add button to browse and add more
epitasks to the list.

Note: If you select a deployment epitask here, Episode delivers the file twice—
once to the target folder and again to the deployment task output.

f. Click OK, and then click the Export button in the Export Settings window.

The selected Episode system begins encoding the selected media file. Premiere shows
an encoding progress bar, and you can also watch progress and view status information
in the Status window on the Episode system.
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When encoding is complete, the encoded file appears in the target folder specified by the
epitask.
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Encoding Media Files in a Timeline Sequence
You can also use Episode and the Episode Premiere Pro Plug-in to encode multiple files
on an Adobe Premiere Pro Timeline:
1. Import or drag and drop a media clip onto the timeline to create a sequence.

2, Play the clip in the timeline and edit as desired, including marking in and out
points.

3. Repeat steps 3-5 of the previous procedure—Exporting and Encoding a Media File—
to encode the media file used in the sequence.

Encoding progress is displayed in Premiere and can also be viewed in the Episode
Status window. Your encoded outputs will be placed in the target folder specified by
the epitask.

This concludes the description of Episode with Adobe Premiere. For more information,
please visit the Telestream.net and Adobe.com Web sites.
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This chapter provides details about Episode all menus and their menu items.
m File Menu
m Edit Menu
m View Menu
m Media Browser Menu
m Library Menu
m Tools Menu
m Preview
m Help Menu
m Shortcuts By Menu

File Menu

New Workflow. (Control-N) Select to display a new, unnamed workflow in the
Workflow panel, with three empty tasks: source, encoder, and deployment.

New > New Source. Select to create a new, untitled source task in your current
workflow. You can only have one source in a workflow.

Windows systems include specific source selections: File List, Watch Folder, and
Image Sequence.

New > New Encoder. Select to add a new, untitled encoder task to your current
workflow.

New > New Deployment. Select to add a new, deployment task to your current
workflow.

Windows systems include specific deployment selections: Desktop and YouTube..

Save Workflow As. (Control-Shift-S) Select to save the current workflow as a new item
or use the same name to overwrite.
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Save Task As. (Control-Alt-Shift-S) Select to save the highlighted task as a new task
with a new name or use the same name to overwrite. Enter a name in the Inspector’s
Name field. Tasks are saved in the Library.

If the item has already been saved as a user task, you can right-click on the name in the
library and select Rename <item>. System tasks cannot be renamed.

Import. (Control-O) Select to import tasks or workflows. Episode displays the Open
dialog, where you can navigate and select the task or workflow to open.

Export Task. When a task is selected, select to display a file system dialog, where you
can navigate to your target directory and save the task. Episode task files are saved with
an epitask suffix. You can archive these files, move them to other servers, and import
them in other Episode instances.

Export Workflow. (Control-Shift-S)Select to display the file system dialog, where you
can navigate to your target directory and save the workflow. Episode workflows files
are saved with an episubmission suffix. You can archive these files, move them to other
servers, and import them in other Episode instances.

Edit Menu

Most Edit menu commands function the same as they do in other applications. A few
are unique to Episode.

Undo. (Control-Z) Roll back to the state before your last action.

Redo. (Control-Y) Restore the state you just used Undo to roll back.

Copy. (Control-C) Copy the highlighted text or selected object to memory.

Cut. (Control-X) Remove the highlighted text or selected object and store it in memory.

Paste. (Control-V) Place the previously copied or cut text or selected object from
memory into the target component.

Delete. (Del) Remove the highlighted object.
Select All. (Control-A) Select all objects in the selected panel.

Set as Deployment for All Encoders. When a Deployment is highlighted, select to
automatically use this Deployment for all encoders.

View Menu

Preview. (Control-1) Select to open the video Preview window.

Cluster Browser. (Control-2) Select to open the Cluster Browser window.
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Media Browser Menu

Add Bookmark. Open the Inspector panel and select to create a new, unnamed
bookmark. Configure the bookmark and click Save to create the bookmark and display
it in the Media Browser.

Add As Watch Folder. (Control- +) Add the selected folder as a watch folder.
Add As Deployment. (Alt- +) Add the selected object as a deployment.
Add to Workflow. (+) Add the selected object as a workflow.

Library Menu

Browse Workflows. (Control-Alt-W) Select to display the Workflows tab in the library.
Browse Sources. (Control-Alt-S) Select to display the Sources tab in the library.
Browse Encoders. (Control-Alt-E) Select to display the Encoders tab in the library.

Browse Deployments. (Control-Alt-D) Select to display the Deployments tab in the
library.

New Source. Select to create a new, unnamed source task in the library. This command
can create a watch folder or afile list, depending on what you select in the menu.

New Encoder. Select to create a new, unnamed encoder task in the library.

New Deployment. Select to create a new, unnamed deployment task in the library.
Two selections are available directly in this menu: Desktop and YouTube. The YouTube
selection allows you to fill in the inspector with your YouTube login and details so you
can deploy directly to your YouTube account.

Rename <item>. Select to highlight the name text of the selected item (in any of the
sections) in the library, so you can edit it.

Duplicate <item>. (Control-D) Select to duplicate the item in the library. Episode
creates a new item identical to the selected item, adding a numeric suffix to its name.
Edit the name of the duplicated item as appropriate.

Remove <item>. (Delete) Select to permanently remove the selected workflow in the
library.

Add to Workflow. (+) Select to add the selected library task to the current workflow. In
the case of a source task, the current task (if any) is replaced by the new task, because
only one source per workflow is permitted.

Tools Menu

Episode 6.5

Submit Workflow. (Control-R) Select to activate a workflow and begin monitoring,
encoding, and deploying.
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Submit Workflow As MBR. (Control-B) Select to activate a workflow and begin
monitoring, encoding, and deploying a multi-bit-rate workflow. (MBR is available only
with Pro and Engine licenses.)
Preferences. Select to open the Preferences panel and set preference options.
Preview

The following commands are available in the Preview window.

Play. (Space) Select to play the video normally. Select again to pause the video.

Step Forward. (Right Arrow) Select to step the video forward a single frame at a time.
Step Backward. (Left Arrow) Select to step the video backward a single frame at a time.
Half Size. (Control-Zero) Select to display the preview at half the actual size.

Normal Size. (Control-1) Select to display the preview at the actual size, up to the
maximum size of the monitor. This is the default size.

Double Size. (Control-2) Select to display the preview at double the actual size, up to
the maximum size of the monitor.

Fit to Window. (Control-3) Select to display the preview video at the size of the current
window. Continues to adjust size as you adjust window size.

Fit to Screen. (Control-4) Select to maximize the window and display the preview at
the maximum monitor size.

Set Mark In. (Control-i) Select to set the mark in value at the current frame.

Set Mark Out. (Control-o0) Select to set the mark out value at the current frame.

Jump to Start. (Home) Select to go to the beginning of the current clip.

Jump to End. (End) Select to go to the end of the current clip.

Jump to Mark In. (Control-Shift-i) Select to jump to the current mark in value, if set.
Jump to Mark Out. (Control-Shift-o) Select to jump to the current mark out value, if set.

Snapshot. (Control-Alt-c) Select to take a snapshot of video in the preview window and
save it to the location you specify as a JPEG file.

Zoom Timeline In. (+) Magnifies the timeline.

Zoom Timeline Out. (-) Restores the timeline to normal size.

Help Menu

Episode Help. Displays the Episode User’s Guide (the document you're currently
reading) and support information.
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Technical Support Information. Displays a tabbed window with information
beneficial to assisting user’s with problems using Episode. Click OK to save all of this
information in a zip file, which you can send to Telestream Customer Service for

analysis.

About. Displays the About Episode window, where you can view the version of Episode

you're using.

Shortcuts By Menu

Episode 6.5

Episode provides shortcuts for many menu items. These tables list Episode menu items

with shortcuts, organized by menu. Common operating system shortcuts, such as in

the Edit menu, are not listed.

Table 5. File Menu Item Shortcuts

Menu Item Shortcut

New Workflow Control-N

Save Task As Control-Alt-Shift-S
Save Workflow As Control-Shift-S
Import Control-O

Table 6. Media Browser Menu Item Shortcuts

Menu Item Shortcut
Add As Watch Folder Control - +
Add As Deployment Alt-+
Add to Workflow +

Table 7. Library Menu Item Shortcuts

Menu Item Shortcut
Browse Workflows Control-Alt-W
Browse Sources Control-Alt-S
Browse Encoders Control-Alt-E
Browse Deployments Control-Alt-D
Duplicate Item Control-D
Add to Workflow +
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Table 8. Tools Menu Item Shortcuts

Menu Item Shortcut

Submit Workflow Control-R
Table 9. Preview Control Shortcuts

Menu Item Shortcut

Show | Hide Preview Control-1

Play Space

Step Forward Right Arrow

Step Backward Left Arrow

Half Size Control-Zero

Actual Size Control-1

Double Size Control-2

Fit to Window Control-3

Fit to Screen Control-4

Set Mark In Control-i

Set Mark Out Control-o

Jump to Start Home

Jump to End End

Jump to Mark In Control-Shift-i

Jump to Mark Out Control-Shift-o

Capture Frame To Disk Control-Alt-c
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Concepts

This chapter discusses encoding concepts and how they apply to Episode transcoding.
m File (Container) Formats And Codecs
m Color Formats
m Video Scan
m Frame Types and |, P, and B Frames
m Picture Resolution and Aspect Ratio
m CBR, VBR, and Quality-Based VBR
m VBV Video Buffer Verifier
m Frame Skip Probability Smooth Motion Vs. Crisp Image

File (Container) Formats And Codecs

Many media file/container formats are actually wrappers—they contain video and/or
audio data encoded with one of a number of codecs—each with their own format.

While many media files contain a single audio track, or a single video (with audio) track,
some media file formats (QuickTime MOV format for example) contain multiple media
tracks.

Each track may have a different resolution, bandwidth, language, etc. Consequently,
even though a file may be in a format supported by Episode, the media contained
inside the file may be encoded with a codec that is not supported, leading to an error
during transcoding.

For details on the encoders and codecs supported by Episode, see Media Containers/
Formats.
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Color Formats

Color Formats

The most basic way to represent color in both still and moving digital images is to use
the RGB color space. In RGB each pixel has three values: red, green and blue, which are
mixed to generate the intended color. This is the way most computers store and display
color.

However, the RGB color space is not represented in most video codecs, due to the way
television emerged, at first with only black and white images and later with color
images.

The color format for television was designed to contain all the black and white
information in one channel, and the color information in two additional channels. The
black and white channel is called luma (light), and the two color channels are called
chroma (color). The separation of luma and chroma make it possible for older, black and
white televisions to still work, only processing the black and white image, while color
televisions can benefit from the color information.

This color space is called YUV, or YCbCr. Y is the luma and U (Cb) and V (Cr) are color
differences—the luma subtracted from a transformed blue and red, respectively. (The
green values are not passed in the signal—they are computed from these values.) This
encoding has several advantages over RGB in terms of video compression, since most
of the image information ends up in the luma channel and the chroma channels hold
much less information for most video material. This, in combination with the fact that
human visual perception is less sensitive to color than to brightness, makes it possible
to sample the chroma more sparsely, thereby reducing the amount of data required to
store (and transmit) an image.

The subsampling pattern is commonly given in the notation (a):(b):(c), which is
interpreted in the following manner: In a block of size (ax2) there are (ax2) luma
samples. (b) is the number of chroma samples along the top row and (c) is the number
of chroma samples along the bottom row. In other words, 4:4:4 means there is a chroma
sample for each luma sample—no subsampling. 4:4:0 means every second row has full
chroma samples and every second is skipped. 4:2:2 means every second column has
full chroma samples and every second is skipped. These two therefore have (2/3) the
number of total samples, compared to 4:4:4. 4:2:0 means every second row has chroma
samples for every second column, thus halving the number of total samples compared
to 4:4:4.

Luma and chroma samples are not necessarily taken at the same positions relative to
image pixels, but that is beyond the scope of this manual. For more information, refer to
an article by Doug Kerr: Chrominance Subsampling in Digital Images (The Pumpkin,
November 2005).
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Video Scan

Video Scan

Episode 6.5

Video material (de-interlaced or interlaced) can be rendered either a full frame at a
time, a progressive scan, or with every other line of the frame at a time—interlaced
scan.

The two half-frames in interlaced video are referred to as the top and the bottom fields.
One of the fields is the dominant field and should always be played back first.

When encoding material to be recorded on DVD and played back on a television, it is
important that the dominant field is set as the first field. If you have not edited the
material you are going to encode, it can be difficult to know whether the dominance
lies in the top or bottom field.

These are the normal field dominances of common formats:

Table 10. Common Formats and Field Dominance

Format Field dominance
DV 25 Bottom Field
DVCPRO 25/50 Bottom Field
DVCPRO 100 HD Top Field

IMX Top Field

Apple Intermediate Codec Top field

Uncompressed 4:2:2 Top field

Much of today’s digital video is generated from non-interlaced film material, where a
single film frame may be sampled several times to generate video fields. This technique
is known as telecine.

For NTSC material this is typically done by taking 3 fields from one frame and 2 from the
next (known as 3-2 pulldown); for PAL, 2-2 pulldown is normal. Knowing this sequence
of fields—the cadence—can greatly improve the quality of deinterlacing. Typically
subsequent editing breaks up the cadence, but Episode detects and adapts to broken
cadences.

For more information, read the article entitled DVD benchmark—~Part 5—Progressive
scan DVD, by Don Munsil and Brian Floria in Secrets of Home Theater and High Fidelity,
7(4), October 2000.

Note: The preferred method of working with interlaced material in Episode is to
deinterlace any interlaced source material to double-frame rate progressive material,
apply video filters and then, if needed, re-interlace the material before creating the
output file. See Field Order Filter, Frame Rate Filter, Deinterlace Filter, Advanced Frame
Rate Filter, and Interlace Filter for further information.
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Frame Types and |, P, and B Frames

Except for raw data formats and editing formats such as DV or Motion JPEG, most video
formats do not simply consist of a sequence of frames, allowing them to be decoded
independently. Since a video frame often looks a lot like its neighboring frames, a video
codec typically searches for differences between frames to achieve a good
compression ratio (temporal compression). Only the differences between these frames
are stored in the encoded video file. However, for the encoded stream to be decodable,
independent frames with full content—which can be decoded directly—must be
scattered throughout the clip. These frames are called keyframes, or I-frames.

To decode a frame at a certain time in the movie the decoder must therefore begin the
decoding process at the nearest previous key-frame and decode to the desired frame.
Keyframes spaced far apart make the clip hard to search, but result in a good
compression ratio. Accordingly they are good for streaming material in which searching
is not usually done. A compromise is to limit the distance between keyframes to some
maximum distance. This is used in most encoded video material.

A frame that predicts data from a previous frame is called a P-frame (Predictive Frame). A
frame that predicts data from both a previous and a subsequent frame is called a B-
frame (Bi-Predictive Frame). The use of B-frames provides a somewhat better
compression ratio, but is also more CPU intensive.

In MPEG-derived formats, the sequence of frames from an I-frame to the next I-frame is
known as a Group Of Pictures (GOP).

Picture Resolution and Aspect Ratio

A digital video frame is a serial stream (ordinal sequence) of pixels which represents (or
displays as) a two-dimensional lattice of pixels, where each pixel has a given color.

Figure 57. Aspect Ratio Example
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Video Encoding Concepts
Picture Resolution and Aspect Ratio

In the diagram above, a lattice of (m x n) pixels is represented. M x N represents the
pixel resolution of the image. The aspect ratio of the display is (width:height). While
computer displays normally have an aspect ratio which is identical to (m:n) (thus the
pixels are square), this is often not true for televisions.

In cases the pixels on the monitor are not square, the pixel aspect ratio = pixel
width:pixel height <> 1:1.

For example, PAL is defined as 720 x 576 pixels, with a display aspect ratio of (4:3. Since
720:576 = 5:4 this means the pixel aspect ratio is 16:15.

SVCD is a video format that is stored on CDs and often played on computers. SVCD
stores NTSC video in 480 x 480 pixels with a pixel aspect ratio of 4:3. The consequent
display aspect ratio of 4:3 requires the player software to stretch the pixels,
interpolating along the horizontal axis to show the image on 640 x 480 square pixels.
Compressing dimensions in this way is known as anamorphic video.

Some codecs (D-10/IMX, DV, MPEG-2 and MPEG-4 in particular) allow the user to set a
display aspect ratio for the output video in order to inform a player of the desired
aspect ratio for viewing. However, this field is inconsistently used—in particular its 1:1
setting does not mean that the display is square, but rather that the pixels themselves
have a square aspect ratio. Often this field is also labelled as pixel aspect ratio. There is a
risk that different equipment interprets this field in different ways.

QuickTime enables you to explicitly set the pixel aspect ratio if it is different from the
display aspect ratio.

In Episode, you can also use the resize filter and the codec settings to manage pixel
resolution and aspect ratio. See Resize Filter.

For example, to create an SVCD video, use the resize filter and set both Width and
Height to 480 in order to get the desired pixel resolution. Set the Aspect Ratio to 4:3 in
the MPEG-2 codec settings to get the desired display aspect ratio.

If the input data has a non-square aspect ratio and this is not indicated in the source file
(or if you wish to override this setting), you can configure the resize filter to use the
Input display aspect ratio menu. Continuing with the example of SVCD video, first
convert it to PAL output. The (m:n) ratio is not the same for SVCD and PAL, so you
should select Cut in the Maintain Proportion With menu and set the Input display
aspect ratio to Assume 4:3. In the codec, set Aspect ratio to 4:3 or Same as Input.

Finally, to convert from one pixel resolution to another, you have two options: either to
scale the smallest dimension to fit the output format and cut off parts of the largest
dimension, or to scale the largest dimension to fit and pad the smallest dimension with
black.

Example: You have an HD video of 1280 x 720 pixels and you want to encode it as a PAL
video at 720 x 576 pixels while retaining as much of the picture as possible. You use the
resize filter and set the Maintain Proportion With menu to Letterbox (Pad), scaling
down the width of the picture until it fits. This shrinks the vertical dimension to 324
pixels and the picture has 126-pixel black borders along the top and bottom as shown
in the figure below.
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Figure 58. Converting HD to PAL with Letterbox Formatting

The other alternative is to select Cut, where the vertical dimension is scaled to 576
pixels and the horizontal to 1024 pixels, of which 152 are cut off at both the left and
right sides as shown below:

Figure 59. Converting HD to PAL with Cut Formatting

Letterbox formatting retains the full width and fills in missing height and width; Cut
formatting retains the full height, but trims the edges. For more precise control you can
use the Initial crop values to crop parts of the picture before scaling with either cutting
or padding.
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CBR, VBR, and Quality-Based VBR

Constant Bit Rate (CBR), Variable Bit Rate (VBR) and Quality-Based VBR are encoding
options available in several video encoders. A clip encoded in CBR mode has a relatively
constant bit rate throughout its duration. CBR encoding is necessary when the content
is distributed over networks or from devices that cannot handle peaks that are higher
than the average bit rate.

However, the use of true CBR (also called Flat Rate), is difficult since it requires every
encoded video frame to be exactly equal in size. This degrades visual quality. I-frames,
for example, must be larger for overall quality to be high.

Different segments of a movie often require different bit rates in order to maintain
constant quality. The quality delivered by most modern video encoders partly depends
on the amount of motion and fine detail in the material. For this reason, VBR is superior,
while keeping the average rate at the desired level. VBR is more suitable for playback on
devices with higher available bandwidth. Since the average rate is known, it is still
possible to predict the resulting file size with good accuracy.

When quality is most important, Quality-Based VBR is the best encoding mode. Using
this mode you only specify the desired quality of the encoded material.

For each segment of the clip, the encoder uses the bit rate required to reach the
specified quality. Thus, file size cannot be predicted, since it depends on how difficult
the clip is to compress. For example, for the same visual quality, a 30-second clip of a
news anchor (low movement) yields a small file while a 30-second clip of a football
game (high movement) is significantly larger.

VBV Video Buffer Verifier

Episode 6.5

To control variations in bit rate when encoding, a Video Buffer Verifier (VBV) is used. The
buffer size determines the elapsed time over which the bit rate must be kept constant.
Episode measures the VBV in seconds. A buffer size of 0-5 seconds is considered CBR.
Setting the VBV value greater than 5 seconds is considered VBR. During the specified
VBV period the bit rate may vary without limits, as long as the average rate in the region
is correct.

This enables the codec to use higher bit rates for difficult segments and lower bit rates
for easier segments. A larger VBV enables the codec to encode difficult passages better,
since the bit rate is allowed to peak for a longer period of time. Some specifications
specify the buffer size in bits. In these situations, you can convert to seconds by
dividing by the bit rate.

Since the buffer size determines how much the bit rate may vary, it sets a constraint on
how long a player must buffer before starting playback, to ensure smooth playback
without need for re-buffering.

In practice, the size of the VBV buffer is a trade-off. A large VBV enables the encoder to
vary the bit rate more freely depending on the difficulty of the current part of the
material, while maintaining the correct average bit rate. However, the player has to
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Frame Skip Probability Smooth Motion Vs. Crisp Image

buffer a larger portion of the clip before playback can be started. A small VBV forces the
codec to encode at a more constant bit rate throughout the clip. This results in lower
quality for difficult passages, but the buffer time for the player is lower.

When encoding a clip with Quality-Based VBR there is no constraint on the size of the
VBV—it is ignored.

Frame Skip Probability Smooth Motion Vs. Crisp

Image

In order to maintain the specified bit rate, most video encoders vary the quality of the
encoded clip. Another alternative supported by some encoders is to skip frames when
the bit rate gets too high. This enables the encoder to keep a higher quality for each
encoded frame, but the motion of the video is not as smooth. Depending on the
material being encoded, smooth motion may be more important than crisp image and
vice versa.

The frame skip probability controls the trade-off between skipping frames and
lowering quality. A frame skip probability of 1 means that when the encoder has to
choose between lowering the quality or skipping a frame, it skips a frame. A probability
of 0 does not mean frames are never skipped, but that it only happens when image
quality cannot be lowered more.

Frame skip probability is also important to use when creating content for networks
with extreme bandwidth limitations such as GPRS, 3G or when streaming over
modems. These networks sometimes cannot handle even the slightest peaks over the
specified bit rate, and frames can be skipped to avoid this. When streaming to such a
device, set the priority towards sustaining the bit rate and sacrificing the frame rate if
necessary.

When encoding for a less bandwidth limited target platform, such as local playback on
a computer, the frame skip probability value can be set lower. This is possible since the
data rate from the computer's hard drive is sufficient to handle quite large bit rate
peaks.
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Media Containers/
Formats

This chapter describes each of the container/file formats you can encode or decode in
Episode, including each user-configurable setting. Each has a default file extension,
which you can change as required. Many formats also have settings that you can
configure.

Note: For a complete list of supported formats, see the Format Support document at
http://www.telestream.net/pdfs/datasheets/Episode6_Format_Support.pdf.

Each format supports a specific set of video and/or audio codecs, with details including
its ability to decode (in) and encode (out), plus notes about required subsystems and
other limits, as appropriate.

Episode decodes only one (the first) audio track in source files it processes, except for
MOV and MXF files. The track may contain multiple channels.

Episode decodes all audio tracks and channels in MOV and MXF source and creates one
track with all channels in it. For example, 2 stereo tracks becomes one track with 4
channels.

Note: Some formats require Episode Pro | Episode Engine, as noted.

m 3GPP (.3gp)

m 3GPP2 (.392)

m 3GPP2 EZmovie (.3g2)
m AC3/ATSC A/52 (.a52)
m ADTS (.aac)

m AIFF (.aif)

m AMR (.amr)

m AVI (.avi)

m DASH MPEG Streaming
m DV-Stream (.dv)
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m Flash (flv)

m Flash (.swf)

m GXF (.gxf)

m iTunes Audio (.m4a)
m iTunes Video ((m4v)
m MOV (mov)

m MP3 ((mp3)

m MP4 ((mp4)

m MPEG Audio (m1a)
m MPEG-ES (m1v)

m MPEG-ES (.m2v)

m MPEG-PS (mpg)

m MPEG-TS (.ts)

m MXF AS-11 (.mxf)

m MXF Op1a (.mxf)

m MXF OpAtom Audio (.mxf)
m MXF OpAtom Video (.mxf)
m MXF Sony XAVC

m MXF XDCAM (.mxf)
m OGG (.0g9)

m PSP (mp4)

m TIFO (.tifo)

m WAV (.wav)

m WebM (.webm)

m WMA (wma)

m WMV (wmv)
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3GPP (.3gp)

Codecs

3GPP (3rd Generation Partnership Project) video format is based on MPEG-4 file format
and GSM specifications. 3GPP specifies video standards for 3G technology known as
UMTS. 3GPP is intended for use on mobile phones.'

Table 11. 3GPP (.3gp) Codecs

Codec Episode EpisodePro Episode Engine Notes

AAC in/out in/out in/out

AMR in/out in/out in/out Out requires Pro Audio Option
H.263 in/out in/out in/out

H.264 in/out in/out in/out

HE-AAC out out Requires Pro Audio Option
MPEG-4 in/out in/out in/out
Settings

Figure 60. 3GPP Settings

3GP Version. Select 3GPPV5 | 3GPPv6 depending on the target players.

For broadest compatibility, select 3GPP version 5, because many older mobile phones
that cannot play 3GPP version 6. Most version 6 phones are backward-compatible with
version 5.

Fast start. Check to add information to the file which enables a player to start playing
the file before it has completely downloaded (progressive download). Fast start
functionality is an alternative to streaming media.

Audio & Video Streaming

MP4 supports streaming of H263 | H264 | MPEG-4 video, and AAC | AAC QuickTime |
AMR audio. Both video and audio codecs must support streaming to enable streaming.

1. 3rd Generation Partnership Project. Digital cellular telecommunications system (Phase 2+); Universal Mobile
Telecommunications System (UMTS); LTE; Transparent end-to-end packet switched streaming service (PSS); 3GPP file
format (3GP), v 9.1.0 edition, 2010 www.3gpp.org.

Episode 6.5
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3GPP (.3gp)

H263 Packetizer

Figure 61. H263 Packetizer Settings

Packet Size Limit (Bytes) 1012

Packatizing Type 2000 W

Insert Extra Headers

Packet Size Limit. Specify the maximum packet size, in bytes.
Packetizing Type. Select 1998 (QT) | 2000.

Insert Extra Headers. Check to enable error correction.
H264 Packetizer

Figure 62. H264 Packetizer Settings

Packat Size Limit (Bytes) 800

Packet Size Limit. Specify the maximum packet size, in bytes.
MPEG-4 Packetizer

Figure 63. MPEG-4 Packetizer Settings

Packat Size Limit (Bytes) 800

Packet Size Limit. Specify the maximum packet size, in bytes.
AAC Packetizer

Figure 64. AAC Packetizer Settings

Encoding LATM {MPEG-4 and 3GPP Defaul) v

Packat Size Limit (Bytes) 1000

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.

LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.
AAC QuickTime Packetizer

Figure 65. AAC QuickTime Packetizer Settings

Encoding LATM {MPEG-4 and 3GPP Defaul) v

Packat Size Limit (Bytes) 1000
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3GPP (.3gp)

Encoding. Select from these options:
Generic (ISMA and QuickTime Default) is the best to use for Web media.
LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.
AMR Packetizer

Figure 66. AMR Packetizer Settings

Frames Per Packet. Use the slider (or manually enter) to specify the number of frames
per packet. A higher number improves bandwidth efficiency, but a player may not be
able to store all frames. Range: 1 to 10.

Packetizing Mode. Select from these options:
Octet Align packetizing mode is supported by all players.

Bandwidth Efficient packetizing mode is not supported by all players, but can make
better use of available bandwidth.

Cyclic Redundancy Check. Check to add CRC so the client can verify content validity
errors that may have occurred in transmission. Not supported by all players.

Robust Sorting. Check to reorder data to decrease the impact of transmission errors.
Not supported by all players.

S
telestream

147



148 | Media Containers/Formats

3GPP2 (392)

3GPP2 (.392)

Codecs

3GPP2 (3rd Generation Partnership Project 2) video format is based on MPEG-4 file

format and 3G CDMA technology. 3GPP2 is intended for use on mobile phones'. 3GPP2

serves a similar purpose but is a different format from 3GPP.

Table 12. 3GPP2 (.3g2) Codecs

Codec Episode EpisodePro Episode Engine Notes
AAC in/out in/out in/out
AMR in in in Output (encoding) requires Pro
Audio Option.
H.263 in/out in/out in/out
H.264 in/out in/out in/out
HE-AAC in in Output (encoding) requires Pro
Audio Option.
MPEG-4 in/out in/out in/out
Settings

Except for File Extension (default.3g2), there are no user-configurable settings.

Audio & Video Streaming

3GGP2 format supports streaming of H263 | H264 | MPEG-4 video, and AAC | AAC
QuickTime | AMR audio. Both video and audio codecs must support streaming to
enable streaming.

H263 Packetizer

Figure 67. H263 Packetizer Settings

Packet Size Limit (Bytes) 1012

2000 W

Packet Size Limit. Specify the maximum packet size, in bytes.
Packetizing Type. Select 1998 (QT) | 2000.

Insert Extra Headers. Check to enable error correction.

1. 3rd Generation Partnership Project 2. 3GPP2 File Formats for Multimedia Services. www.3gpp2.0rg.
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H264 Packetizer

Figure 68. H264 Packetizer Settings

Packat Size Limit (Bytes) 800

Packet Size Limit. Specify the maximum packet size, in bytes.
MPEG-4 Packetizer

Figure 69. MPEG-4 Packetizer Settings

Packat Size Limit (Bytes) 800

Packet Size Limit. Specify the maximum packet size, in bytes.
AAC Packetizer

Figure 70. AAC Packetizer Settings.

Encoding LATM {MPEG-4 and 3GPP Defaul) v

Packat Size Limit (Bytes) 1000

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.

LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.
AAC QuickTime Packetizer

Figure 71. AAC QuickTime Packetizer Settings

Encoding LATM {MPEG-4 and 3GPP Defaul) v

Packat Size Limit (Bytes) 1000

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.

LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.
AMR Packetizer

Figure 72. AMR Packetizer Settings

3GPP2 (3g2)
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Frames Per Packet. Use the slider (or manually enter) to specify the number of frames
per packet. A higher number improves bandwidth efficiency, but a player may not be
able to store all frames. Range: 1 to 10.

Packetizing Mode. Select from these options:
Octet Align packetizing mode is supported by all players.

Bandwidth Efficient packetizing mode is not supported by all players, but can make
better use of available bandwidth.

Cyclic Redundancy Check. Check to add CRC so the client can verify content validity
errors that may have occurred in transmission. Not supported by all players.

Robust Sorting. Check to reorder data to decrease the impact of transmission errors.
Not supported by all players.
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3GPP2 EZmovie (.3g2)

Codecs

3GPP2 EZmovie format is 3GPP2-compatible video extended with EZmovie features
developed by KDDI Corporation', which can be used on devices that use KDDI's mobile
video application or others that support these features.

Table 13. 3GPP2 (.3g2) EZMovie Codecs

Codec Episode EpisodePro Episode Engine Notes
AAC in in/out in/out
AMR in in in Output (encoding) requires Pro
Audio Option.
H.263 in in/out in/out
H.264 in in/out in/out
HE-AAC in in in Output (encoding) requires Pro
Audio Option.
MPEG-4 in in/out in/out
Settings

Episode 6.5

Figure 73. 3GPP2 EZmovie Settings

Restrict Distribution. Check to implement distribution restriction mechanisms.
Restrict Playback. Check to limit the number of times the file can be played.
Playback Count. Integer value determines the number of times the file can be played.
Restrict Expiration. Check to limit the number of days the file can be played.

Expiration Time (Days). Specify an integer value for the number of days this video can
be played, after which it expires and can not be played.

Note: A player may ignore these restrictions.

1.Ezmovie. www.au.kddi.com
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AC3/ATSCA/52 (.a52)

ATSC A/52 is an audio format developed by Advanced Television Systems Committee'
for use in HDTV digital television and DVD applications. It is also known as AC-3.

Codecs
Table 14. ATSC A/52 (.a52) Codecs

Codec Episode EpisodePro EpisodeEngine Notes
A-52 in/out in/out in/out
Settings

Except for File Extension (default .a52), there are no user-configurable settings.

1. Advanced Television Systems Committee. Digital Audio Compression Standard (AC-3, E-AC-3), 2010. www.atsc.org.
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ADTS (.aac)

ADTS (Audio Data Transport Stream) is a wrapper format for AAC-encoded audio files.!
ADTS is used by MPEG TS and others to stream audio.

Codecs
Table 15. ADTS (.aac) Codecs

Codec Episode EpisodePro Episode Engine Notes
AAC in/out in/out in/out
HE-AAC in in in/out Output (encoding) requires Pro
Audio Option.
Settings

Except for File Extension (default.aac), there are no user-configurable settings.

1. International Organization for Standardization. Information technology—Generic coding of moving pictures and
associated audio information—Part 7: Advanced Audio Coding (AAC), 2006.
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AIFF (.aif)

AIFF (Audio Interchange File Format) is an audio file format standard for playback on
personal computers and other audio devices, co-developed by Apple.]

The audio data in AIFF is uncompressed, lossless PCM used by professional-level audio
and video applications, unlike the better-known lossy MP3 format.

Codecs

Table 16. AIFF (.aif) Codecs

Codec Episode EpisodePro Episode Engine Notes
PCM in/out in/out in/out
Settings

Except for File Extension (default .aif), there are no user-configurable settings.

1. Apple. Audio Interchange File Format: AIFF, version 1.3 edition, 1989
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AMR (.amr)

Note: This format is available only with Pro Audio Option.

AMR (Adaptive Multi-Rate) is a standard, mandatory audio codec in 3GPP.! AMR is a
speech format, ideal for storing the spoken word, and is unlikely to give ideal results for
music audio.

Codecs

Table 17. AMR (.amr) Codecs

Codec Episode EpisodePro Episode Engine Notes
AMR in/out in/out in/out Requires Pro Audio Option
Settings

Except for File Extension (default .amr), there are no user-configurable settings.

1. Internet Engineering Task Force. RTP Payload Format and File Storage Format for Adaptive Multi-Rate (AMR) &
Adaptive Multi-Rate Wideband Audio Codecs, 2007. www.rfc-editor.org
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AVI (.avi)

Codecs

AVI (Audio Video Interleave) is a multimedia (audio and video) container format
developed by Microsoft in 1992." AVl allows synchronous audio-with-video playback.

Many AVI files also use the file format extensions developed by the Matrox OpenDML
group. These extensions are supported by Microsoft, and are unofficially called AVI 2.0.

Table 18. AVI (.avi) Codecs

Codec Episode EpisodePro Episode Engine Notes

DV 25 in/out in/out in/out

DVCPro 25 in in/out in/out

DVCPro 50 in in/out in/out

DivX in in in Requires Divx QuickTime plugin
MJPEG in in/out in/out

MP3 in/out in/out in/out Requires MP3 QuickTime plugin
PCM in/out in/out in/out

Windows RGB  in in/out in/out

Avid in/out in/out in/out Requires Avid QuickTime plugin
YCbCr in in/out in/out
Settings

Figure 74. AVI Settings

File Extension

Version Version 1 {regular AVT) v

Version. Select Version 1 (Regular AVI) | Version 2 (Large Files). \lersion 2 is not supported
by all players. but enables encoding of source files larger than 4GB.

1. AVI File Format, 2010. msdn.microsoft.com.
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DASH MPEG Streaming

The Dynamic Adaptive Streaming, or MPEG DASH, format provides MP4 high quality
adaptive bitrate streaming of media via HTTP web servers. DASH breaks a long media
program into small segments which are encoded at multiple different bit rates, all of
which are made available to receiving devices.

During playback, a device chooses the best segment bitrate available for its connection
and processing capacity so as to minimize buffering and resultant pauses in playback.
This enables DASH clients to play back high quality video without interruptions despite
changing network conditions.

Figure 75. DASH Encoder Example

""" DASH Streaming 1264kbit

Encoder
Task Name  DASH Streaming 1264kbit

“  Format

| Container: TIFO ( tifo) v 2

Video Encoder: H264 (MainConcep W 2

Audio Encoder: AAC QuickTime v 7

|

File Extension

Split & Stitch

Settings

For settings, please see the settings for the chosen container and encoder. TIFO (.tifo) is
the default container, and H.264 (MainConcept) Codec is the default video encoder.

/'_'\
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DV-Stream (.dv)

DV (Digital Video) format (originally known as Blue Book) was developed by a group of
leading video camera manufacturers.

Audio in DV is stored uncompressed as either 16-bit linear PCM at 48kHz or 4 nonlinear
12-bit PCM channels at 32 kHz. DV also supports 16-bit audio at 44.1 kHz.

Codecs

Table 19. DV-Stream (.dv) Codecs

Codec Episode EpisodePro Episode Engine Notes
DV 25 in/out in/out in/out

DVCPro 25 in in/out in/out

DVCPro 50 in in/out in/out
Settings

Except for File Extension (default.dv), there are no user-configurable settings.

1. International Electrotechnical Commission. Helical-scan digital video cassette recording system using 6.35 mm
magnetic tape for consumer use (525-60, 625-50, 1125-60 & 1250-50 systems), 2001.
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Flash (.flv)

Adobe Flash video format (FLV was originally developed by Macromedia) is a video
container file format.! Flash is used to deliver video over the Internet for use by Adobe
Flash Player versions 6-10, and may also be embedded in SWF files.

Codecs

Table 20. Flash (.flv) Codecs

Codec Episode EpisodePro EpisodeEngine Notes
VP6 (Flash 8) in/out in/out in/out

H.264 (Flash 9)  in/out in/out in/out

Settings

Except for File Extension (default .flv), there are no user-configurable settings.

1. Adobe Systems. Video File Format Specification, version 10 edition, 2008.
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Flash (.swf)

Adobe SWF (Small Web Format) is a multimedia wrapper format'. SWF support was
added to Flash Player 6. Episode only allows the wrapping of video and audio tracks in
SWEF files.

Codecs
Table 21. Flash (.swf) Codecs

Codec Episode EpisodePro EpisodeEngine Notes
VP6 (Flash 8) in/out in/out in/out

H.264 (Flash 9) in/out in/out in/out
Settings

Except for File Extension (default.swf), there are no user-configurable settings.

1. Adobe Systems. SWF File Format Specification, version 10 edition, 2008.
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GXF (.gxf)

GXF (General eXchange Format) is an interchange format for storage and data transfer
originally developed by Grass Valley Group.’

Codecs
Table 22. GXF (.gxf) Codecs

Codec Episode EpisodePro Episode Engine Notes
MPEG-2 in in/out in/out

MPEG-2 HD in in/out in/out

PCM in in/out in/out
Settings

Except for File Extension (default .gxf), there are no user-configurable settings.

1. Society of Motion Picture and Television Engineers. General Exchange Format (GXF), 2009.
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iTunes Audio (.m4a)

iTunes Audio is AAC audio in an MPEG-4 wrapper, containing the audio layer (non-
video) of an MPEG-4 movie file. Also known as Apple Lossless.

Codecs
Table 23. iTunes Audio (m4a) Codecs
Codec Episode EpisodePro Episode Engine Notes
AAC in/out in/out in/out
HE-AAC in in in Output (encoding) requires Pro
Audio Option.
Settings

Except for File Extension (default.m4a), there are no user-configurable settings.
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iTunes Video (.m4v)

iTunes Video is an MPEG-4 multi-media (audio and video) wrapper intended for playing
files in iTunes. This format supports copyright protection.

Codecs
Table 24. iTunes Video (.m4v) Codecs

Codec Episode EpisodePro Episode Engine Notes
AAC in/out in/out in/out

H.264 in/out in/out in/out

MPEG-4 in/out in/out in/out

Settings

Except for File Extension (default .m4v), there are no user-configurable settings.
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MOV (.mov)

MOV format is Apple’s’ QuickTime multimedia framework.

Episode decodes all audio tracks and channels in MOV and MXF source and creates one
track with all channels in it. For example, 2 stereo tracks becomes one track with 4
channels.

You can quickly extend the encoding and decoding abilities of Episode by
downloading and installing third-party QuickTime codec plugins in your system. You
access the QuickTime video and audio codecs directly. See QuickTime Codecs and
QuickTime Audio Codecs.

Codecs
Table 25. MOV (.mov) Codecs

Codec Episode EpisodePro Episode Engine Notes

uLaw 2:1 in/out in/out in/out Use QuickTime codec
alaw 2:1 in/out in/out in/out Use QuickTime codec
AVC-Intra 50 in in/out in/out

AVC-Intra 100 in in/out in/out

AAC in/out in/out in/out

AMR in/out in/out in/out

Animation in/out in/out in/out Use QuickTime codec
Apple in/out in/out in/out Use QuickTime codec
Component

Apple GSM 10:1 in/out in/out in/out Use QuickTime codec
Apple in/out in/out in/out Use QuickTime codec

Intermediate

Apple Lossless in/out in/out in/out Use QuickTime codec

Apple ProRes in/out in/out in/out Episode ProRes output on
Windows available only with
Episode Engine license on
Windows Server 2008|12.

Apple in/out in/out in/out
Uncompressed
Apple Video in/out in/out in/out Use QuickTime codec

1. Apple. QuickTime File Format Specification, 2007-09-04 edition, 2007. developer.apple.com.
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MOV (.mov)

Codec Episode EpisodePro Episode Engine Notes

Avid in/out in/out in/out Requires Avid QuickTime codec

Avid DNxHD in/out in/out in/out Requires Avid QuickTime codec

Avid DV in/out in/out in/out Requires Avid QuickTime codec

Avid Meridien in/out in/out in/out Requires Avid QuickTime codec

Blackmagic in/out in/out in/out Use Quicktime codec

Cinepak in/out in/out in/out Use QuickTime codec

DV 25 in/out in/out

DVCPro 25 in/out in/out in/out Requires Final Cut Pro

DVCPro 50 in/out in/out in/out Requires Final Cut Pro

DVCPro 100/HD in/out in/out in/out Use QuickTime codec. Requires
Final Cut Pro or Raylight for
Windows

GoPro Cineform  in in in Use QuickTime codec

H.261 in/out in/out in/out Use QuickTime codec

H.263 in/out in/out in/out

H.264 in/out in/out in/out

HDV in in /out in/out

HE-AAC in in in Out requires Pro Audio Option

IMA in/out in/out in/out Use QuickTime codec

D-10/IMX in in /out in/out

MJPEG in in/out in/out

MP3 in/out in/out in/out

MPEG-4 in/out in/out in/out

Mace 3:1 in/out in/out in/out Use QuickTime codec

Mace 6:1 in/out in/out in/out Use QuickTime codec

Media 100 in/out in/out in/out Requires Media 100 QuickTime
codec

PCM in/out in/out in/out

Pixlet in/out in/out in/out Use QuickTime codec
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Table 25. MOV (.mov) Codecs

166 | Media Containers/Formats

Codec Episode EpisodePro Episode Engine Notes
ProRes 4:2:2and  in/out in/out in/out Alpha channel is supported in
4:4:4:4 Windows output Apple I?rgRes 4:4:4:4 QuickTime
available only on with millions of colors + selected.
Windows Server  Episode ProRes 4:4:4:4 does not
2008/2012. support millions of colors +
QDesign in/out in/out in/out Use QuickTime codec
RAW in/out in/out in/out
RED in in in Requires RED QuickTime plugin
Sheer Video in/out in/out in/out Requires Sheer QuickTime plugin
Sorenson Video 1 in/out in/out in/out Use QuickTime legacy codec
Sorenson Video 2 in/out in/out in/out Use QuickTime legacy codec
Sorenson Video 3 in/out in/out in/out Use QuickTime codec
Targa Cine YUV in in/out in/out
XDCAM in in in/out
XDCAM EX in in/out in/out
XDCAM HD in in/out in/out
XDCAM HD 422 in in/out in/out
YCbCr in in /out in/out
Settings
Figure 76. QuickTime MOV Settings
File Extension
Disable Save
Add QT Timecode Track v
Fast Start v
Disable Saving. Check to prevent others from transcoding the output file to other
formats.
Add QuickTime Timecode Track. Check to add a QuickTime timecode track in
conjunction with the Timecode option. The timecode track can be toggled on or off in
QuickTime Player.
VAT
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Note: QuickTime Player Version 7.6.6 and earlier fails to increment the timecode for
the first B-frame in a video, causing the timecode to seem out of synch, but no frames
are skipped.

Fast Start. Check to add information to the file which enables a player to start playing
the file before it has completely downloaded (progressive download). Fast start
functionality is an alternative to streaming media.

Audio & Video Streaming

QuickTime MOV format supports streaming of H263 | H264 | MPEG-4 video, and AAC |
AAC QuickTime | AMR audio. Both video and audio codecs must support streaming to
enable streaming.

H263 Packetizer

Figure 77. H263 Packetizer Settings

Packet Size Limit (Bytes) 1012

Packetizing Type 2000 W

Insert Extra Headers

Packet Size Limit. Specify the maximum packet size, in bytes.
Packetizing Type. Select 1998 (QT) | 2000.

Insert Extra Headers. Check to insert extra headers.
H264 Packetizer

Figure 78. H264 Packetizer Settings

Packat Size Limit (Bytes) 800

Packet Size Limit. Specify the maximum packet size, in bytes.
MPEG-4 Packetizer

Figure 79. MPEG-4 Packetizer Settings

Packat Size Limit (Bytes) 800

Packet Size Limit. Specify the maximum packet size, in bytes.
AAC Packetizer

Figure 80. AAC Packetizer Settings

Encoding LATM {MPEG-4 and 3GPP Defaul) v

Packat Size Limit (Bytes) 1000
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MOV (.mov)

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.

LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.
AAC QuickTime Packetizer

Figure 81. AAC QuickTime Packetizer Settings

Encoding LATM {MPEG-4 and 3GPP Defaul) v

Packat Size Limit (Bytes) 1000

Encoding. Select from these options:

Generic (ISMA and QuickTime Default) is the best to use for Web media.

LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.
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AMR Packetizer

Figure 82. AMR Packetizer Settings

Frames Per Packet. Use the slider (or manually enter) to specify the number of frames
per packet. A higher number improves bandwidth efficiency, but a player may not be
able to store all frames. Range: 1 to 10.

Packetizing Mode. Select from these options:
Octet Align packetizing mode is supported by all players.

Bandwidth Efficient packetizing mode is not supported by all players, but can make
better use of available bandwidth.

Cyclic Redundancy Check. Check to add CRC so the client can verify content validity
errors that may have occurred in transmission. Not supported by all players.

Robust Sorting. Check to reorder data to decrease the impact of transmission errors.
Not supported by all players.
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MP3 (.mp3)
MP3 (MPEG-1 Audio Layer lll) is the audio format of MPEG-1.]

Codecs
Table 26. MP3 (.mp3) Codecs

Codec Episode EpisodePro Episode Engine Notes
MP3 in/out in/out in/out
Settings

Figure 83. MP3 Settings

File Extension

Use ID3 v1.1

Use ID3 w23

Use ID3 tag v 1.1. Check to add ID3 v1.1 metadata tags to the output file.
Use ID3 tag v 2.3. Check to add ID3 v2.3 metadata tags to the output file.

See Adding Metadata for more information on metadata. See www.id3.org for more
information ID3 tags.

1. International Organization for Standardization. Information technology—Coding of moving pictures and associated
audio for digital storage media at up to about 1.5 Mbs—Part 3: Audio, 1993.
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MP4 (.mp4)

Codecs

MP4 or MPEG-4 Part 14 format is a multimedia container format." It is commonly used
to store digital video and digital audio streams (especially MPEG). Like most modern
container formats, MP4 can be streamed over the Internet.

Episode can add ODSM (Object Descriptor Stream) and SDSM (Scene Description
Stream) tracks to MPEG-4 files which are required by some players. A check box in the
Format panel enables this feature.

Table 27. MP4/MPEG4 (.mp4) Codecs

Codec Episode EpisodePro Episode Engine Notes
AAC in/out in/out in/out

AAC QuickTime in/out in/out in/out

H264 in/out in/out in/out

MPEG-4 in/out in/out in/out
Settings

These are the user-configurable settings:

Audio & Video Streaming

MP4 supports streaming of H264 | MPEG-4 video, and AAC | AAC QuickTime audio. Both
video and audio codecs must support streaming to enable streaming in this container.

H264 Packetizer

Figure 84. H264 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.
MPEG-4 Packetizer

Figure 85. MPEG-4 Packetizer Settings

Packet Size Limit. Specify the maximum packet size, in bytes.

1. International Organization for Standardization. Information technology—Coding of audio-visual objects, 2004.
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MP4 (.mp4)

AAC Packetizer

Figure 86. AAC Packetizer Settings

Encoding LATM {MPEG-4 and 3GPP Defaul) v

Packat Size Limit (Bytes) 1000

ODSM and SDSM Tracks. A check box at the bottom of the Format panel enables
these tracks to be included (or excluded by unchecking).

Figure 87. ODSM and SDSM Track Selection

File Extension mpd

Include ODSM and SDSM v
tracks

Figure 88. Encoding. Select from these options:
Generic (ISMA and QuickTime Default) is the best to use for Web media.
LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.

Packet Size Limit. Specify the maximum packet size, in bytes.
AAC QuickTime Packetizer

Figure 89. AAC QuickTime Packetizer Settings

Encoding LATM {MPEG-4 and 3GPP Defaul) v

Packat Size Limit (Bytes) 1000

Encoding. Select from these options:
Generic (ISMA and QuickTime Default) is the best to use for Web media.
LATM (MPEG-4 and 3GPP Default) is the best to use for mobile phones.
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MPEG Audio (.m1a)

MPEG Audio is an MPEG-1 elementary stream with a single audio track.! see MPEG

Audio Codec.
Codecs
Table 28. MPEG Audio (.m1a) Codecs
Codec Episode EpisodePro Episode Engine Notes
MPEG-1 in/out in/out in/out
Settings

Except for File Extension (default .m1a), there are no user-configurable settings.

1. International Organization for Standardization. Information technology—Coding of moving pictures and associated
audio for digital storage media at up to about 1.5 Mbs—Part 1: Systems, 1993.
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MPEG-ES (.m1v)

MPEG-ES is an MPEG-1 elementary stream with a single video track.’

Codecs

Table 29. MPEG-ES (m1v) Codecs

Codec Episode EpisodePro Episode Engine Notes
MPEG-1 in/out in/out in/out

Settings

Except for File Extension (default.m1v), there are no user-configurable settings.

1. International Organization for Standardization. Information technology —Coding of moving pictures and associated
audio for digital storage media at up to about 1.5 Mbs—Part 1: Systems, 1993.
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MPEG-ES (.m2v)

MPEG-ES format is an MPEG-2 elementary stream with a single video track.'

Codecs

Table 30. MPEG-2 ES (.(m2v) Codecs

Codec Episode EpisodePro EpisodeEngine Notes
MPEG-2 in/out in/out in/out

Settings

Except for File Extension (default.m2v), there are no user-configurable settings.

1. International Organization for Standardization. Information technology—Generic coding of moving pictures and
associated audio information: Systems, 2007.
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MPEG-PS (.mpg)

MPEG-PS (MPEG Program Stream) is a format for multiplexing digital audio, video and
more. It contains interleaved (multiplexed) packetized elementary streams. Program
streams are intended for reasonably reliable media such as DVD or SVCD.

Codecs
Table 31. MPEG-PS (.mpg) Codecs

Codec Episode EpisodePro Episode Engine Notes
AAC out out out

ATSC A-52 in/out in/out in/out

H.264 in/out in/out in/out

MPEG audio in/out in/out in/out

MPEG-2 in/out in/out in/out

MPEG-4 in/out in/out in/out
Settings

Figure 90. MPEG-PS Settings
File Extension
Max Packat Size

Max Packet Size. Set the size of interleaved packets (300-5000 bytes).
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Note: This format is available only in Episode Pro and Episode Engine.

Codecs

Media Containers/Formats
MPEG-TS (.ts)

MPEG-TS (MPEG Transport Stream) is a container format for transmission and storage of
audio, video, and data and is used in broadcast systems—which are inherently less

reliable than disk-based storage and transmission systems.?

In this application, packets may be lost and viewers must be able to enter a
transmission in mid-stream. Packetized elementary streams are interleaved (muxed) in

the transport stream.

Table 32. MPEG-TS (.mpg) Codecs

Codec Episode EpisodePro Episode Engine
AAC in out out

AES in in/out in/out

ATSC A-52 in in/out in/out

H.264 in in/out in/out

HDV in/out in/out in/out

MPEG audio in in/out in/out

MPEG-2 in in/out in/out

MPEG-4 in in/out in/out

PCM in in in

Episode 6.5
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Settings

Figure 91. MPEG-TS Settings

PMT PID

Transport rate

Transport rate mode Automatic

Transport rate Transport rate unit jhps

One PES per frame

IS0 639 language code  Mone

General
PID Assignment

Each packet contains a PID (Packet IDentifier), so that the receiving system/application
can utilize the incoming packet in the correct video or audio stream. PID values can be
set in the range 16 to 8190, but video and audio streams should not use values below
32.

Audio PID. Set the audio PID.
Video PID. Set the video PID.

PCR PID. Set the PID for the Program Clock Reference (PCR) packets, which control
media timing. The PID may be identical to a media track (typically the Video PID) or
have a unique value. The PCR PID cannot be the same as the PMT PID.

PMT PID. Set the PID for the Program Map Tables (PMT), which describe the structure of
tracks within a program in the transport stream. Since Episode only creates single-
program transport streams, only one PMT can be specified.

Transport Rate

The transport rate determines the bit rate of the resulting stream.

Transport Rate Mode. Select Automatic to set the transport rate to the sum of the rates
of the media tracks plus approximately 10% overhead for system packets. This is the
lowest possible rate for the stream.

Select Manual to explicitly specify the transport rate. If the sum of the rates of the
media tracks and system packets is lower than the specified bit rate, the stream is
padded to the specified bit rate. If the total rate is higher than the specified rate, the
rate is automatically adjusted up to the lowest possible rate, as it is for Automatic.
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Transport Rate. Specify the manual transport rate numeric value.

Transport Rate Unit. Select the unit type: bps | Kbps | Mbps.

PES Options

Packetized Elementary Stream (PES) describes how the media tracks (elementary
streams) are stored within the transport stream.

PES Mode. Select Automatic Max Size to automatically set the maximum size of PES
packets.

Select One PES per Frame to store each frame of video in one PES packet. This may be
required for compatibility with some video-on-demand services.

Select Manual Max Size to manually set the maximum size of PES packets.
PES Max Size. When Manual Max Size is checked, enter the appropriate PES size.
Language

ISO 639 Language Code. Select a language code, or None. If a language code is
selected, an 1SO-639" language descriptor is added to the audio track of the stream.

System Packets

These settings enable you to configure various settings in the set commonly known as
system packets.

Figure 92. MPEG-TS System Packets Settings

Transport Stream ID. Set the ID number for the transport stream.

Program Number. Set the number for the single program stream within this transport
stream (range: 1-65535).

PAT Interval. Set the maximum time interval between Program Association Table (PAT)
packets. These indicate the programs available in the transport stream.

PMT Interval. Set the maximum time interval between PMT packets.
PCR Interval. Set the maximum time interval between PCR packets.

Force NULL Packets. Check to add null packets to the stream in order to create a
constant bit rate stream.

NULL Interval. When Force NULL Packets is checked, set the maximum time interval in
seconds between NULL packets.

1. International Organization for Standardization. Codes for the representation of names of languages—Part 2: Alpha-

3 code, 1998.

Episode 6.5

S
telestream

179



180 | Media Containers/Formats

MXF AS-11 (.mxf)

MXF AS-11 (.mxf)

Codecs

MXF AS-11 is defined by the Advanced Media Workflow Association (AMWA) as a
format containing HD AVC-Intra or SD D-10 video with AES3 audio used by program
producers and distributors for distributing programming to broadcasters. Episode
supports AS-11 transcoding using the codecs listed below.

Episode decodes all audio tracks and channels in MOV and MXF sources and creates
one track with all channels. For example, two stereo tracks become one track with 4
channels.

Table 33. MXF AS-11 (.mxf) Codecs

Codec Episode EpisodePro Episode Engine Notes
AES in in/out in/out

AVC-Intra 50 in in/out in/out

AVC-Intra 100  in in/out in/out

D-10/IMX in in/out in/out
Settings

Figure 93. MXF AS-11 Settings

File Extension

Split audio channels to

separate tracks

File Extension. Specifies the .mxf file extension by default but allows you to enter a
different extension.

Split audio channels to separate tracks. Check to send the input audio channels to
separate tracks in the output file.

Add Ancillary Closed Caption track. Check this option to include a CEA-608 or CEA-
708 closed caption track in the VANC data of the output MXF file container if captions
are present in the incoming media. Uncheck this option to exclude MXF file captions.
(Note: To enable captions imported from .scc or .mcc files, also see the Caption Importer
Filter. To enable embedded input captions, also see the VBl Importer Filter.)
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MXF Op1a wrapper file format is defined in SMPTE 377M.! Op1a corresponds to the
SMPTE 378M standard.?

Codecs

Media Containers/Formats
MXF Op1a (.mxf)

Episode decodes all audio tracks and channels in MOV and MXF sources and creates
one track with all channels. For example, two stereo tracks become one track with 4

channels.

Table 34. MXF Op1a (.mxf) Codecs

Codec Episode EpisodePro Episode Engine Notes

AES in in/out in/out

AVC-Intra 50 in in/out in/out

AVC-Intra 100  in in/out in/out

BWF in in/out in/out

DNxHD out out Requires Avid QuickTime plugin

DV25 in in/out in/out

DVCPro25 in in/out in/out

DVCPro50 in in/out in/out

DVCProHD in in/out in/out Requires DVCProHD QuickTime
plugin

D-10/IMX in in/out in/out

JPEG2000 in in in

H.264 in in/out in/out

MainConcept

H.264 (x264) in in/out in/out

MPEG-2 ES in in/out in/out

XDCAM HD in in/out in/out

1. Society of Motion Picture and Television Engineers. Television—Material Exchange Format (MXF)—File Format
Specification, 2004.
2. Society of Motion Picture and Television Engineers. Television—Material Exchange Format (MXF)—Operational
pattern 1A (Single Item, Single Package), 2004.
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MXF Op1a (.mxf)

Settings
Figure 94. MXF OP1a Settings

File Extension

Split audio channels to
separate tracks

Add Andillary Closed
Caption track

File Extension. Specifies the .mxf file extension by default but allows you to enter a
different extension.

Split audio channels to separate tracks. Check to send the input audio channels to
separate tracks in the output file.

Add Ancillary Closed Caption track. Check this option to include a CEA-608 or CEA-
708 closed caption track in the VANC data of the output MXF file container if captions
are present in the incoming media. Uncheck this option to exclude MXF file captions.
(Note: To enable captions imported from .scc or . mcc files, also see the Caption Importer
Filter. To enable embedded input captions, also see the VBl Importer Filter.)
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MXF OpAtom Audio (.mxf)

MXF OpAtom format is similar to MPEG Elementary Stream format, in that either a
video track or an audio track can be wrapped, but not both at the same time.'

Episode decodes all audio tracks and channels in MOV and MXF sources and creates
one track with all channels. For example, two stereo tracks become one track with 4
channels.

Codecs

Table 35. MXF OPAtom (.mxf) Codecs

Codec Episode EpisodePro Episode Engine Notes
AES out out

BWF out out

Settings

Figure 95. MXF OpAtom Settings

File Extension

Wrap as Avid compliant
OP-Atom (BWF only)

Framerate (Frames Per 5

Wrap as Avid compliant OpAtom (BWF only). Check to generate a file using the
proprietary modifications to the standard for Avid video editing systems.

Framerate. Select the frame rate, in frames per second.

1. Society of Motion Picture and Television Engineers. Television—Material Exchange Format (MXF)—Specialized
Operational Pattern Atom (Simplified Representation of a Single Item), 2004.
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MXF OpAtom Video (.mxf)

MXF OpAtom Video format is similar to MPEG Elementary Stream format, in that either
a video track or an audio track can be wrapped, but not both at the same time.

Codecs
Table 36. MXF OPAtom Video (.mxf) Codecs

Codec Episode EpisodePro Episode Engine Notes

AVC-Intra 50 in in/out in/out

AVC-Intra 100  in in/out in/out

DNxHD out out Requires Avid QuickTime plugin
DV25 out out

DVCPro25 out out

DVCPro50 out out

DVCProHD out out Requires DVCProHD QuickTime

plugin

MPEG-2 ES out out

XDCAM HD out out
Settings

Figure 96. MXF OpAtom Settings

File Extension

Wrap as Avid compliant
OpAtom

Wrap as Avid compliant OpAtom. Check to generate a file using the proprietary
modifications to the standard for Avid video editing systems.

1. Society of Motion Picture and Television Engineers. Television—Material Exchange Format (MXF)—Specialized
Operational Pattern Atom (Simplified Representation of a Single Item), 2004.
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MXF Sony XAVC

MXF XAVC serves digital cinema with standards of 4096x2160 resolution in the MXF file
wrapper. The XAVC codec supports a variety of Sony digital cameras and camcorders.

Codecs
Table 37. MXF XAVC (.mxf) Codecs

Codec Episode EpisodePro Episode Engine Notes
XAVC in in/out in/out
Settings

Figure 97. MXF XAVC Settings

File Extension. Specifies the .mxf file extension by default but allows you to enter a
different extension.
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MXF XDCAM (.mxf)

Note: This format is available only in Episode Pro and Episode Engine.

MXF XDCAM format is a unique MXF version used by the Sony XDCAM video camera.

Episode decodes all audio tracks and channels in MOV and MXF sources and creates
one track with all channels. For example, two stereo tracks become one track with 4
channels.

Codecs
Table 38. MXF XDCAM (.mxf) Codecs

Codec Episode EpisodePro Episode Engine Notes

AES in in/out in/out

BWF in in/out in/out

DNxHD in in/out in/out Requires Avid QuickTime plugin
DVv25 in in/out in/out

DVCPro25 in in/out in/out

DVCPro50 in in/out in/out

DVCProHD in in/out in/out Requires DVCProHD QuickTime

plugin

IMX in in/out in/out

MPEG-2 ES in in/out in/out

MPEG-4 in in in

XDCAM HD in in/out in/out

XDCAM HD 422 in in/out in/out

XDCAM EX in in/out in/out
Settings

Figure 98. MXF XDCam Settings

File Extension mf
Add Ancillary Closed v
| Caption track

File Extension. Specifies the .mxf file extension by default but allows you to enter a
different extension.
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Add Ancillary Closed Caption track. Check this option to include a CEA-608 or CEA-
708 closed caption track in the VANC data of the output MXF file container if captions
are present in the incoming media. Uncheck this option to exclude MXF file captions.
(Note: To enable captions imported from .scc or . mccfiles, also see the Caption Importer
Filter. To enable embedded input captions, also see the VBl Importer Filter.)
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0GG (.099)

OGG format is an open media wrapper format designed for efficient streaming and
manipulation.’

Codecs
Table 39. OGG (.0ogg) Codecs

Codec Episode EpisodePro Episode Engine Notes
Vorbis out out out
Settings

Except for File Extension (default.ogg), there are no user-configurable settings.

1. Internet Engineering Task Force. Ogg Encapsulation Format Version 0, 2003. www.rfc-editor.org.
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PSP (.mp4)

PSP format is an MPEG-4 file format for PlayStation Portable.

PSP can play MPEG-4 files, but requires that they be named M4V99999.mp4, where
99999 is five decimal digits, and stored in the directory E\MP_ROOT\100MNVO1 on the
PSP. You can set up the file naming convention in the deployment.

Codecs
Table 40. PSP (.mp4) Codecs

Codec Episode EpisodePro Episode Engine Notes
AAC in/out in/out in/out

AAC QuickTime in/out in/out in/out

H264 in/out in/out in/out

MPEG-4 in/out in/out in/out
Settings

Except for File Extension (default .mp4), there are no user-configurable settings.
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TIFO (.tifo)

Telestream Intermediary Format is an intermediate media wrapper format designed by
Telestream. Its primary use is in efficiently moving file-based media between
Telestream digital media products.

Codecs
Table 41. TIFO (.tifo) Codecs

Codec Episode Episode Pro Episode Engine
Blackmagic in/out in/out in/out
D-10/IMX in/out in/out in/out
DV in/out in/out in/out
Flash 8 Video in/out in/out in/out
H263 in/out in/out in/out
H264 in/out in/out in/out
HDV in/out in/out in/out
MJPEG in/out in/out in/out
MPEG-1 in/out in/out in/out
MPEG-2 in/out in/out in/out
MPEG-4 in/out in/out in/out
QuickTime in/out in/out in/out
RGB Levels in/out in/out in/out
Targa Cine YUV in/out in/out in/out
VP8 in/out in/out in/out
Windows Media 9 in/out in/out in/out
Windows Media VC-1 in/out in/out in/out
Windows RGB in/out in/out in/out
XDCAM HD in/out in/out in/out
YCbCr in/out in/out in/out
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Settings

Figure 99. TIFO Settings

File Extension

Tifo version F v

TIFO Version. Select the version number required to maintain compatibility with older
versions of Telestream products.
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WAV (.wav)

The Waveform audio format was co-developed by Microsoft and IBM.

Codecs
Table 42. WAV (.wav) Codecs

Codec Episode EpisodePro Episode Engine Notes
PCM in/out in/out in/out
Settings

Figure 100. WAV Settings

File Extension
Add Broadcast wave header []

Add Broadcast wave header. Check to add a BWF header, which allows you to add
metadata to the output file. See Adding Metadata.

1. Multiple channel audio data and wave files, 2007. www.microsoft.com.
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WebM (.webm)

WebM is a multimedia container format designed to provide a royalty-free, high-quality
open video compression format for use with HTML5 video. The project's development
is sponsored by Google.

A WebM file consists of VP8 video and Vorbis audio streams, in a container based on a
profile of Matroska. The project releases WebM related software under a BSD license
and all users are granted a worldwide, non-exclusive, no-charge, royalty-free patent
license.

Codecs
Table 43. Webm (.webm) Codecs

Codec Episode EpisodePro Episode Engine Notes
VP8 out out out

Vorbis out out out
Settings

Except for File Extension (default .webm), there are no user-configurable settings.
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WMA (.wma)

Windows Media is a proprietary multimedia framework developed by Microsoft. WMA
format is the audio portion of Windows Media.

Codecs
Table 44. WMA (.wma) Codecs

Codec Episode EpisodePro Episode Engine Notes
Windows in/out in/out in/out

Media Audio

WMA Pro in/out in/out in/out

Settings

Except for File Extension (default .wma), there are no user-configurable settings.
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WMV (.wmv)

Windows Media is a proprietary multimedia framework developed by Microsoft. WMV
is the video portion of Windows Media.

Codecs
Table 45. WMV (.wmv) Codecs

Codec Episode EpisodePro Episode Engine Notes

VC-1 out out out

WMV7 in in in Requires Flip4AMac component
(Available for MacOS X only)

WMV8 in in in Requires Flip4Mac component
(Available for MacOS X only)

WMV9 in/out in/out in/out

WMA in/out in/out in/out

WMA Pro in/out in/out in/out

Settings

Except for File Extension (default .wmv), there are no user-configurable settings.
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Video Codecs

This chapter describes each of the video codecs provided in Episode, including a
description of each user-configurable parameter.

Note: See Media Containers/Formats for a table of formats and supported codecs.

Some codecs require an Episode Pro or Episode Engine license, as indicated.
m AVC-Intra Codec
m Blackmagic Codec
m D-10/IMX Codec
m DPX Sequence Codec
m DV Codec
m Flash 8 Video (VP6) Codec
m H.263 Codec
m H.264 (MainConcept) Codec
m H.264 (x264) Codec
m HDV Codec
m HEVC (H.265/x265) Codec
m JPEG Sequence Codec
m MJPEG Codec
m MPEG-1 Codec
m MPEG-2 Codec
m MPEG-2 VOD Codec
m MPEG-4 Codec
m Pass Through Option
m ProRes Codec
m QuickTime Codecs
m RGB Levels Codec
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m Targa Cine YUV Codec

m TGA Sequence Codec

m TIFF Sequence Codec

m VP8 Codec

m VP9 Codec

m Windows Media Video 9 Codec
m Windows Media Video VC-1 Codec
m Windows RGB Codec

m XAVC Codec

m XDCAM HD Codec

m YCbCr Codec
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AVC-Intra Codec

Episode 6.5

Episode is able to encode AVC-Intra media in both MXF and MOV formats. AVC-Intra
was developed by Panasonic. It is fully compliant with the H.264/MPEG AVC standard
and follows the SMPTE RP 2027-2007 recommended practice specifications. AVC-Intra
utilizes 10-bit intra-frame AVC compression and can be used for both 1080 and 720 HD
frame sizes.

Note: Inputis supported in all editions. Output is supported in Episode Pro and
Episode Engine only.

Figure 101. AVC-Intra Codec Settings

AVC-Intra Class Class 50 v

AVC-Intra Class. Select from the following options:

Class 50. Produces 50 Mbit/s CABAC encoding. 1920X1080 (1440X1080 encoded pixels)
formats are High 10 Intra Profile, Level 4, 4:2:0 chrominance. 1280X720 (960X720 actual
pixels) formats are High 10 Intra Profile, level 3.2, 4:2:0 chrominance.

Class 100. Produces 100Mbit/s CAVLC encoding. All formats are High 4:2:2 Intra Profile,
level 4.1, 4:2:2 Chrominance. All formats are full frame (1920X1080 and 1280X720).
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Blackmagic Codec

The Blackmagic codec provides uncompressed video used by Decklink and AJA
products.

Figure 102. Blackmagic Codec Settings
Bit Depth 8 v

Display Aspect Ratio From Source/Resize Configuration v

Bit depth. Select 8|70 bits per color channel.

Note: 10-bit encoding does not increase the quality of 8-bit source data.

Display Aspect Ratio. Select from the following options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the resize filter if activated.

Square Pixels | 4:3|16:9|2.21:1|2.35:1 causes the codec to use the specified pixel aspect
ratio. See Picture Resolution and Aspect Ratio.
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D-10/IMX Codec

Note: This codec is available only in Episode Pro and Episode Engine.

The D-10/IMX codec is a form of MPEG-2 4:2:2 I-frames-only video (SMPTE 356M)." The
codec is restricted to encoding NTSC and PAL frame sizes and frame rates.

Figure 103. D-10/IMX Codec Settings

Eit Rate 50 Mbit/s v

Display Aspect Ratio 1:1 {Square Pixeks) v

Bit Rate. Select 30 Mbs | 40 Mbs | 50 Mbs.
Display Aspect Ratio. Select from the following options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3| 16:9|2.21:1 causes the codec to use the specified pixel aspect ratio.
See Picture Resolution and Aspect Ratio.

1. Society of Motion Picture and Television Engineers. Television—Type D-10 Stream Specifications—MPEG-2 4:2:2P @
ML for 525/60 and 625/50, 2001.
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Discard Option

When the Discard option is selected from the Video Codec dropdown menu, Episode
does not decode the video or pass it to the encoder. Thus, there is no video stream in
the output.
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DPX Sequence Codec

Episode 6.5

Note: This feature is available in both the Episode CLI and in the GUI client with the
Episode Engine license. For CLI details, see the Episode Advanced User’s Guide.

Select a sequence of DPX images as an input format for conversion to video. Support
includes 8-bit, 10-bit, and 12-bit resolution.

Figure 104. Image Sequence Settings

F™™ Untitled

Image Sequence

Task Name  Untitled

Max sequence number increase

Safety files

Frame rate
Encode while ingest
Encode while ingest waits{zec)

Encode while ingest number of waits

Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default
value is 1, meaning that one missing number in a sequence is treated as the end of the
sequence. If set to another number, that number of sequence numbers must be
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the
sequence before processing of the file begins. This does not apply to the first file in a
sequence. This only has practical implications if Encode While Ingest is enabled. Setting
this to 0 (zero) may significantly decrease the time the encoder has to wait when the
end of the sequence is reached, but depending on file system and file format, may
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device
that produces an image sequence over time. Wait times between received files can be
specified in the following wait fields.

Encode while ingest waits (sec). Specifies the number of seconds to wait before
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to
wait for files during encode while ingest. The default is 5 times. If no files are received
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.
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Revert. Restores the Image Sequence settings to what they were before they were
changed.

Save As. Saves the Image Sequence configuration to a file.
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DV Codec

Episode 6.5

DV does not use intra-frame prediction—all frames are keyframes. Thus, each frame is
decodable separately. This makes DV video suitable for editing and provides a
remarkably even quality, even in segments that are typically difficult for other video
encoders to encode well.

The DV codec is restricted to NTSC and PAL frame sizes and rates.

Figure 105. DV Codec Settings

DV Type. Select from the following options. The DV type automatically sets the audio in
the sample rate filter to the appropriate value.

DV, also known as DV25, has a fixed 25 Mbs bit rate. DV25 can encode PAL video (720 x
576) pixels at 25 FPS with a 4:2:0 color space and NTSC video (720 x 480) pixels at 29.97
FPS with a 4:1:1 color space. Audio at 32 | 44.1 | 48 kHz is supported in both cases.

Note: The DVCPRO and DBVCPROS50 codecs are available only in Episode Pro and
Episode Engine.

DVCPRO has a fixed 25 Mbs bit rate. DVCPRO can encode PAL video (720 x 576) at 25
FPS with a 4:1:1 color space and NTSC video (720 x 480) at 29.97 FPS with a 4:1:1 color
space. Audio at 32 | 48 kHz is supported in both cases.

DVCPRO50 has a fixed 50 Mbs bit rate. DVCPRO50 can either PAL video (720 x 576)
pixels at 25 FPS with a 4:2:2 color space and NTSC video (720 x 480) pixels at 29.97 FPS
with a 4:2:2 color space. Audio at 32 | 48kHz is supported in both cases.

Display Aspect Ratio. Select from these options:

4:3| 16:9 causes the codec to use the specified pixel aspect ratio. See Picture Resolution
and Aspect Ratio.

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3| 16:9|2.21:1 causes the codec to use the specified pixel aspect ratio.
See Picture Resolution and Aspect Ratio.

Frame Mode. Select from these options:

Same as Source sets the output frame mode the same as the input file.
Interlaced sets the output frame mode to interlaced.

Progressive sets the output frame mode to progressive.
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Flash 8 Video (VP6) Codec

Flash 8 is Adobe’s implementation of VP6 Video.

Note: Storing Flash 8 video in SWF format restricts the possible image frame rates
depending on the audio sample rates. For audio sample rates of 11025 Hz the
maximum allowed frame rate is 9 FPS. For audio samples rates of 22050 Hz and 44100
Hz the maximum allowed frame rate is 38 FPS. FLV format has no such limitations.

m Bandwidth Settings
m Keyframe Settings
m Profile Settings

m Encoding Settings

Bandwidth Settings

Figure 106. Flash 8 (VP6) Codec—Bandwidth Settings
Bandwidth Settings

Peak Rate (kbitfs)

Average Rate (kbitfs)

Frame Skip Probability

Video Buffering Verifier 5
(VBV} Buffer Size
(Seconds)

Variable Bit Rate (VER)
(36)

Peak Rate. Specify the maximum allowed bit rate over any one-second interval. Range:
15 Kbps to 100,000 Kbps.

Average Rate. Specify the desired bit rate of the video track. Range: 15 Kbps to 100,000
Kbps.

Frame Skip Probability. Use the slider (or enter the value manually) to set the
probability of skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and
1.0 is most likely to cause frame skipping. See Frame Skip Probability Smooth Motion Vs.
Crisp Image.

Video Buffering Verifier (VBV) Buffer Size. Use the slider (or enter the value
manually) to set the VBV buffer size. Range: 0 to 60 seconds. See VBV Video Buffer
Verifier.

VBR Strength. When Bit Rate (under Encoding Settings) is set to VBR, use the slider (or
enter the value manually) to set the amount of bit rate variability allowed in the bit rate.
0is equal to constant bit rate.
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Keyframe Settings

Figure 107. Flash 8 Codec—Keyframe Settings

Keyframe Settings

Keyframe Cantrol Natural and Forced Keyframes

Keyframe Distance 5o
{Frames)

Minimum Distance 1
{Frames)

Keyframe Control. Select from the following options:
Keyframes Only creates all frames as keyframes. Requires very high video bit rate.
Forced Keyframes Only creates keyframes with exactly the specified keyframe distance.

Natural and Forced Keyframes creates keyframes when the encoder detects a scene
change, but also inserts a keyframe at Keyframe distance from the latest keyframe. If
Keyframe distance is 0, only natural keyframes are created.

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Keyframe Interval. Specify the maximum distance between keyframes. Range 0 to 200
frames.

Minimum Interval. Specify the minimum distance between keyframes. Range: 0 to 50
frames. Minimum distance cannot be larger than keyframe distance.

Profile Settings

Episode 6.5

Figure 108. Flash 8 Codec—Profile Settings

Profile

Error resilient mode

Encede alpha

Profile. Select from the following options:
Vp6-S works better for large image sizes but does not allow two-pass encoding.
Vp6-E allows higher compression rates.

Error Resilient Mode. Check to add error correction codes to the output. This improves
quality on lossy networks, but increases the output size by approximately 5%.

Encode Alpha. Check to copy any alpha (transparency) channel in the source to the
output.
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Flash 8 Video (VP6) Codec

Encoding Settings

Figure 109. Flash 8 Codec—Encoding Settings

Best Quality

Constant Bit Rate (CBR)

Complexity. Select from these settings:
Normal Quality provides average visual quality with faster encoding.
Best Quality improves visual quality but increases encoding time.

Two-pass Encoding. Check to perform encoding in two passes. In pass one, the codec
analyzes the frames and collects data. In the second pass it uses the collected data as
the basis for how to best distribute the bits.

Two-pass encoding produces better output image quality, but increases encoding
time.

Bit Rate. Select from these settings:
Constant Bit Rate (CBR) keeps the output bit rate constant.

Variable Bit Rate (VBR) allows the output bit rate to vary up to the Peak rate, variability
depending on setting in VBR Strength.

Sharpness. Use the slider (or enter the value manually) to set the sharpness indicator. A
low sharpness setting blurs the image slightly. A high sharpness setting enhances
edges but may also cause image artifacts.
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H.263 Codec

H.263 is designed for low-bit rate video'. It is suitable for streaming to handheld
devices.

m Bandwidth Settings
m Keyframe Settings
m Profile Settings

m Encoding Settings

Bandwidth Settings

Figure 110. H.263 Codec—Bandwidth Settings

Average Rate (kbitfs)

Frame Skip Probability

Video Buffering Verifier
(VBV} Buffer Size
(Seconds)

Average Bit Rate. Set the desired bit rate of the video track. Range: 0 to 30,000 Kbps.

Frame Skip Probability. Use the slider (or enter the value manually) to set the
probability of skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and

1.0 is most likely to cause frame skipping. See Frame Skip Probability Smooth Motion Vs.
Crisp Image.

Video Buffering Verifier (VBV) Buffer Size. Use the slider (or enter the value

manually) to set the VBV buffer size. Range: 0 to 60 seconds. See VBV Video Buffer
Verifier.

Keyframe Settings

Figure 111. H263 Codec—Keyframe Settings

{Frames)

Inira Refresh Distance

{Frames)

Keyframe Control. Select from the following options:
Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Forced Keyframes Only creates keyframes with exactly the specified keyframe distance.

1. International Telecommunication Union. Video coding for low bit rate communication, 2005. www.itu.int.
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Natural and Forced Keyframes creates keyframes when the encoder detects a scene
change, but also inserts a keyframe at Keyframe distance from the latest keyframe. If
keyframe distance is 0, only natural keyframes are created.

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Intra Block Refresh updates only moving areas in the image instead of the entire frame.
This is useful when streaming at very low bit rates, since it keeps the bit rate more
constant.

Keyframe Interval. Use the slider (or enter the value manually) to set the maximum
distance between keyframe. Range: 0 to 1,000 frames.

Intra Refresh Period. Use the slider (or enter the value manually) to set the maximum
distance between Intra Block Refreshes. Range 0 to 140 frames.

Profile Settings

H.263 has a number of profiles, supporting different features.

Figure 112. H263 Codec—Profile Settings

Profile. Select from the following options:

Baseline (Profile 0) only allows the picture sizes QCIF (176 x144) and Sub-QCIF (128 x
96). No other profile settings are enabled.

Profile 3 supports all picture sizes and enables the following options:
Advanced Intra Coding. Check to use an advanced algorithm for coding intra blocks.
Deblocking Filter. Check to reduce artifacts at the edges of encoding blocks.

Slice Structure. Check to use slices when encoding frames. This allows faster re-
synchronization of the picture for lossy connections.

Modified Quantization. Check to use an alternate quantization method to increase
color fidelity.

Encoding Settings

Figure 113. H263 Codec—Encoding Settings

Use two-pass encoding

Two-pass encoding. Check to perform encoding in two passes. In pass one, the codec
analyzes the frames and collects data. In the second pass it uses the collected data as
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the basis for how to best distribute the bits. Two-pass encoding provides better output
image quality but increases encoding time.
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H.264 (MainConcept) Codec

H.264 is also known as AVC and MPEG-4 Part 10'. H.264 uses many different techniques
to achieve excellent video compression ratio for bit rates ranging from very low levels
for hand-held devices to high levels for HD television.

Note: This topic describes how to use the MainConcept H.264 codec. You can also
generate H.264 video using the H.264 (x264) Codec.

m Bandwidth Settings

m Frame Type Settings

m Profile Settings

m Display Settings

m Quality Settings

m Detailed Frame Settings
m Bitstream Flags

m Level Signaling

Bandwidth Settings

Figure 114. H264 Codec—Bandwidth Settings
Bandwidth Comntrol Variable Bit Rate (VER)

Average Bit Rate (kbit/s) 4800

Variable Bit Rate (VER)
Quality (%)

Bandwidth Control. Select from the following options:

Constant Bit Rate (CBR) uses the constant bit rate with the Average Bit Rate setting.
Variable Bit Rate (VBR) uses the Average Bit Rate setting.

Variable Bit Rate (VBR)—Quality Based uses the VBR Quiality setting.

Average Bit Rate. When Variable Bit Rate (VBR) is selected, specify the desired bit rate of
the video track. Range: 15 to 100,000 Kbps.

Note: The actual maximum size of the VBV is determined by the encoding level and
target bit rate and may be considerably less than 60 s. In this case it is limited to the
maximum possible value. See VBV Video Buffer Verifier.

Variable Bit Rate (VBR) Quality. Use the slider (or enter the value manually) to set the
image quality for a video frame expressed as a percent: 0% (most compression, lowest
quality) to 100% (least compressed, highest quality).

1. International Organization for Standardization. Information technology—Coding of audio-visual objects, 2004.
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Frame Type Settings

Figure 115. H264 Codec—Frame Type Settings

Frame Type Settings

Keyframe Contral Matural and Forced Keyframes: v

Keyframe Distance
{Frames)

Use adaptive B-frames

Number of B-Frames
{Frames)

Number of Reference
Frames {Frames)

Keyframe Control. Select from the following options:
Keyframes Only creates all frames as keyframes. Requires very high video bit rate.
Forced Keyframes Only creates keyframes with exactly the specified keyframe distance.

Natural and Forced Keyframes creates keyframes when the encoder detects a scene
change, but also inserts a keyframe at Keyframe distance from the latest keyframe. If
Keyframe distance is 0, only natural keyframes are created.

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Keyframe Interval. When enabled (Forced Keyframes Only | Natural and Forced
Keyframes) Specify the maximum distance between keyframes. Range: 0 to 300.

Use Adaptive B-frames. Check to use fewer than the number of B-frames (specified in
Number of B-frames) in a sequence if this improves quality.

Number of B-frames. Use the slider (or enter the value manually) to set the number of
B-frames between P-frames in a GOP. Range: 0 to 3.

Number of Reference Frames. Use the slider (or enter the value manually) to set the
number of reference frames stored. A higher number may improve coding quality but
increases encoding time. Range: 0 to 16.

Profile Settings

Episode 6.5

Figure 116. H264 Codec—Bandwidth Settings

Profile Settings

Encoding Profile

Entropy Coding

Profile Settings. Select Baseline | Main | High profile.

Baseline is primarily used for low-cost applications that require additional data loss
robustness. This profile is used in some videoconferencing and mobile applications.

Main is used for standard-definition digital TV broadcasts that use the MPEG-4 format.
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High is primarily used for broadcast and disc-based applications, particularly for high-
definition applications.

Entropy Coding. When enabled (Main | High profile), select from these options:
CAVLCis simpler and faster. When Baseline profile is selected, CAVLC is used.
CABAC is slower and higher quality.

Display Settings

The color space option is only enabled when High profile is selected. For Baseline and
Main, only 4:2:0 color space is used.

Figure 117. H264 Codec—Display Settings

Color Space. When High profile is selected, choose Same as Source | 4:2:0 | 4:2:2. See
Color Formats.

Display Aspect Ratio. Select from these options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3 | 16:9 explicitly set the display aspect ratio.

Quality Settings

Figure 118. H264 Codec—Quality Settings

Two-pass Encoding. Check to perform encoding in two passes. In pass one, the codec
analyzes the frames and collects data. In the second pass it uses the collected data as
the basis for how to best distribute the bits. Two-pass encoding provides better output
image quality but increases encoding time.

Deblocking Filter. Check to smooth out block artifacts which may occur in the image
when using lower bit rates.

Adaptive Interlacing Mode. Check to generate more efficient interlaced output. This
option increases encoding time.
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Detailed Frame Settings

Episode 6.5

Figure 119. H264 Codec—Detailed Frame Settings

Detailed Frame Settings

Number of Slices 4 Shices

Initial Buffer Fullness (%) 100

Number of Slices. Select from these options:

Automatic (One per CPU) speeds up processing by transcoding parts (slices) of the same
frame in parallel.

1Slice | 2 Slices | 3 Slices | 4 Slices Select to speed encoding. Using more slices may
decrease image quality somewhat as redundancies between parts of the frame cannot
be fully utilized.

Initial Buffer Fullness. Use the slider (or enter the value manually) to set the maximum
percent of the buffer to be utilized.

When encoding starts, the encoder assumes a certain level of bits in the buffer, to
obtain an even bit rate right from the beginning. How full the buffer is affects how large
the first frames are. Lower means fewer available bits and the first frames are smaller.
This is good when you want to limit the size of the first frame which typically can be
very large, especially if there is little motion in the material (because then it makes
sense to spend a lot of bits on the quality of the first frame). A low value decreases
quality slightly for the first frames of the movie. The default value is 50%.

IDR Frames. Select from the following options to set the frequency of IDR frames: Every
| Every 2nd | Every 3rd | Every 5th | Every 10th.

An IDR frame is an I-frame whose preceding frames cannot be used by predictive
frames. Predictive frames (P-frames and B-frames) coming after an I-frame may look at
frames before the I-frame for best compression. More distant IDR frames may allow
more efficient compression but limits the ability of a player to move to arbitrary points
in the video. In particular, QuickTime Player may display image artifacts when you scrub
the timeline unless every |-frame is an IDR frame.

Limit Frame Size. Check to enable the Frame Size option so you can set it as
appropriate.

Even if the average bit rate stays below the set limit, individual frames may become
larger than a decoder can handle in real time, thus you may need to set limits on how
large frames can get. This limitation may reduce image quality considerably, so you
should not use this setting unless you have definite problems.

Frame Size. When enabled, use the slider (or enter the value manually) to limit the
maximum frame size. Range: 2 to 10 times the average frame size.
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Bitstream Flags

Figure 120. H264 Codec—Bitstream Flag Settings

Bitstream Flags

Force headers for every
GOP

Add picture timing SEI

Signal fixed framerate v

Pulldown None

Force Headers for Every GOP. Check to insert a header before every GOP, which is a
requirement for producing Blu-ray media.

Add Picture Timing SEI. Check to add Supplemental Enhancement Information fields
indicating the global time for each frame and suitable decoder settings. They add a
small overhead to the file size, but can help a decoder play out the video more
efficiently.

Signal Fixed Framerate. Check to indicate that the clip is to be played out with a fixed
framerate.

Pulldown. Select how to set the flag which tells a player how to pull down fields in
order to display at a higher frame rate. See Video Scan.

Select from these options:
None does not perform pulldown.

2:3(23.976/24->29.97/30 FPS) | 3:2 (23.976/24 -> 29.97/30 FPS) | 2:3 (23.976/24 -> 59.94/60
FPS)|3:2(23.976/24 -> 59.94/60 FPS). If the frame rate does not match 23.976 or 24 these
settings are ignored.

Level Signaling

Figure 121. H264 Codec—Level Signalling Settings

Level Signalling

Level. Select an option to mark the level of the output as a higher value than the
default. Select from these options: Auto | Level 1.1... Level 5.1.

The level you select provides the decoder the required maximum values for macro
block rates, frame sizes and bit rates. Episode automatically marks the level as
corresponding to the lowest level matching the current values for those parameters. If
you indicate a level lower than allowed by the current parameter values, the lowest
legal level is silently selected.
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Closed Captioning Settings
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Figure 122. H.264 (MainConcept) Codec—Closed Captioning Settings

Closed Captioning

Closed Captioning

Closed Captioning Fields

Closed Captioning. Select None | Same as Source | EIA-608 | EIA-608 + EIA-708.

This setting controls and enables only the output side of the closed captioning
capability. When set to None, no captions are embedded in the encoded output. When
set to Same as Source, EIA-608, or EIA-608 + EIA708, closed captions (of the type
selected) embedded in the source are likewise embedded into the encoded output.

None. Embedded closed captions in the source are not included in the output.

Same as Source. Embedded captions in input media are embedded in output media.
EIA-608. 608 captions embedded in input media are embedded in output media.
EIA-608 + EIA-708. Embedded 608/708 input captions are embedded in the output.

Note: Depending on the source, you may also need to enable an input Video Filter:

To make captions embedded in source blanking available to the encoder, select
Decode Captions in the VBI Importer Filter. (Strips input VBI captions if not selected).

To import 608/708 captions from .scc or .mcc caption files, select the Caption Importer
Filter and browse for the .scc or . mcc caption file.

MPEG-2 source files containing embedded captions in the user data do not require the
VBI Importer Filter. As long as Closed Captioning is enabled for the encoder, captions on
the input should pass to the transcoded output.

You can also choose to include closed captions in the MXF AS-11 (mxf), MXF Op1la
(.mxf), or MXF XDCAM (.mxf) file containers. To do so, select Container in the Inspector,
and select Add Ancillary Closed Caption Track.
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H.264 (x264) Codec

H.264 is also known as AVC and MPEG-4 Part 10'. H264 uses many different techniques
to achieve excellent video compression ratio for bit rates ranging from very low levels

for hand-held devices to high levels for HD television.

Note: This topic describes the x264 H.264 codec, often referred to simply as x264. You

can also generate H.264 media using the H.264 (MainConcept) Codec.

Tables below each user interface figure identify corresponding standard x264 CLI
commands so that you can correlate the two interfaces more easily. The CLI commands

in these tables are not those of the x264 implementation in the Episode CLI.

m Bandwidth Settings

m Preset and Tuning

m Frame Type Settings

m Buffering Settings

m Display Settings

m Profile & Level Settings

m Slices Settings

m Deblocking Filter Settings
m Analysis Settings

m Compatibility Settings

m Closed Captioning Settings

Bandwidth Settings

Figure 123. x264 Codec—Bandwidth Settings

Bandwidth Settings
Rate Control Method
Average Bit Rate (kbitfs)
HRD Compliance
VBV Size (kbit)

VEV Max Bit Rate (kbit/s)

Quality

1. International Organization for Standardization. Information technology—Coding of audio-visual objects, 2004.
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Table 46. H264 (x264) Codec CLI—Bandwidth Settings

Rate Control Method
Average Bit Rate -B, --bitrate
Constant Quality -g, —-qp
HRD Compliance --nal-hrd
Disabled none
CBR cbr
VBR vbr
VBV Size --vbv-bufsize
VBV Max Bit Rate --vbv-maxrate

Rate Control Method. Select from the following options:
Average Bit Rate uses the Average Bit Rate setting.
Constant Quality Based uses the Quality setting.

Average Bit Rate. When Average Bit Rate is selected, specify the desired bit rate of the
video track. Range: 15 to 400,000 Kbit/s.

HRD Compliance. HRD (Hypothetical Reference Decoder) is a reference model of a
decoder that is specified in the H.264 standard. It defines two buffers by their size and
read/write speed. Creation of HRD-compliant video streams is important when the
stream is to be streamed at a constant bit rate or played back on a hardware device
with limited resources (DVD/Blu-ray players, etc.).

Select from these options:

Disabled eliminates the requirement to adhere to the HRD model. This is the preferred
choice when encoding a file for local playback or download to a computer.

CBR encodes to a constant bit rate targeted at the average bit rate value. This is the
preferred choice when encoding files to be streamed to a device. For CBR mode, you
must also specify the VBV size. The VBV maximum bit rate is set to the same value as the
average bit rate.

VBR encodes to an average bit rate constrained to the average bit rate value. For VBR
mode one must also specify the VBV size and the VBV max bit rate. VBR mode is the
preferred choice when the VBV buffer has a bit rate different from the average bit rate.
For example, a Blu-ray player can fill the VBV buffer at a higher bit rate than the video
average bit rate.

VBV Size. Specifies the size of the VBV buffer in kilobits. A larger buffer provides the
encoder a longer time for varying the bit rate. The buffer is filled at the bit rate set by
the VBV Max bit rate. A larger buffer also increases the time the decoder/player has to
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buffer the stream before it should start playback (buffering time (in seconds) = VBV Size

/ VBV Max bit rate).

VBV Max Bitrate. The bit rate at which the VBV buffer fills. In a scenario where you
stream a file at a constant bit rate (for example, a VOD transport stream), this is set to
the same rate as the video bit rate. If you are encoding for a device that can refill the

buffer faster than the average bit rate, set it here.

Quality. When Constant Quality is selected, use the slider (or enter the value manually)
to set the image quality for a video frame expressed as a whole number: 1 (Best) to 51

(Worst).

Preset and Tuning

Figure 124. x264 Codec—Preset and Tuning

Table 47. H264 (x264) Codec CLI—Preset and Tuning Settings

Preset --preset
Ultra Fast ultrafast
Super Fast superfast
Very Fast veryfast
Faster faster
Fast fast
Medium medium
Slow slow
Slower slower
Very Slow veryslow
Placebo placebo

Tuning —-tune
Disabled (--tune not set)
Film film
Animation animation
Grain grain

teflégtr'ea'n
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Table 47. H264 (x264) Codec CLI—Preset and Tuning Settings
Still Image stillimage
PSNR psnr
SSIM ssim
Fast Decode fastdecode
Zero Latency zerolatency
Preset. Select from these options, which trade encoding speed for visual quality:
Ultra Fast | Super Fast | Very Fast | Faster | Fast | Medium | Slow | Slower | Very Slow |Placebo
Tuning. Select from these options, which optimize encoding quality for a particular
type of source content:
Disabled performs no special optimization of the video frame during encoding.
Film optimizes the output assuming film-based input.
Animation optimizes the output assuming animated media input.
Grain optimizes the output assuming grainy video input.
Still Image optimizes the output assuming still images as input.
PSNR optimizes the encoder for PSNR (peak signal to noise ratio) at the expense of
visual quality.
SSIM optimizes the encoder for SSIM (structural similarity) at the expense of visual
quality.
Fast Decode optimizes the output for fastest decoding on the display device.
Zero latency optimizes the output to target zero latency on the display device.
Figure 125. x264 Codec—Frame Type Settings
Keyframe Control
Keyframe Interval
(Frames)
Max Number of Reference |
Frames {Frames)
Adagtive B-Frames Fast
Number of B-Frames 3
(Frames)
E-Frames Rd'grem:e Disabled
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Table 48. H264 (x264) Codec CLI—Frame Type Settings

Keyframe Control

Natural Keyframes

Only

Natural and Max

Keyframe Interval

Natural and Forced

Keyframe Interval

Forced Keyframe --no-scenecut

Interval Only

Keyframes Only -i, -min-keyint 1
Keyframe Interval -1, --keyint
Max Number of Reference --ref
Frames
Adaptive B-Frames --b-adapt

Auto (From Preset)

Disabled 0

Fast 1

Trellis 2
Number of B-Frames -b, --bframes
B-Frames As Reference --b-pyramid
Frames (B-Pyramid)

Disabled none

Strict strict

Normal normal

Keyframe Control. Controls the method of inserting keyframes into the stream.
Select from the following options:
Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Natural and Max Keyframe Interval creates keyframes when the encoder detects a scene
change, but also inserts a keyframe if the Keyframe Interval distance is reached before a
natural keyframe has been created.

Forced Keyframe Only only creates keyframes at the set keyframe interval.
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Natural and Forced Keyframe Interval creates keyframes when the encoder detects a
scene change, but also inserts a keyframe at the set keyframe interval.

Forced Keyframe Only creates all frames (requires higher bit rates).
Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Keyframe Interval. When Natural and Max Keyframe Interval | Forced Keyframe Only |
Natural and Forced Keyframe Interval are selected, use the slider (or enter the value
manually) to specify the maximum distance between keyframes. Range: 0 to 300.

Max Number of Reference Frames. Use the slider (or enter the value manually) to set
the maximum number of frames a frame can reference. More reference frames provides
better quality, because the encoder has more frames in which to find similarities, but
increases memory use by the decoder. Range: 1 to 16.

Adaptive B-Frame. Check to enable adaptive B-frame placement. Sometimes it is
better to create a P-frame rather than a B-frame, so the number of B-frames between P-
frames may become less than the Number of B-frames value.

Number of B-Frames. Use the slider (or enter the value manually) to set the number of
B-frames that can be used between P-frames. Range: 1 to 16.

B-Frames as Reference Frames (B-Pyramid). Allows the use of B-frames as references
for other frames.

Select from these options:
Disabled does not allow B-frames to the used as references.
Strict allows one B-frame per mini-GOP to be used as a reference.

Normal allows numerous B-frames per mini GOP to be used as a reference.

Buffering Settings

Episode 6.5

Figure 126. x264 Codec—Buffering Settings
Buffering

Override Number of
Frames To Look Ahead

Numnber of Frames To
Look Ahead (Frames)

Two-Pass Encoding

Table 49. H264 (x264) Codec CLI—Buffering Settings

Number of Frames To Look --rc-lookahead
Ahead
Two-Pass Encoding -p, --pass 2

Override Number of Frames to Look Ahead. Check to override the default Frame
Look-ahead value.
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Number of Frames to Look Ahead. Use the slider (or enter the value manually) to
specify the number of frames the encoder can look ahead to detect more difficult areas
to encode, and save bits for those sections. Range: 0 to 250.

Two-Pass Encoding. Check to perform encoding in two passes. In the first pass, the
encoder analyzes the frames and collects data. In the second pass, it uses the collected
data as the basis for how to best distribute the bits. Two-pass encoding provides better
output image quality but increases encoding time.

Display Settings
Figure 127. H264 Codec—Display Settings
Display settings
Display Aspect Ratio From Source/Resize Filter v

Table 50. H264 (x264) Codec CLI—Display Settings

Display Aspect Ratio

Square Pixels (will use --sar to set correct
display aspect ratio)

4:03:00

16:09:00

Display Aspect Ratio. Select from these options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3 | 16:9 explicitly set the display aspect ratio.

Profile & Level Settings

Figure 128. H264 Codec—Profile & Level Settings

Main v

Autn {Recommended) v

Comtext-Adaptive Binary-Arithmetic { W
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Table 51. H264 (x264) Codec CLI—Profile and Level Settings

Profile --profile
Baseline baseline
Main main
High high

Level --level

Entropy Coding

Auto (From Preset)

Context-Adaptive --no-cabac
Variable-Length
Coding (CAVLQ)

Context-Adaptive (--no-cabac not set)
Binary-Arithmetic
Coding (CABACQ)

Profile. Select from the following options:

Baseline uses the fastest encode and decode profile.

Main uses a more complex encoder, which usually provides better quality/bit rate ratio.
High use an even more complex encoder. Requires Episode Pro or Episode Engine.

Level. The level you select provides the decoder the maximum values for macro block
rates, frame sizes, reference frames, VBV information, and bit rates.

Select from these options:

Auto. Episode automatically marks the level as corresponding to the lowest level
matching the current configuration.

Levels (1.0 to 5.1). Select an option to mark the level of the output as a higher value than
the default. If you manually select a level lower than allowed by the current parameter
values, the configuration may silently change to match the selected level.

Entropy Coding. When enabled (Main | High profile), select from these options:
CAVLC s simpler and faster. When Baseline profile is selected, CAVLC is used.

CABAC is slower and higher quality. CABAC is enabled when Main or High files are
selected.
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Slices Settings

Figure 129. x264 Codec—Slices Settings
Slices

Numnber of slices Autny v

Table 52. H264 (x264) Codec CLI—Slices Settings

Number of Slices --slices

Number of Slices. Select from these options:
Auto speeds up processing by transcoding parts (slices) of the same frame in parallel.

1 Slice | 2 Slices | 3 Slices | 4 Slices. Select to speed encoding. Using more slices may
decrease image quality somewhat as redundancies between parts of the frame cannot
be fully utilized.

Deblocking Filter Settings

Figure 130. x264 Codec—Deblocking Filter Settings

Table 53. H264 (x264) Codec CLI—Deblocking Filter Settings

Deblocking Filter -f, --deblock
Strength alpha
Threshold beta

Deblocking Filter. Select to enable the in-loop deblocking filter. The deblocking filter
provides quality gains without affecting the encoding speed significantly. Telestream
recommends that you enable this option.

Strength. When deblocking is enabled, use the slider (or enter the value manually) to
specify filter strength, which affects the overall amount of deblocking to be applied.
Higher values deblock the picture more effectively, but destroys details in the picture to
provide a more softened picture.

Threshold. When deblocking is enabled, use the slider (or enter the value manually) to
specify filter threshold, which determines whether something in a block is a detail or
not. Higher values apply more deblocking to less flat blocks (with more detail present).
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Figure 131. x264 Codec—Analysis Settings
Analysis
Motion Estimation Method  Hexagon
?\p:;‘t:él}Ed:imﬁunRange 16
Override Motion Vector
Motion Vector Range
(Picals)
Fast Moise Redudtion
Weighted P-Frames
Prediction
Table 54. H264 (x264) Codec CLI—Analysis Settings
Motion Estimation Method --me
Auto (From Preset)
Diamond dia
Hexagon hex
Uneven Multi-Hex umh
Exhaustive esa
Transformed tesa
Exhaustive
Motion Estimation Range --merange
Motion Vector Range --mvrange
Fast Noise Reduction --nr
Weighted P-Frames --weightp
Prediction
Auto (From Preset)
Disabled 0
Simple 1
Smart 2
Motion Estimation Method. Select the full-pixel motion estimation method to use:
Diamond | Hexagon | Uneven Multi-Hex | Exhaustive | Transformed Exhaustive
Motion Estimation Range. Use the slider (or enter the value manually) to specify the
maximum range of motion search in pixels. Range 0 to 32.
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Override Motion Vector Range. Check to override the motion vector value.

Override Motion Vector Range. When Override Motion Vector Range is checked, use
the slider (or enter the value manually) to specify the maximum vertical range of any

one motion vector in pixels. Range -1 (Auto) to 1024.

Fast Noise Reduction. Use the slider (or enter the value manually) to estimate noise
based on this value and attempts to remove it by dropping small details before

quantization. Range 0 to 1000.

Weighted P-Frames Prediction. Select Auto (from Preset) | Disabled | Simple | Smart.

Compatibility Settings

Figure 132. x264 Codec—Compatibility Settings

Compatibility
Fake Interlace

Force headers for every
GOPp

Open GOP

Blu-Ray Compatibility

Table 55. H264 (x264) Codec CLI—Compatibility Settings

Fake Interlace

--fake-interlaced

Force headers for every
GOP

Open GOP

--open-gop

Blu-Ray Compatibility

--preset veryslow
--tune film
--bluray-compat
--vbv-maxrate X
--vbv-bufsize X
-level 4.1

--keyint X
--open-gop

--slices 4

--tff

--colorprim "bt709"
--transfer "bt709"
--colormatrix "bt709"
--sar X

--pass 1

Fake Interlace. Check to mark the video stream as interlaced even when the stream is
progressive. Allows the encoding of 25p and 30p Blu-ray-compliant video streams.
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Force Headers for every GOP. Check to insert a header for every GOP, which is a
requirement for producing Blu-ray media.

Open GOP. Check Open GOP encoding to increase encoding efficiency. However, not
all players/decoders support this encoding method.

Blu-Ray Compatibility. Check to adhere to encode for Blu-Ray compatibility.

Closed Captioning Settings

Episode 6.5

Figure 133. x264 Codec—Closed Captioning Settings

Closed Captioning

Closed Captioning

Closed Captioning Fields

Closed Captioning. Select None | Same as Source | EIA-608 | EIA-608 + EIA-708.

This setting controls and enables only the output side of the closed captioning
capability. When set to None, no captions are embedded in the encoded output. When
set to Same as Source, EIA-608, or EIA-608 + EIA708, closed captions (of the type
selected) embedded in the source are likewise embedded into the encoded output.

None. Embedded closed captions in the source are not included in the output.

Same as Source. Embedded captions in input media are embedded in output media.
EIA-608. 608 captions embedded in input media are embedded in output media.
EIA-608 + EIA-708. Embedded 608/708 input captions are embedded in the output.

Note: Depending on the source, you may also need to enable an input Video Filter:

To make captions embedded in source blanking available to the encoder, select
Decode Captions in the VBl Importer Filter. (Strips input VBI captions if not selected).

To import 608/708 captions from .scc or .mcc caption files, select the Caption Importer
Filter and browse for the .scc or .mcc caption file.

MPEG-2 source files containing embedded captions in the user data do not require the
VBI Importer Filter. As long as Closed Captioning is enabled for the encoder, captions on
the input should pass to the transcoded output.

You can also choose to include closed captions in the MXF AS-11 (mxf), MXF Op1ia
(.mxf), or MXF XDCAM (.mxf) file containers. To do so, select Container in the Inspector,
and select Add Ancillary Closed Caption Track.

Closed Captioning Fields. Default: Field 1. This option is not user-configurable and is
always set to Field 1 for H.264 (x264), which means that only Field 1 caption information
is forwarded to the output if Closed Captioning is set to E/A-608. Any Field 2 caption
information is disregarded.
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HDV Codec

HDV is a High Definition Video codec which utilizes MPEG-2 compression.

Figure 134. HDV Codec Settings

HLV Type HDV 720p (1280x720 24, 25, 29.97,. W
Frame Type Frame v
Fiedd Order Top Frst v

HDV Type. Select from the following options:

HDV 720p (1280 x720 24, 25, 29.97, 30, 50, 59.94 or 60 FPS) | HDV 1080i (1440 x1080 25,
29.97 or 30 FPS) | HDV 1080p (1440 x1080 24 or 25 FPS).

Note: This setting determines the allowable values for the Resize Filter, Frame Rate
Filter, and Advanced Frame Rate Filter and the corresponding values of the source file.
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HEVC (H.265/x265) Codec

The High Efficiency Video Coding format (HEVC), also known as H.265, succeeds the
H.264 format, providing approximately double the compression with the same video
quality. HEVC format supports resolutions up to 8K (8192 x 4320) or lower resolutions at
higher quality for the same bit rate compared to H.264.

m Bandwidth Settings

m Preset and Tuning

m Frame Type Settings

m Compatibility

m Buffering Settings

m Display Settings

m Profile & Level Settings

Bandwidth Settings

Figure 135. H.265 (x265)Codec—Bandwidth Settings

Bandwidth Settings
Rate Control Method Average Bit Rate
Average Bit Rate (kbit/s) 1000
HRD Compliance Disabled
VBV Size (kbit)

VBV Max Bit Rate (kbit/s)

Quality

" 51 worsy

Table 56. H.265 (x265) Codec CLI—Bandwidth Settings

Rate Control Method
Average Bit Rate -B, --bitrate
Constant Quality -, --qp
HRD Compliance --nal-hrd
Disabled none
CBR cbr
VBR vbr
VBV Size --vbv-bufsize
VBV Max Bit Rate --vbv-maxrate

Rate Control Method. Select from the following options:
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Average Bit Rate uses the Average Bit Rate setting.
Constant Quality Based uses the Quality setting.

Average Bit Rate. When Average Bit Rate is selected, specify the desired bit rate of the
video track. Range: 15 to 400,000 Kbit/s.

HRD Compliance. HRD (Hypothetical Reference Decoder) is a reference model of a
decoder that is specified in the H.265 standard. It defines two buffers by their size and
read/write speed. Creation of HRD-compliant video streams is important when the
stream is to be streamed at a constant bit rate or played back on a hardware device
with limited resources (DVD/Blu-ray players, etc.).

Select from these options:

Disabled eliminates the requirement to adhere to the HRD model. This is the preferred
choice when encoding a file for local playback or download to a computer.

CBR encodes to a constant bit rate targeted at the average bit rate value. This is the
preferred choice when encoding files to be streamed to a device. For CBR mode, you
must also specify the VBV size. The VBV maximum bit rate is set to the same value as the
average bit rate.

VBR encodes to an average bit rate constrained to the average bit rate value. For VBR
mode one must also specify the VBV size and the VBV max bit rate. VBR mode is the
preferred choice when the VBV buffer has a bit rate different from the average bit rate.
For example, a Blu-ray player can fill the VBV buffer at a higher bit rate than the video
average bit rate.

VBV Size. Specifies the size of the VBV buffer in kilobits. A larger buffer provides the
encoder a longer time for varying the bit rate. The buffer is filled at the bit rate set by
the VBV Max bit rate. A larger buffer also increases the time the decoder/player has to
buffer the stream before it should start playback (buffering time (in seconds) = VBV Size
/ VBV Max bit rate).

VBV Max Bitrate. The bit rate at which the VBV buffer fills. In a scenario where you
stream a file at a constant bit rate (for example, a VOD transport stream), this is set to
the same rate as the video bit rate. If you are encoding for a device that can refill the
buffer faster than the average bit rate, set it here.

Quality. When Constant Quality is selected, use the slider (or enter the value manually)
to set the image quality for a video frame expressed as a whole number: 1 (Best) to 51
(Worst).

Preset and Tuning

Figure 136. H.265 (x265) Codec—Preset and Tuning
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Table 57. H.265 (x265) Codec CLI—Preset and Tuning Settings
Preset —preset
Ultra Fast ultrafast
Super Fast superfast
Very Fast veryfast
Faster faster
Fast fast
Medium medium
Slow slow
Slower slower
Very Slow veryslow
Placebo placebo
Tuning --tune
Disabled (—-tune not set)
Film film
Animation animation
Grain grain
Still Image stillimage
PSNR psnr
SSIM ssim
Fast Decode fastdecode
Zero Latency zerolatency
Preset. Select from these options, which trade encoding speed for visual quality:
Ultra Fast | Super Fast | Very Fast | Faster | Fast | Medium | Slow | Slower | Very Slow |Placebo
Tuning. Select from these options, which optimize encoding quality for a particular
type of source content:
Disabled performs no special optimization of the video frame during encoding.
PSNR optimizes the encoder for PSNR (peak signal to noise ratio) at the expense of
visual quality.
SSIM optimizes the encoder for SSIM (structural similarity) at the expense of visual
quality.
t/elggtr‘ean
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Grain optimizes the output assuming grainy video input.

Zero latency optimizes the output to target zero latency on the display device.

Fast Decode optimizes the output for fastest decoding on the display device.

Frame Type Settings

Figure 137. H.265 (x265) Codec—Frame Type Settings

Frame Type Settings
Keyframe Control

Keyframe Interval (Frames)

Max Number of Reference  , . {From Praset}

Frames [Frames)

Adaptive B-Frames Auwto (From Praset)

MNumber of B-Frames
(Frames)

Auto (From Preset}

B-Frames As Reference Disabled
Frames (B-Pyramid])

Natural Keyframes Only

Table 58. H.265 (x265) Codec CLI—Frame Type Settings

Keyframe Control

Natural Keyframes
Only

Natural and Max
Keyframe Interval

Natural and Forced
Keyframe Interval

Forced Keyframe

--no-scenecut

Interval Only
Keyframes Only -i, -min-keyint 1
Keyframe Interval -1, --keyint
Max Number of Reference -—-ref
Frames
Adaptive B-Frames --b-adapt

Auto (From Preset)

Disabled 0
Fast 1
Trellis p
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Table 58. H.265 (x265) Codec CLI—Frame Type Settings

Number of B-Frames -b, --bframes

B-Frames As Reference --b-pyramid
Frames (B-Pyramid)

Disabled none
Strict strict
Normal normal

Keyframe Control. Controls the method of inserting keyframes into the stream.
Select from the following options:
Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Natural and Max Keyframe Interval creates keyframes when the encoder detects a scene
change, but also inserts a keyframe if the Keyframe Interval distance is reached before a
natural keyframe has been created.

Forced Keyframe Interval Only only creates keyframes at the set keyframe interval.
Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Keyframe Interval. When Natural and Max Keyframe Interval | Forced Keyframe Only |
Natural and Forced Keyframe Interval are selected, use the slider (or enter the value
manually) to specify the maximum distance between keyframes. Range: 0 to 300.

Max Number of Reference Frames. Use the slider (or enter the value manually) to set
the maximum number of frames a frame can reference. More reference frames provides
better quality, because the encoder has more frames in which to find similarities, but
increases memory use by the decoder. Range: 1 to 16.

Adaptive B-Frames. Check to enable adaptive B-frame placement. Sometimes it is
better to create a P-frame rather than a B-frame, so the number of B-frames between P-
frames may become less than the Number of B-frames value.

Number of B-Frames. Use the slider (or enter the value manually) to set the number of
B-frames that can be used between P-frames. Range: 1 to 16.

B-Frames as Reference Frames (B-Pyramid). Allows the use of B-frames as references
for other frames.

Select from these options:
Disabled does not allow B-frames to the used as references.
Strict allows one B-frame per mini-GOP to be used as a reference.

Normal allows numerous B-frames per mini GOP to be used as a reference.
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Compatibility

Figure 138. H.265 (x265) Codec Compatibility Settings

Open GOP. Check Open GOP encoding to increase encoding efficiency. However, not
all players/decoders support this encoding method.

Buffering Settings

Figure 139. H.265 (x265) Codec—Buffering Settings

Number of Frames To
Look Ahead (Frames)

Two-Pass Encoding

Table 59. H.265 (x265) Codec CLI—Buffering Settings

Number of Frames To Look --rc-lookahead
Ahead
Two-Pass Encoding -p, —-pass 2

Override Number of Frames to Look Ahead. Check to override the default Frame
Look-ahead value.

Number of Frames to Look Ahead. Use the slider (or enter the value manually) to
specify the number of frames the encoder can look ahead to detect more difficult areas
to encode, and save bits for those sections. Range: 0 to 250.

Two-Pass Encoding. Check to perform encoding in two passes. In the first pass, the
encoder analyzes the frames and collects data. In the second pass, it uses the collected
data as the basis for how to best distribute the bits. Two-pass encoding provides better
output image quality but increases encoding time.

Display Settings

Figure 140. H.265 (x265) Codec—Display Settings

Display Settings

Display Aspect Ratio From Source/Resize Filter

VAT
telestream Episode 6.5



Video Codecs
HEVC (H.265/x265) Codec

Table 60. H.265 (x265) Codec CLI—Display Settings

Display Aspect Ratio

Square Pixels (will use --sar to set correct
display aspect ratio)

4:03:00

16:09:00

Display Aspect Ratio. Select from these options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3 | 16:9 explicitly set the display aspect ratio.

Profile & Level Settings

Episode 6.5

Figure 141. H.265 (x265) Codec—Profile & Level Settings

Main 10

Auto (Recommended)

Table 61. H.265 (x265) Codec CLI—Profile and Level Settings

Profile --profile
Main main
Main10 high

Level --level

Profile. Select from the following options:
Main performs 8-bit encoding.
Main 10 performs 8- to 10-bit encoding. Requires Episode Pro or Episode Engine.

Level. The level you select provides the decoder the maximum values for macro block
rates, frame sizes, reference frames, VBV information, and bit rates.

Select from these options:

Auto. Episode automatically marks the level as corresponding to the lowest level
matching the current configuration.

Levels (1.0to 5.1). Select an option to mark the level of the output as a higher value than
the default. If you manually select a level lower than allowed by the current parameter
values, the configuration may silently change to match the selected level.
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JPEG Sequence Codec

Note: This feature is available in both the Episode CLI and in the GUI client with the
Episode Engine license. For CLI details, see the Episode Advanced User’s Guide.

Select a sequence of JPEG images as an input format for conversion to video. RGB 32-bit
is supported.

Figure 142. Image Sequence Settings

F™™ Untitled

Image Sequence

Task Name  Untitled

Max sequence number increase

Safety files

Frame rate
Encode while ingest
Encode while ingest waits{zec)

Encode while ingest number of waits

Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default
value is 1, meaning that one missing number in a sequence is treated as the end of the
sequence. If set to another number, that number of sequence numbers must be
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the
sequence before processing of the file begins. This does not apply to the first file in a
sequence. This only has practical implications if Encode While Ingest is enabled. Setting
this to 0 (zero) may significantly decrease the time the encoder has to wait when the
end of the sequence is reached, but depending on file system and file format, may
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device
that produces an image sequence over time. Wait times between received files can be
specified in the following wait fields.

Encode while ingest waits (sec). Specifies the number of seconds to wait before
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to
wait for files during encode while ingest. The default is 5 times. If no files are received
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.

VAT
telestream Episode 6.5



Video Codecs | 239
JPEG Sequence Codec

Revert. Restores the Image Sequence settings to what they were before they were
changed.

Save As. Saves the Image Sequence configuration to a file.
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MJPEG Codec

The Motion JPEG (MJPEG) codec generates a sequence of JPEG still images, and is
suitable to use as an editing format.

m Profile Settings
m Encoding Setting

Profile Settings

Figure 143. MJPEG Codec—Profile Settings

Profile Settings

Profile

Profile. Select MJPEG A | MJPEG B | Photo JPEG. The actual encoding is identical for all
versions, but the headers are different.

Color Space. Select Same as Source | 4:2:0 | 4:2:2 (see Color Formats (78)).

Encoding Setting

Figure 144. MJPEG Codec—Encoding Setting

Encoding Settings

Encoding Quality (%)

Encoding Quality. Use the slider (or enter the value manually) to specify the image
quality as a percent, from 0 (most compression, lowest quality) to 100 (least
compressed, highest quality).
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MPEG-1 Codec

MPEG-1 video is accepted by most video players. This format is suitable when it is
important to reach a large audience on different platforms. MPEG-1 is recommended
for image sizes up to CIF (352 x 288) and bit rates up to 1500 Kbps. Above 1500 Kbps,
MPEG-2 is typically a better encoding option.

m Bandwidth Settings
m Keyframe Settings

Bandwidth Settings

Figure 145. MPEG-1 Codec—Bandwidth Settings
Bandwidth Settings

Coding Type

Average Rate (kbitfs)

Encoding Quality (%)

Coding Type. Select from the following options:
Bit Rate-based controls bandwidth by specifying a maximum bit rate.
Quality-based controls bandwidth by specifying a maximum quality.

Average Bit Rate. When bit rate-based is selected as the coding type, specify the
desired bit rate of the video track, from 16 Kbps upwards.

Encoding Quality. When quality-based is selected as the coding type, use the slider (or
enter the value manually) to specify the image quality. Range: 0 (most compression,
lowest quality) to 100 (least compressed, highest quality).

Keyframe Settings

Episode 6.5

Figure 146. MPEG-1 Codec—Keyframe Settings
Keyframe Settings
GOP Format Long-GOP (PAL)

P-Frames Bebween I-
Frames

B-Frames Bebween P-
Frames

Force sequence header for
avery GOP

GOP Format. Select one of the predefined GOP structures, or select Custom to specify
some other GOP structure using the P-frames between |-frames and B-frames between
P-frames fields.
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GOP Type. Select Open GOP | Closed GOP. In a file using an Open GOP structure, frames
are allowed to predict data from frames outside the GOP. This provides better
compression but is not accepted by all applications and does not work well when using
MPEG-1 as an editing format. When using Closed GOP, each frame in the GOP is
independent of the frames outside of the GOP. Hence all the predictive coding is
performed inside each GOP.

P-frames Between I-frames. Use the slider (or enter the value manually) to set the
maximum number of P-frames permitted between I-frames. Range: 0 to 25.

B-frames Between P-frames. Use the slider (or enter the value manually) to set the
maximum number of B-frames permitted between P-frames. Range: 0 to 10.

Force Sequence Header for Every GOP. Check to insert a sequence header before
every GOP, a requirement when creating MPEG files for editing.
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MPEG-2 Codec

The MPEG-2 codec is similar to the MPEG-1 codec, but is more suitable for larger frame
sizes and higher bit rates. MPEG-2 is the standard format for DVDs and for digital
television.

m Bandwidth Settings

m Display Settings

m Keyframe Settings

m Advanced Options

m Closed Captioning & VBI Settings

Bandwidth Settings

Episode 6.5

Figure 147. MPEG-2 Codec—Bandwidth Settings
Bandwidth Settings

Coding Type Bitrate-Based

Bitrate Control Canstant Bit Rate (CBR)

Average Rate (kbitfs) 3000

Peak Rate (kbitfs)

Coding Type. Select from the following options:

Bit Rate-based controls bandwidth by specifying a maximum bit rate. When selected,
Encoding Quality is disabled, and other bit rate-based settings are enabled, as
appropriate.

Quality-based controls bandwidth by specifying a maximum quality. When selected,
only Encoding Quiality is enabled.

Bit Rate Control. When Bit Rate-Based is selected, select from the following options:

Constant Bit Rate (CBR) encodes the video with a constant bit rate. The VBV buffer size is
adjusted so that the output conforms to Main Profile at Main Level. If you encode the
video as I-frames only, frames are padded to reach the set bit rate. This is best suited for
high bit rates: 30 Mbs and upwards.

Video Buffering Verifier (VBV) Size uses the buffer time value in the VBV buffer size field.
The VBV buffer size controls the variation in bit rate. A larger buffer size allows bigger
variations in bit rate. For more information, see VBV Video Buffer Verifier.

Peak Rate sets the highest allowed bit rate in the clip to the value in the Peak Rate field.

Average Bit Rate. When Bit Rate-Based is selected, set the desired bit rate of the video
track. Range 16 Kbps to 300,000 Kbps.
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Peak Bit Rate. When Peak Rate is selected, specify the maximum allowed bit rate over
any one-second interval. Range: 16 Kbps to 300,000 Kbps.

Video Buffering Verifier (VBV) Buffer Size. When Video Buffering Verifier (VBV) Size is
selected, use the slider (or enter the value manually) to set the VBV buffer size. Range: 0
to 60 seconds. See VBV Video Buffer Verifier.

Two-pass Encoding. When Bit Rate-Based is selected, check to perform encoding in
two passes. In pass one, the codec analyzes the frames and collects data. In the second
pass it uses the collected data as the basis for how to best distribute the bits. Two-pass
encoding provides better output image quality but increases encoding time.

Encoding Quality. When Quality-Based is selected, use the slider (or enter the value
manually) to set the image quality for a video frame. Range: 0 (most compression,
lowest quality) to 100 (least compressed, highest quality).

Display Settings

Figure 148. MPEG-2 Codec—Display Settings

Display Aspect Ratio. Select from the following options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3| 16:9|2.21:1 causes the codec to use the specified pixel aspect ratio.
See Picture Resolution and Aspect Ratio.

Field Order. Select Top First | Bottom First | Same as Input.

Keyframe Settings

Figure 149. MPEG-2 Codec—Keyframe Settings

Keyframe Settings

GOP Format Long-GOP {PAL)

P-Frames Between I-
Frames

B-Frames Babween P-
Frames

Force sequence header for
every GOP

GOP Type

GOP Format. Select one of the predefined GOP structures, or select Custom to specify
some other GOP structure using the P-frames between |-frames and B-frames between
P-frames fields.
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P-Frames Between I-Frames. When enabled, enter the maximum number of P-frames
permitted between I-frames. Range: 0 to 25.

B-Frames Between P-Frames. When enabled, enter the maximum number of B-frames
permitted between P-frames. Range: 0 to 10.

Force Sequence Header for Every GOP. Check to insert a sequence header before
every GOP, a requirement when creating MPEG files for editing.

GOP Type. Select Open GOP | Closed GOP. In a file using an Open GOP structure, frames
are allowed to predict data from frames outside the GOP. This provides better
compression but is not accepted by all applications, and does not work well when
using MPEG-1 as an editing format. When using Closed GOP, each frame in the GOP is
independent of the frames outside of the GOP. Hence, all the predictive coding is
performed inside each GOP.

Advanced Options

Figure 150. MPEG-2 Codec—Advanced Options

Profile. When Coding Type is set to Bitrate-Based, Select Main | 422 | High. When Coding
Type is set to Quality-Based, Main is specified.

Level. Select Main | High422 | High.

Intra DC Precision. Select 8 Bits | 9 Bits | 10 Bits. The DC component of the encoded
signal determines the base level of each encoded block.

Detect Scene Changes. Check to insert keyframes (I-frames) in the stream when two
consecutive frames differ more than a given threshold.

Pulldown. Select how to set the flag which tells a player how to pull down fields in
order to display at a higher frame rate. See Video Scan. Select from the following
options:

None do not perform pulldown.

2:3(23.976/24 -> 29.97/30 FPS) | 3:2 (23.976/24 -> 29.97/30 FPS). If the frame rate is not
23.976 or 24 FPS, these setting is ignored.

Closed Captioning & VBI Settings

Episode supports writing closed captions in MPEG-2 video in MPEG Elementary,
Program, and Transport Streams. Closed captions are imported from MPEG user data in
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D-10/IMX, HDV, MPEG-2, and XDCAM HD files in the following formats: EIA-608 in ATSC
A/53 wrapping, EIA-708 in ATSC A/53 wrapping, and SCTE-20.

Figure 151. MPEG-2 codec—Closed Captioning & VBI Settings

Cosed Captioning & VBI

Closed Captioning Same as Soure v

oms oot T

Add empty VBI

e R

Closed Captioning. Select the format of the output closed captioning data:

None does not place any closed captions in the output file.

Same as Source copies any closed captions from the source to the output file.

EIA-608 places captions from the source into the output file Closed Captioning Fields.

EIA-608 + EIA-708 places both ATSC A/53-wrapped EIA-608 and EIA-708 captions from
the source into the output file.

SCTE-20 places captions from the source into the selected Closed Captioning Fields of
the output file.

This setting controls and enables only the output side of the closed captioning
capability. To pass captions from input to output, you also have to set up caption
importing from the input source files. Detecting and importing captions on the input
source requires enabling either the VBl Importer Filter or the Caption Importer Filter
described in the Video Filters chapter. The Caption Importer Filter imports embedded
608/708captions from the source media file, and the VBI Importer Filter ensures that VBI
data containing captions is passed to the output and not removed from the input.

When both EIA-608 and either VBI Importer Filter or Caption Importer Filter are
enabled, captions will be embedded in the transcoded output file if valid captions were
present in the input source file or caption file.

MPEG-2 source files containing embedded captions in the user data are an exception to
the VBI or Caption Filter requirement; these captions can be forwarded to the
transcoded output without enabling any filters as long as Closed Captioning is set to
EIA-608 in the video codec.

Closed Captioning Fields. When SCTE-20 is selected, select to indicate the fields in
which to place EIA-608 and SCTE-20 captions:

Field 1 places captions in field 1 if the source contains captions in field 1; captions in
field 2 are ignored. If there are captions in field 2 and none in field 1, the field 2 captions
are placed in field 1.

Field 1 + Field 2 places captions in the same field as they were imported from in the
source file.

Add Empty VBI. Check to pad the height of the image so that there is space for VBI
(Vertical Blanking Information) lines that can be used to store information such as time

VAT
telestream Episode 6.5



Video Codecs | 247
MPEG-2 Codec

codes, teletext, etc. Images from 480 to 511 lines high are assumed to be NTSC and are
padded up to 512 lines; images from 576 to 607 lines high are assumed to be PAL and
are padded up to 608 lines.

VBI Pad Color. When Add Empty VBI is checked, select the color of the VBI space (0| 76)
from the dropdown menu.
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MPEG-2 VOD Codec

Note: This codec is available only in Episode Pro and Episode Engine.

The MPEG-2 VOD codec uses automatic and limited encoding parameters. It cannot be
customized.

Supported input includes:
e 528 0r352x576 @ 25 FPS
e 528 0r 352 x 480 @29.97 FPS
e 1920 x 1080 @ 25 or 29.97 FPS
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MPEG-4 Codec

MPEG-4 includes many of the features of MPEG-1 and MPEG-2 and is accepted by most
video players. The role of MPEG-4 has been for the most part superseded by a codec
developed to support its subset MPEG-4 Part 10, known as H.264. MPEG-4 can be useful
if support in older players and/or platforms is required. MPEG-4 is efficient across a
wide range of bit rates, frame sizes. and frame rates.

m Bandwidth Settings
m Keyframe Settings
m Profile Settings

m Encoding Settings

Bandwidth Settings

Figure 152. MPEG-4 codec—Bandwidth Settings

Bandwidth settings

Average Rate (kbps)

Frame Skip Probability

Average Bit Rate. Specify the desired bit rate. Range: 0 to 100,000 Kbps.

Frame Skip Probability. Use the slider (or enter the value manually) to set the
probability of skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and

1.0 is most likely to cause frame skipping. See Frame Skip Probability Smooth Motion Vs.
Crisp Image.

Video Buffering Verifier (VBV) Buffer Size. Use the slider (or enter the value

manually) to set the VBV buffer size. Range: 0 to 60 seconds. See VBV Video Buffer
Verifier.

Keyframe Settings

Figure 153. MPEG-4 codec—Keyframe Settings
Keyframe settings

Keyframe Control

Keyframe Interval
{Frames)

Number of B-Frames
{Frames)

Keyframe Control. Select from the following options:
Keyframes Only creates all frames as keyframes. Requires very high video bit rate.

Forced Keyframes Only creates keyframes with the specified keyframe distance.
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Natural and Forced Keyframes creates keyframes when the encoder detects a scene
change, but also inserts a keyframe at keyframe distance from the latest keyframe. If
Keyframe distance is 0, only natural keyframes are created.

Natural Keyframes Only creates keyframes when the encoder detects a scene change.

Keyframe Interval. When creating Forced Keyframes Only or Natural and Forced
Keyframes, specify the maximum distance between keyframes. Range 0 to 200 frames.

Number of B-Frames. When Advanced Simple Profile is selected, use the slider (or enter
the value manually) to set the maximum number of B-frames permitted between P-
frames. Range: 0 to 10.

Profile Settings

Figure 154. MPEG-4 codec—Profile Settings

Advanced Simple Profile

Simple Profile Level 0 [ |

Motion Estimation

Acouracy

Display Aspect Ratio

Error Correction
Packet Length (Bits)
Use data partition

Use RVLC

Profile. Select from the following options:

Simple Profile Simple Profile (Level 0) is used in 3GPP files. Simple Profile provides the
fastest encoding and is supported by any player that supports MPEG-4. If the video bit
stream is below 64 Kbps it is tagged as level 0. If the bit stream is between 64 Kbps and
128 Kbps it is tagged as level 0B.

Advanced Simple Profile Advanced Simple Profile includes additional encoding features
but is not supported by all players.

Simple Profile Level 0. Check to encode media below 64Kbps.

Motion Estimation Accuracy. When using Advanced Simple Profile, select the active
area for looking at motion estimation. Half Pel (1/2 pixel) | Quarter Pel (1/4 pixel).

Display Aspect Ratio. Select 7:7|4:3|16:9|2.21:1.

Error Correction

Packet Length. Specify data packet length in bits. Large packets have less overhead,
but provide less error correction. Range: 0 to 163,840 bits.

Use Data Partition. Check to insert synchronization markers for better error correction.
This is useful for very low bandwidth and error-prone networks.
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Use RVLC. Check to utilize Reversible Variable Length Codes. RVLC make it possible for
the player to look back in previously-played video and check previous parts of the
image. If the current frame contains corrupt data, the codec can check with previous
frames for correction.

Note: Using RVLC increases bandwidth requirements and may result in lowered
image quality. RVLC is dependent on player support.

Encoding Settings

Episode 6.5

Figure 155. MPEG-4 codec—Encoding Settings
Encoding Settings

Two-pass Encoding. Check to perform two-pass encoding. In pass 1, the codec
analyzes the frames and collects data. In the 2nd pass it uses the collected data as the
basis for how to best compress the data. Two-pass encoding provides better output
quality but increases encoding time.

S
telestream

251



252 ‘ Video Codecs
Pass Through Option

Pass Through Option

When the Pass Through option is selected from the Video Codec dropdown menu,
Episode extracts the video stream from the input file, and passes it through untouched,
and inserts it into the output file. That is, no decoding or encoding of the video stream
occurs.

Task Name  Untitled

Max sequence number increase
Safety files

Frame rate

Encode while ingest

Encode while ingest waits{zec)

Encode while ingest number of waits
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ProRes Codec

Episode 6.5

ProRes is capable of recording full HD frame sizes at a variety of bit rates, which is useful
for a wide range of purposes from proxies to finish editing and archiving.

ProRes 422 is a full-frame 10-bit 4:2:2 video codec developed by Apple in 2007. ProRes
4444 (MacOS X only) is a 12-bit 4:4:4 video codec. It is a lossy video compression format
which supports Variable Bit Rate (VBR). Telestream does not recommend using the
ProRes 4444 encoding in a mixed-platform cluster: the job may be assigned to a
Windows node, and the job will fail.

Note: MacOS X: ProRes is distributed and installed for encoding and decoding. You
can decode ProRes directly in QuickTime, eliminating the requirement to separately
install the ProRes codec.

Windows: ProRes is provided for encode and decode operations in QuickTime. For
encode operations, you must be running on Windows Server 2008|2012 and have an
Episode Engine license.

Figure 156. ProRes Codec Settings

Version Profes 422 (HQ) v

Version. Select the version of ProRes to use:

ProRes 422 a 10-bit 4:2:2 codec developed by Apple.

ProRes 422 (HQ) video bit rate of approx. 220 mb/s at 1920 x 1080.
ProRes 422 video bit rate of approx 145 mb/s at 1920 x 1080.
ProRes 422(LT) video bit rate of approx 100 mb/s at 1920 x 1090.
ProRes 422 (Proxy) video bit rate of approx 45 mb/s at 1920 x 1080.
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QuickTime Codecs

Which QuickTime video codecs are installed on your computer depends on your
installation. For details about QuickTime codecs, you are referred to the codec
supplier’s documentation.

Figure 157. QuickTime Codec Settings

Display Aspect Ratio From Source/Resize Configuration v

Options. Click to display the QuickTime Compression Settings dialog. Choose the
codec you wish to use from the Compression Type menu and enter the settings you
want to use. For help using this dialog, click the ? icon in the bottom left corner.

Figure 158. QuickTime Compression Settings Dialog

Compression Settings

Compression type: [ MPEG-4 Viden j

Iation

Frames per second: Best -
IV Key frame every 24 frames r

Iv Limit data rate to 720 kbits/sec Download J

Encoding Mode
i

-

Compreszor

Quality

Least Low Hilgh Best

Display Aspect Ratio. Select the following options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3| 16:9|2.21:1 causes the codec to use the specified pixel aspect ratio.
See Picture Resolution and Aspect Ratio.

These options override the value set in the Resize filter (if utilized), unless From Source/
Resize Filter is selected.

Note: Episode overrides the frame rate specified in the QuickTime dialog, so you have
to explicitly use the Frame Rate Filter. If you use the hardware-accelerated Matrox
H.264 codec you should only run one such job at a time, since only one process can
use the accelerator unit at any given time.
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RGB Levels Codec

The RGB Levels codec produces video in an uncompressed video format, which is
utilized by QuickTime.

Figure 159. RGB Levels Codec Settings

Bits Per Pixel 24 v

Bits Per Pixel. Select 24 | 32 from the dropdown menu. 24 bits per pixel provides 8 bits
each for red, blue, and green. 32 bits per pixel provides additional support for an 8-bit
alpha channel.
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Targa Cine YUV Codec

Note: This codec is available only in Episode Pro and Episode Engine.

Targa Cine YUV is an uncompressed video format used with Cinewave cards. The pixel
values are stored with 4:2:2 subsampling.

There are no user-settable options.
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TGA Sequence Codec

Episode 6.5

Note: This feature is now available in both the Episode CLI and in the GUI client with
the Episode Engine license. For CLI details, see the Episode Advanced User’s Guide.

Select a sequence of TGA images as an input format for conversion to video. An alpha
channel and 24-bit graphics are supported.

Figure 160. Image Sequence Settings

F™™ Untitled

Image Sequence

Task Name  Untitled

Max sequence number increase

Safety files

Frame rate
Encode while ingest
Encode while ingest waits{zec)

Encode while ingest number of waits

Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default
value is 1, meaning that one missing number in a sequence is treated as the end of the
sequence. If set to another number, that number of sequence numbers must be
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the
sequence before processing of the file begins. This does not apply to the first file in a
sequence. This only has practical implications if Encode While Ingest is enabled. Setting
this to 0 (zero) may significantly decrease the time the encoder has to wait when the
end of the sequence is reached, but depending on file system and file format, may
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device
that produces an image sequence over time. Wait times between received files can be
specified in the following wait fields.

Encode while ingest waits (sec). Specifies the number of seconds to wait before
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to
wait for files during encode while ingest. The default is 5 times. If no files are received
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.
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Revert. Restores the Image Sequence settings to what they were before they were
changed.

Save As. Saves the Image Sequence configuration to a file.
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TIFF Sequence Codec

Episode 6.5

Note: This feature is now available in both the Episode CLI and in the GUI client with
Episode Engine license. For CLI details, see the Episode Advanced User’s Guide.

Select a sequence of TIFF images as an input format for conversion to video. 8-bit and
16-bit are supported.

Figure 161. Image Sequence Settings

F™™ Untitled

Image Sequence

Task Name  Untitled

Max sequence number increase

Safety files

Frame rate
Encode while ingest
Encode while ingest waits{zec)

Encode while ingest number of waits

Task Name. Names the task.

Max sequence number increase. Enables gaps in the sequence numbers. The default
value is 1, meaning that one missing number in a sequence is treated as the end of the
sequence. If set to another number, that number of sequence numbers must be
missing to be considered the end of a sequence.

Safety files. Controls how many files after any given file need to be present in the
sequence before processing of the file begins. This does not apply to the first file in a
sequence. This only has practical implications if Encode While Ingest is enabled. Setting
this to 0 (zero) may significantly decrease the time the encoder has to wait when the
end of the sequence is reached, but depending on file system and file format, may
result in errors. Default is 0.

Frame rate. Sets the video frame rate of the output media file.

Encode while ingest. Encodes files as they are ingested from a scanner or other device
that produces an image sequence over time. Wait times between received files can be
specified in the following wait fields.

Encode while ingest waits (sec). Specifies the number of seconds to wait before
checking for a newly arrived file during encode while ingest. The default is 5 seconds.

Encode while ingest number of waits. Specifies the maximum number of times to
wait for files during encode while ingest. The default is 5 times. If no files are received
for 5 wait times, the sequence is ended. Assuming the defaults are used, the maximum
is 5 waits times 5 seconds each for a total of 25 seconds.

Images. Lists the images selected for processing by the Image Sequence task.
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Revert. Restores the Image Sequence settings to what they were before they were
changed.

Save As. Saves the Image Sequence configuration to a file.

VAT
telestream Episode 6.5



Video Codecs | 261
VP8 Codec

VP8 Codec

The VP8 codec is an open source codec released by Google. The codec is based on VP6,
which was initially developed by On2 Technologies, and is used in WebM format.

Figure 162. VP8 Codec Settings

Bitrate (kbit/s)

Two-pass encoding
Keyframe Sattings
Minimum Keyframe Interval
Maximum Keyframe
Interval

Video Intended for:

Decoders Buffer Time
(Seconds)

Maximum Number of
Threads

Bit Rate. Enter the maximum bit rate in kbits per second.

Two-pass Encoding. Check to perform encoding in two passes. In pass one, the codec
analyzes the frames and collects data. In the second pass it uses the collected data as
the basis for how to best distribute the bits. Two-pass encoding provides better output
image quality but increases encoding time.

Keyframe Settings. Select from the following options:
Natural creates keyframes when the encoder detects a scene change.
Forced Keyframes creates keyframes with exactly the specified keyframe distance.

Minimum Keyframe Interval. When Forced Keyframes is selected, specify the minimum
distance between keyframes. Range: 0 to 50 frames.

Maximum Keyframe Interval. When Forced Keyframes is selected, specify the
maximum distance between keyframes. Range: 0 to 200 frames.

Video Intended for. Select Streaming (CBR) | Download (VBR).

Decoders Buffer Time. Use the slider (or enter the value manually to set the amount of
media the buffer holds. Range: 0 to 10 seconds.

Maximum Number of Threads. Use the slider (or enter the value manually to set the
maximum number of threads. Range: 1 to 16.
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VP9 Codec

The VP9 codec is open source software released by Google as the successor to VP8 with
improved compression to achieve a reduced bit rate while retaining the same video
quality. The codec is based on VP6, which was initially developed by On2 Technologies,
and is used in WebM format. A number of common browsers allow the VP9 codec to
play in the HTML5 video tag.

Figure 163. VP8 Codec Settings

Bitrate (kbit/s)

Two-pass encoding
Keyframe Sattings
Minimum Keyframe Interval
Maximum Keyframe
Interval

Video Intended for:

Decoders Buffer Time
(Seconds)

Maximum Number of
Threads

Bit Rate. Enter the maximum bit rate in kbits per second.

Two-pass Encoding. Check to perform encoding in two passes. In pass one, the codec
analyzes the frames and collects data. In the second pass it uses the collected data as
the basis for how to best distribute the bits. Two-pass encoding provides better output
image quality but increases encoding time.

Keyframe Settings. Select from the following options:
Natural creates keyframes when the encoder detects a scene change.
Forced Keyframes creates keyframes with exactly the specified keyframe distance.

Minimum Keyframe Interval. When Forced Keyframes is selected, specify the minimum
distance between keyframes. Range: 0 to 50 frames.

Maximum Keyframe Interval. When Forced Keyframes is selected, specify the
maximum distance between keyframes. Range: 0 to 200 frames.

Video Intended for. Select Streaming (CBR) | Download (VBR).

Decoders Buffer Time. Use the slider (or enter the value manually to set the amount of
media the buffer holds. Range: 0 to 10 seconds.

Maximum Number of Threads. (Mac only) Use the slider (or enter the value manually
to set the maximum number of threads. Range: 1 to 16.
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Figure 164. VP9 Codec Settings

Bit Rate (kbitys)

Two-pass encoding
Keyframe Settings
Minimum Keyframe Interval

Madmum Keyframe Interval

Video Intended for: Streaming (CBR)

Decoders Buffer Time 1
(Seconds)
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Windows Media Video 9 Codec

The Windows Media Video 9 codec is used in the Windows Media (WM) format, a
proprietary format playable in Windows Media Player.

m Bandwidth Settings
m Keyframe Settings
m Profile Settings

m Encoding Settings

Bandwidth Settings

Figure 165. Windows Media Video 9 Codec—Bandwidth Settings

Coding Mode Two-Pass Variable Bit Rate (VBR) Pesk W

Peak Rate (kbitfs)

Average Rate (kbitfs)

Picture Quality {96}

Coding Mode. Select from the following options:

One-Pass Constant Bit Rate (CBR) encodes video at the bit rate specified in the Average
Rate field. Quality is specified using the Picture Quality slider.

One-Pass variable Bit Rate (VBR) encodes the clip with a variable bit rate, at the quality
specified in the Smoothness/crispness slider. The encoder uses whatever bit rate
necessary to maintain the specified quality. Unlike One-pass CBR, a higher quality never
causes the encoder to skip frames, only to use a higher bit rate.

Two-Pass Constant Bit Rate (CBR) encodes the clip with constant bit rate. The encoder
analyzes the source clip in the first pass and encodes in the second pass. This setting is
bit rate-based, and has no picture quality setting.

Two-Pass Variable Bit Rate (VBR) Unconstrained encodes the clip with a variable bit rate,
constrained by the value in Average Rate. The codec analyzes the source clip in the first
pass and encodes in the second pass. This setting is bit rate-based, but has no peak bit
rate limitations.

Two-Pass Variable Bit Rate (VBR) Peak Constrained encodes the clip with a variable bit
rate, controlled by the values in Peak Rate and Average Rate. The codec analyzes the
source clip in the first pass and encodes in the second pass.

Peak Rate. When encoding Two-Pass Variable Bit Rate (VBR) Peak Constrained, Set the
maximum allowed bit rate over any one-second interval. Range: 5 Kbps to 20,000 Kbps.

Average Rate. When encoding One-Pass Constant Bit Rate (CBR), One-Pass Constant Bit
Rate (CBR), Two-Pass Variable Bit Rate (VBR) Unconstrained or Two-Pass Variable Bit Rate
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(VBR) Peak Constrained, set the desired bit rate of the video track. Range 5 to 20,000
Kbps.

Video Buffering Verifier (VBV) Buffer Size. When encoding One-Pass Constant Bit
Rate (CBR), Two-Pass Constant Bit Rate (CBR), or Two-Pass Variable Bit Rate (VBR) Peak
Constrained, use the slider (or enter the value manually) to set the VBV buffer size.
Range: 0 to 60 seconds. See VBV Video Buffer Verifier.

Picture Quality. When encoding One-Pass Constant Bit Rate (CBR) or One-Pass Variable
Bit Rate (VBR), use the slider (or enter the value manually) to set the probability of
skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and 1.0 is most
likely to cause frame skipping (see Frame Skip Probability Smooth Motion Vs. Crisp Image.
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Keyframe Settings

Figure 166. Windows Media Video 9 codec—Keyframe Settings

Keyframe Control. Select from the following options:

Natural and Forced Keyframes causes the codec choose when to insert keyframes, but
also ensures that there is at least one keyframe within the specified distance. If
Keyframe distance is set to 0, keyframes are created only when a scene change is
detected, making this the same as Natural Keyframes Only.

Natural Keyframes Only causes the codec insert keyframes when it detects scene
changes.

Keyframe Interval. Enter the maximum distance between keyframes regardless of
scene changes. With long clips that have lots of redundant data such as news clips

(talking heads), limiting the maximum distance allows the stream to recover more

rapidly if losing packets. Range: 0-60 seconds.

Number of B-frames. When using Main Profile, use the slider (or manually enter the
value) to specify the number of B-frames in a GOP (range: 0 to 7). A higher number
causes more efficient, slower encoding.

Profile Settings
Figure 167. Windows Media Video 9 Codec—Profile Settings
Profile Settings
Field Order Derive From Source v

Profile. Select from the following options:
Simple Profile is the fastest-encodable profile.

Main Profile allows additional encoding options.
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Encoding Settings

Figure 168. Windows Media Video 9 Codec—Encoding Settings
Encoding Settings

Encoding Complescity Offfine Normal v

Encoding Complexity. Select from the following options:
Live Fast | Live Normal are best for streaming video.

Offline Fast | Offline Normal | Offline Slow | Offline High Quality provide increasingly
slower, but higher quality encoding; they are better for downloadable video.
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Windows Media Video VC-1 Codec

The VC-1 Codec creates Windows Media 9 Advanced Profile CBR (Constant Bit Rate) or
VBR (Variable Bit Rate) files, either in one- or two-pass encoding.

m Bandwidth Settings
m Keyframe Settings
m Encoding Settings
m Profile Settings

Bandwidth Settings

Figure 169. VC-1 Codec—Bandwidth Settings

Coding Mode One-Pass Constant Bit Rate [CBR)

Peak Rate (kbitfs)

Average Rate (kbitfs)

Coding Mode. Select from the following options:

One-Pass Constant Bit Rate (CBR) encodes video at the bit rate specified in the Average
Rate field. Quality is specified using the Picture Quality slider.

One-Pass Variable Bit Rate (VBR) encodes the clip with a variable bit rate, at the quality
specified in the Smoothness/crispness slider. The encoder uses whatever bit rate
necessary to maintain the specified quality. Unlike One-pass CBR, a higher quality never
causes the encoder to skip frames, only to use a higher bit rate.

Two-Pass Constant Bit Rate (CBR) encodes the clip with constant bit rate. The encoder
analyzes the source clip in the first pass and encodes in the second pass. This setting is
bit rate-based, and has no picture quality setting.

Two-Pass Variable Bit Rate (VBR) Unconstrained encodes the clip with a variable bit rate,
constrained by the value in Average Rate. The codec analyzes the source clip in the first
pass and encodes in the second pass. This setting is bit rate-based, but has no peak bit
rate limitations.

Two-Pass Variable Bit Rate (VBR) Peak Constrained encodes the clip with a variable bit
rate, controlled by the values in Peak Rate and Average Rate. The codec analyzes the
source clip in the first pass and encodes in the second pass.

Peak Rate. When encoding Two-Pass Variable Bit Rate (VBR) Unconstrained or Two-Pass
Variable Bit Rate (VBR) Peak Constrained, set the maximum allowed bit rate over any one-
second interval. Range: 5 Kbps to 20,000 Kbps.
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Average Rate. When encoding One-Pass Constant Bit Rate (CBR), Two-Pass Constant Bit
Rate (CBR), Two-Pass Variable Bit Rate (VBR) Unconstrained or Two-Pass Variable Bit Rate
(VBR) Peak Constrained, set the desired bit rate of the video track. Range 5 to 20,000
Kbps.

Video Buffering Verifier (VBV) Buffer Size. When encoding One-Pass Constant Bit
Rate (CBR), Two-Pass Constant Bit Rate (CBR), or Two-Pass Variable Bit Rate (VBR) Peak
Constrained, use the slider (or enter the value manually) to set the VBV buffer size.
Range: 0 to 60 seconds. See VBV Video Buffer Verifier.

Smoothness/Crispness. When encoding One-Pass Constant Bit Rate (CBR) or One-Pass

Variable Bit Rate (VBR), use the slider (or enter the value manually) to set the probability
of skipping frames so that if the set bit rate is exceeded, 0.0 is least likely and 1.0 is most
likely to cause frame skipping. See Frame Skip Probability Smooth Motion Vs. Crisp Image.

Keyframe Settings

Figure 170. Windows Media Video VC-1 Codec—Keyframe Settings

Keyframe Control. Select from the following options:

Natural and Forced Keyframes causes the codec to choose when to insert keyframes, but
also ensures that there is at least one keyframe within the specified distance. If
Keyframe distance is set to 0, keyframes are created only when a scene change is
detected, making this the same as Natural Keyframes Only.

Natural Keyframes Only causes the codec insert keyframes when it detects scene
changes.

Keyframe Distance. Enter the maximum distance between keyframes regardless of
scene changes. With long clips that have lots of redundant data such as news clips
(talking heads), limiting the maximum distance allows the stream to recover more
rapidly if losing packets. Range: 0-60 seconds.

Number of B-frames. When using Main Profile, use the slider (or manually enter the
value) to specify the number of B-frames in a GOP (range: 0 to 7). A higher number
causes more efficient, slower encoding.

Encoding Settings
Figure 171. Windows Media Video VC-1 Codec—Encoding Settings

Encoding Settings

Encoding Complescity Offfine Normal v
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Encoding Complexity. Select from the following options:
Live Fast | Live Normal are best for streaming video.

Offline Fast | Offline Normal | Offline Slow | Offline High Quality provide increasingly
slower, but higher quality encoding; they are better for downloadable video.

Profile Settings

Figure 172. Windows Media Video VC-1 Codec—Profile Settings

Field Order. Select Derive from Source | Progressive | Top Field First | Bottom Field First.
Display Aspect Ratio. Select from the following options:

From Source/Resize Filter causes the codec to use the display aspect ratio information in
the source material or the value set in the Resize Filter if activated.

Square Pixels | 4:3|16:9|2.21:1|2.35:1 causes the codec to use the specified pixel aspect
ratio. See Picture Resolution and Aspect Ratio.

Width. Specify the width of the output frame, in pixels.
Display Aspect Ratio. Specify the height of the output frame, in pixels.
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Windows RGB Codec

Episode 6.5

Note: This codec is available only in Episode Pro and Episode Engine.

Windows RGB is an uncompressed I-frames-only format.

Figure 173. Windows RGB Codec Settings

Bits Per Pixel 24 v

Bits Per Pixel. Select 24 | 32 from the dropdown menu. 24 bits per pixel provides 8 bits

each for red, blue, and green. 32 bits per pixel provides additional support for an 8-bit
alpha channel.
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XAVC Codec

Settings

The XAVC video format was invented by Sony for use in its video cameras and
camcorders. XAVC uses level 5.2 of the H.264/MPEG-4 AVC format, supporting up to 4k
resolution (4096 x 2160) and up to 60 frames per second. Color depth can be 8-, 10-, or
12-bits, and chroma subsampling can be 4:2:0, 4:2:2, or 4:4:4. The container format is
MXF.

Figure 174. XAVC Codec Settings

XAVC Type XAVC Intra

AVC Intra Class XAVC Intra Class 100 CBG

AN Long Gop Bitate

XAVC Type. Select either the XAVC Intra type for intra-frame processing, or the XAVC
Long GOP for Group of Pictures processing. According to Sony specifications, long GOP
format at 35 to 50 Mbps is a good choice for HD when the best compromise between
small file size with high picture quality and low computational demand is required.
Intra produces high picture quality but requires a higher bitrate and more
computational power.

AVC Intra Class. If you choose Intra type above, also select the Intra Class: 50 to 480
CBG (constant bit rate) or 100 to 480 VBR (variable bitrate). VBR is supported by most
equipment and can produce higher video and audio quality. However, it can also take
more time to encode and may sometimes exceed the data rate of the connection.

AVC Long GOP Bit Rate. If you choose Long GOP above, select the bit rate, from 25 to
300 Mbps, or select Automatic to allow the rate to be set automatically.
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XDCAM HD Codec

Note: This codec is available only in Episode Pro and Episode Engine.

XDCAM HD is an MPEG-2-based codec used by Sony for High-Definition video.

Figure 175. XDCAM HD Codec Settings

Version XDCAM HD 1440:1080 (35 Mbit VBR) W

Version. Select the video profile, which is comprised of a codec, rate control, frame size,
color space, and/or bit rate.
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YCbCr Codec

Note: This codec is available only in Episode Pro and Episode Engine.

YCbCr is an uncompressed |-frames-only format. It is a transformation of RGB images
where Y is the luma (brightness) component of the image and Cb and Cr are the blue
and red chroma (color) components, respectively. For details, see Color Formats.

Figure 176. YCbCr Codec settings

Color Space 420 v

Color Space. Select from these options:
Same as Source causes the codec to use the color space in the source material.

4:2:0|4:2:2 | 4:2:2 Interleaved causes the codec to use the specified color space. 4:2:2
Interleaved format has Y, Cb, and Cr samples for each pixel stored next to each other,
and the planar formats have all Y, Cb, and Cr samples stored in separate sequences
(planes).
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This chapter describes each of the video filters in Episode:
m Advanced Frame Rate Filter
m Black and White Restoration Filter
m Burn Timecode Filter
m Caption Importer Filter
m Color Space Converter Filter
m Contrast Filter
m Deinterlace Filter
m Fade Filter
m Field Order Filter
m Frame Rate Filter
m Gamma Filter
m HSV Levels Filter
m Interlace Filter
m Matte Extractor Filter
m Noise Reduction Filter
m Resize Filter
m RGB Filter
m Rotate Filter
m Sharpen Filter
m Smoothing Filter
m Timecode Converter
m VBI Exporter Filter
m VBl Importer Filter
m Watermark Filter
m Watermark Resize Filter
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Video filters apply transformations to the video track in the source file, before it is
encoded. Activated filters are applied to your video in the order they are listed in the
Inspector panel, from top to bottom.

You select a filter to display its properties in the inspector. You activate a filter by
checking its checkbox, and de-activate it by unchecking the box. You can only alter the
properties (or method/option/section within a filter) of an active filter.

Note: Codecs encode the output after all active video filters have been applied to
your input media (as it is being decoded). In some cases, functionality in filters and
codecs is duplicated, and if enabled in both it may be unnecessary and harmless, but it
may also lead to unintended results. For example, you can enable a filter to change the
display aspect ratio. However, in some codecs, you can also chagne the aspect ratio.
Most video filters only operate on 8-bit video data. However, the Frame Rate,
Deinterlace, Advanced Frame Rate, Resize, and Interlace filters can also operate on 10-
bit data.

Some filters are used to adjust the output format, such as the Frame Rate and Resize
filters. Others are used to improve the appearance of the image, such as the Noise
Reduction filter, and the Black And White Restoration filter. Still others add information
to the output file, such as the Burn Timecode filter and Watermark filter.

You can view the effects of video filters in real time using the Preview window to
determine if you are achieving the intended effect (see Using the Preview Window).

Click the question mark icon to display online help for the filter.

Only active filters are applied to your video (as depicted in the figure following), and
they are applied frame by frame, to decoded digital baseband video in the order they
are listed in the Inspector panel, from top to bottom.
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This process and result is depicted in the figure below:

Figure 177. Video Filter Application to a Frame

Source frame

Output frame

TCG: 00:00:13:1C

In this example, the Contrast, Burn Timecode, and Watermark filters are activated (and
configured). On this frame which has just been decoded to digital baseband, first the
Contrast filter is applied, increasing the contrast (which you can see in the output
frame). Next, the Burn Timecode filter renders the current timecode onto the frame (see
output frame), and finally the Watermark filter applies the specified graphic to the
frame—notice that the watermark partially overlays the timecode.

With all the video filters applied, the digital baseband output frame is passed to the
encoder for encoding into the output stream.

Advanced Frame Rate Filter

The advanced frame rate filter performs complex frame rate conversions. (Basic frame
rate conversions are available in the Frame Rate Filter.)

Note: A frame rate change that changes the video track duration requires you to use
the Audio Speed Filter to adjust the audio track to match.
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Advanced Frame Rate Filter

Figure 178. Advanced Frame Rate Filter Settings

Filter Mode Fixed Frame Rate

Create New Frames at Rate Jg , -
{Frames Per Second) 0.001

Create New Frames By Blending Neighboring Frames
Stated Output T Spead v (Frames Per Second)
Frame Rate A

Enable advanced options

Search Block Size (Pixels)
Motion Search Length

Dampen Deviating Motion

Blur Motion Estimation
Errors

Sub-pel predsion

Filter Mode. Select the type of frame rate conversion you want to perform:

Fixed Frame Rate enables the Create New Frames field. New frames are created to match
the given frame rate.

Twice the Framerate sets the output frame rate from the filter to twice the input frame
rate. This setting is often used when you are interlacing non-interlaced content, using
the double frames to create fields in the interlace filter. This setting can optionally be
used to create slow motion material by setting the Stated output frame rate to Same as
input.

Copy Input Frames copies the source frames to the output, but a different frame rate can
be specified with the Stated output frame rate menu.

Create New Frames at Rate. When using Fixed Frame Rate, use the slider (or manually
enter) the new output frame rate. Range: 001 to 200.

Create New Frames. Select how to create new frames:

As Copy Of Nearest Neighbor copies the source frame closest in time to the desired
output frame. This is the fastest frame generation method, but may cause uneven
motion, especially in pans.

By Blending Neighboring Frames creates the output frame as a weighted average of the
two source frames closest to it in time. This provides smoother motion, but may also
cause slight blurriness.

Using Smart Motion Compensation analyzes the motion of the objects in the video to
provide both a sharp image and smooth motion. Scenes where the motion of objects is
hard to analyze may cause artifacts in the image. The algorithm searches in the most
probable direction of motion.

Using Heavy Motion Compensation searches the entire frame to find the best match for
motion. This method is very slow, but often produces in the best result.

Stated Output Frame Rate. Select the indicated output frame rate:

Same As Input sets the output frame rate from the filter to be the same as the frame rate
of the input material.
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Note: If you are using the Field Order Filter in this workflow, it may have already
changed the frame rate relative to the source frame rate.

To Keep Speed adjusts the stated output frame rate so that one second of input material
generates one second of output material.

Set To explicitly sets the desired output frame rate from the filter.
Frames Per Second. When using the Set To option, enter the frames per second.
Enable Advanced Options. Check to enable these advanced features:

Search Block Size (Pixels). Select a block size from the dropdown menu to determine
how large a search block to use in the interpolation algorithm. A larger search block
provides better data to work with but also limits the amount of motion in between
frames. Smaller-sized frames should use smaller search blocks.

Motion Search Length. Select a short, medium, or long motion search distance from
the dropdown menu. A longer search distance improves compression, but slows
transcoding.

Dampen Deviating Motion. Use the slider to determine what assumptions to make
about motion in the frames. If motion is mostly uniform in one direction, set the slider
toward more, in which case deviation motion is treated as noise and filtered away. If
motion is non-uniform and should be kept so, set the slider toward /ess.

Blur Motion Estimation Errors. Use the slider to perform a certain amount of image-
blurring to hide errors in motion estimation, from less to more.

Sub-pel Precision. Check to perform motion estimation for movements smaller than a
full pixel. This improves image quality, but slows transcoding.

Black and White Restoration Filter

Episode 6.5

Content for television (encoded from PAL or NTSC) sometimes appears washed out:
black appears dark grey and white appears as light grey. Use the black and white
restoration filter to correct this condition by setting a new black and/or white level.

Figure 179. Black and White Restoration Filter Settings

Black. Use the slider to set (or manually enter) the threshold for black. All luma values
below this are remapped to black. (Range: 0 to 255.)

White. Use the slider to set (or manually enter) the threshold for white. All luma values
above this are remapped to white. (Range: 0 to 255.)
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Burn Timecode Filter

Use the burn timecode filter to add a visible timecode to the output video. The
timecode alters the video frame, and cannot be removed later.

Figure 180. Burn Timecode Filter Settings

Position X. Select the horizontal position of the timecode burn-in location: Left | Center
| Right.

Position Y. Select the vertical position of the timecode burn-in location: Top | Center |
Bottom.

Opacity (%). Use the slider to set (or manually enter) the opacity value, making the
timecode text partially transparent. Lower values are more transparent; higher values
are more opaque. Range: 0 to 100.

Width (%). Use the slider to set (or manually enter) the timecode width as a percentage
of the image width. Range: 0 to 100.

Font. Select a font for the timecode.

Header. Enter the text prefix to display with the timecode.

Caption Importer Filter

Use the Caption Importer Filter to select and import the data from an SCC (.scc) closed
caption file or an MCC (.mcc) MacCaption or CaptionMaker file. These files will produce
EIA-608 SD or EIA-708 HD captions on the transcoded MXF, MPEG2, or H.264 (x264)
output if you enable the additional output settings explained below.

To pass the imported captions from the .scc or .mcc file through to the transcoded
output, select a Closed Captioning type in Video Encoder. See these container and
encoder descriptions for details about enabling closed captions on the transcoded
output: MXF AS-11 (.mxf), MXF Op1a (.mxf), MXF XDCAM (.mxf), MPEG-2 Codec, H.264
(MainConcept) Codec, or H.264 (x264) Codec.

These elements must be present to produce a captioned output from a caption file:
» Select an imported .scc or .mcc caption file in the Caption Importer Filter.

* Set Video Encoder Closed Captioning to Same as Source or the type of captioning
you are submitting via the .scc (608) or .mcc (708+608) file.
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Note: Because you must explicitly specify a file (and not a file pattern), you must
change the file in the filter each time you run this workflow.

Figure 181. Caption Importer Filter Settings

File Choose._.. Browse_

Click Browse and choose the .scc or .mcc file to import.

Color Space Converter Filter

Use the color space converter filter to convert video between 601 and 709 color spaces.
Additionally, color can be converted between scaled and unscaled color.

Figure 182. Color Space Converter Settings

Color Space

Input Color Space. Select Derive From Source | ITU-R Rec. 601 | ITU-R Rec. 709 to identify
the color space of your source video.

Output Color Space. Select Derive From Source | ITU-R Rec. 601 | ITU-R Rec. 709 to specify
which color space to use to encode your video.

Video Levels

Episode 6.5

Output Video Levels. Select the options for dealing with monitor vs. television output
from the dropdown menu:

Pass Through Use the same video level on your output as your input.

Clamp to Studio Range (Video Levels) Narrow full-range values (RGB 0-255) to studio
values (RGB 16-235) by clamping out-of-range values.

Stretch to Full Range (RGB Levels) Expand studio range video (RGB values 16-235) to full-
range values (RGB 0-255), in a relative manner.

Squeeze to Studio Range (Video Levels) Narrow full-range values (RGB 0-255) down to
studio values (RGB 16-235), in a relative manner.
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Contrast Filter

Use the contrast filter to make dark pixels darker and light pixels lighter. Higher positive
values increase contrast; higher negative values flatten or reduce contrast.

Video encoded from NTSC/PAL can sometimes look a bit grey or milky. Increasing the
contrast may improve the appearance.

Be careful not to increase the contrast too much—Ilighter pixels have a tendency to
become a white blur. In high contrast video, you can lower the contrast, causing the
image to become develop a flat or greyish appearance.

Figure 183. Contrast Filter Settings

Contrast (%). Use the slider to set (or manually enter) the contrast adjustment value.

Deinterlace Filter

Use the deinterlace filter to convert video from interlaced to deinterlaced (progressive).
As explained in Video Scan, a television video frame is constructed of two interlaced
fields as a pair, displayed one after the other. Because computers, mobile phones, and
other mobile devices use progressive scan, showing a whole frame at once, interlaced
video should be deinterlaced for playback on these devices.

Figure 184. Deinterlace Filter Settings
Fiedd Order Automatic Detection
Creating New Fields by [Edge Detecting Interpolation

Deinterlace Type Deintertace Interdaced Frames (Automatic)

Field Order. Select the option to determine which field is dominant.
Top Indicates that the input should be processed as top-field dominant.
Bottom Indicates that the input should be processed as bottom-field dominant.

Automatic Detection Analyzes the correct field order (recommended).

Note: If the field order filter is activated, the values set in the field order filter are used
and this setting is ignored.
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Creating New Fields by. Create each de-interlaced frame from two fields.
Duplication. Duplicates the dominant field—quicker with less lower visual quality.

Interpolation. Creates new pixels by linear interpolation of the nearest pixels in the
dominant field only; the non-dominant field is discarded. This method provides better
results than duplication, but requires more processing time.

Blending. Averages both fields to smoother motion; less sharpness than interpolation.

Smooth Blending. Averages both fields, then applies the lowpass filter to the frame.
This method provides a smoother image, but is slightly slower than blending.

Edge Detecting Interpolation. Interpolates pixels (only vertically). Edge Detecting
Interpolation attempts to find similar elements in the frame and detect edges before
interpolating. This method provides more distinct diagonal edges in the output.

Edge Detecting Interpolation Heavy. Interpolates in the same manner as edge
detecting interpolation, but with a more detailed algorithm. This method slows
encoding, but provides better results.

Motion Compensation. Analyzes the motion of objects in the video to obtain more
information on how to best create new frames. This method provides sharper output
than blending, while preserving smooth motion. Motion compensation usually
provides the best results, but may result in artifacts in scenes where motion is difficult
to estimate. This method is computationally intense, and therefore the slowest.

Note: Motion compensation requires deinterlacing of all frames, therefore the
Deinterlace Type setting is ignored when using the Motion Compensation method.

This table displays an original image, and images processed by various methods in the
deinterlace filter, to illustrate how these methods change the visual result.

Table 62. Effects of Different Deinterlacing Types on Frames

Image Description

Unprocessed interlaced frame

S

Duplication

Interpolation

VAT
Episode 6.5 telestream



284 | Video Filters
Deinterlace Filter

Table 62. Effects of Different Deinterlacing Types on Frames

Description

Blending

Smooth blending

Edge detecting interpolation

Motion compensation

333

Deinterlace Type. Select the type of deinterlacing from the dropdown menu:

Complete Deinterlace. Deinterlaces the entire frame.

Deinterlace Interlaced Frames (Automatic). Deinterlaces frames that are determined
to be interlaced. This option is suitable for media with both interlaced and progressive
frames, such as telecine media.

Deinterlace Interlaced Frames (Manual). Deinterlaces frames that are determined to
be interlaced based on the Threshold field value. This option is suitable for media with
both interlaced and progressive frames, such as telecine media.

Deinterlace Moving Areas (Automatic) deinterlaces the moving parts of each frame. This
option is not suitable for media with progressive frames, such as telecine media.

Deinterlace Moving Areas (Manual) deinterlaces the moving parts of each frame.
Deinterlacing is performed on those macroblocks where the average luminance
difference between the two frames exceeds the value in the Threshold field. This option
is not suitable for media with progressive frames, such as telecine media.

Double Frame Rate. Separates interlaced frames into two consecutive frames. This
doubles the frame rate, so it is necessary to apply the Frame Rate Filter to keep the
original speed. One application of this function is converting from HD interlaced to SD
progressive media.

Threshold. Set the threshold for when deinterlacing should occur. The value
determines how large the difference can be between the pixels of two fields before
deinterlacing. If the value is set to zero the whole frame is de-interlaced.

Deinterlace Chroma. Check to indicate that the chroma channel is interlaced in the
source material and has to be de-interlaced as well. It is not always easy to know if the
chroma channels are interlaced or not. One way to find out is to open the clip in the
Preview and step through it frame by frame.
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Table 63. Effects of Deinterlacing Luma and Chroma

Image Description

Only luma de-interlaced

Both luma and chroma de-interlaced

Note: Only apply Deinterlace to interlaced media. Otherwise, undesirable artifacts
are created. When using the Field Order filter, make sure your source media has not
been de-interlaced prior to use.

Fade Filter

Use the fade filter to fade the encoded clip in and out from/to black or white. The
number of frames are counted from the beginning of the clip for a fade in and from the
end for a fade out.

Figure 185. Fade Filter Settings

Fade In (Frames)

Fade From Color

Fade Out (Frames)

Fade to Color

Fade In (Frames). Use the slider to set (or manually enter) the number of frames over
which the clip is faded in.

Fade From Color. Select Black or White.

Fade Out Frames. Use the slider to set (or manually enter) the number of frames
(counting from the end of the clip).

Fade To Color. Select Black or White.
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Field Order Filter

Use the field order filter to change the field dominance of interlaced video. Subsequent
filters may require this field order information to operate properly.

The field order filter can both identify and modify interlacing. You can select from a list
of input video choices and then select from choices on how to modify the media.

The field order filter can both identify it and modify field order, depending on the
parameters you set.

Figure 186. Field Order Filter Settings

Input Field Order. Select the field dominance of the incoming material.

Derive from file format operates on the field order, based on the assumption that the
field order information in the source file is correct (regardless of whether it is or not).

Source has Top Field First operates on the field order, assuming the source is top field
dominant.

Source has Bottom Field First operates on the field order, assuming the source is bottom
field dominant.

Source is Progressive operates on the field order assuming the source is progressive;
disables the filter action option.

Source has unknown field order does not modify the source; subsequent filters are free
to determine the field order themselves; disables the filter action option.

Filter Action. When source is interlaced, select how to change the dominance of
interlaced material:

Same as input does not change the field dominance; disables the filter method option.
Switch to Top Field First changes the field dominance to top field dominant.
Switch to Bottom Field First changes the field dominance to bottom field dominant.

Interlaced to Progressive deinterlaces the input and creates progressive output; disables
filter method option. If you select this option, do not use the Deinterlace Filter. The
output frame rate from this filter is twice the input frame rate, so if you also use the
Frame Rate Filter or Advanced Frame Rate Filter you must take account of this.
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Filter Method. When Filter Action is set to Switch to Top Field First or Bottom Field First,
select how to change the field order. Spatial shifts reorder the fields in situ and does not
cause any problems for cuts, but loses one line of the image.

Spatial Shift Upwards moves both fields upward by one line (losing the topmost line).

Spatial Shift Downwards moves both fields downward by one line (losing the
bottommost line).

Temporal Shift moves all fields towards the beginning of the clip, dropping the first field.

Frame Rate Filter

Episode 6.5

The frame rate filter performs simple conversions of the frame rate of a clip. The
Advanced Frame Rate Filter performs more complex conversions, suitable for video
standard conversions (for example, PAL and NTSC).

A frame rate change that modifies the duration of the video requires you to use the
Audio Speed Filter to adjust the speed of any audio track to match.

Figure 187. Frame Rate Filter Settings

New Framerate (Frames 29.97

Per Second)
Change Framerate to

First Interlaced Pair

Filter Mode. Select the filter mode from the dropdown menu:

Fixed Frame Rate utilizes the New Frame rate for the output file, using the conversion
algorithm you specify in Framerate Preset.

Fractional Frame Rate specifies the resulting frame rate as the fraction of the original
frame rate you specify in Change Framerate To.

Upper limit sets a maximum frame rate that to be used if the input frame rate is higher. If
the input frame rate is lower, the input frame rate is used.

Framerate Preset. Select the filter mode from the dropdown menu:

Fast does not interpolate frames but reuses frames if needed to achieve the desired
frame rate.

Automatic analyzes PAL or NTSC source video to determine the best algorithm for the
specific conversion.

Telecine 24->29.97 | Telecine 23.976->29.97 | Inv.Telecine, Fixed Cadence 29.97->23.976 |
Inv.Telecine 29.97->24 | Inv.Telecine 29.97->23.976 | Film => PAL 24->25 | PAL => Film 25-
>24 selections perform conversion between formats and deactivates New frame rate.
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As explained in Video Scan, Episode automatically detects the cadence even when it is
broken. But, if you know that the cadence is fixed for the entire length of the clip, the
extra processing is unnecessary.

You can select, for example, Inverse Telecine, Fixed cadence 29.97->23.98 to enable
First interlaced Pair and set which frames have been derived from the first duplicated
film frame. If the first frame is a single interlaced frame, this option cannot be used.

New Framerate (FPS). Select the desired frame rate of the output video from the
dropdown menu.

AP
telestream Episode 6.5



Video Filters
Gamma Filter

Change Framerate To. When Fractional Framerate is selected in Filter Mode, select the
output frame rate as a fraction of the input frame rate from the dropdown menu.

This option simply selects from already existing frames without interpolating, and
disables Framerate Preset. 2x speeds up the frame rate—useful when converting HD
low frame rate video to SD high frame rate video, for example.

First Interlaced Pair. Select which frames have been derived from the first duplicated
film frame, from the dropdown menu.

Gamma Filter

The gamma filter is a commonly used filter, providing an important correction in many
video workflows. Gamma compensates for the color display differences between
various display technologies and devices. For example, PDAs, iPods, handheld devices
and terminals and MacOS X and Windows computers all have varying gamma.

The gamma filter is a non-linear filter. It only affects midrange tones, leaving the darkest
and lightest parts unchanged. This enables you to darken or lighten your video without
risk of distorting the darkest and brightest areas.

Figure 188. Gamma Filter Settings

Gamma. Use the slider to select (or manually enter) the gamma correction. Range: -100
to 100. Positive numbers (1 to 100) lighten the image. Negative numbers (-1 to -100)
darken the image. Larger numbers increase the effect.

HSV Levels Filter

Episode 6.5

The HSV levels filter makes color adjustments in the Hue, Saturation and Brightness
(Value) color space. This filter compliments the RGB Filter which adjusts in the Red,
Green, Blue color space.

Figure 189. HSV Levels Filter Settings

Hue. Use the slider to select (or manually enter) how to alter the colors. The value is
measured in degrees. Range: -180 degrees to +180 degrees. This is useful for correcting
badly white-balanced material, for example.

Saturation. Use the slider to select (or manually enter) how to alter the intensity of the
colors. Positive values intensify the colors, and vice versa. Range: -100% to +100%.
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Brightness (Value). Use the slider to select (or manually enter) how dark (negative
values) or bright (positive values) to make the video. It affects all pixels linearly, unlike
the Contrast Filter, which makes dark pixels become darker and bright pixels brighter.

Interlace Filter

Use the interlace filter to convert progressive input to interlaced, at half the input frame
rate.

Figure 190. Interlace Filter Settings

Fiedd Order Bottom Feld First v

Field Order. Select the field dominance that is appropriate for the output format. See
Video Scan for standard field orders for common formats.

Matte Extractor Filter

Use the matte extractor filter to extract the alpha transparency channel of the source
file and convert it to a grey-scale image, with completely opaque mapped to white and
completely transparent mapped to black.

There are no user-settable options.

Noise Reduction Filter

Use the noise reduction filter to diminish visual noise in your video. The filter employs
three methods to reduce noise in the clip:

m Median Method
m Average Method
m Temporal Method

You can use one, two, or all three methods and specify how many times each method is
to be applied.

Median Method

Use the median method when you want to replace each pixel value with the median
value of the pixels in the filter box. This improves the quality of images with impulse
noise, by mainly affecting pixels with values very different from those of their
neighbors.
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Figure 191. Noise Reduction Filter Settings—Median Method

Numnber of Runs

Radius (Pixels)

Only filker chroma

Enable. Check to use this method in the filter.
Number Of Runs. Enter the number of times to run the filter.

Radius (pixels). Use the slider to set the size of the filter box (or enter it manually).
Range:0to 7.

Only Filter Chroma. Check to filter only the color component of the material. Luma is
left unchanged. This may be useful when encoding old VHS material, since much of the
noise often resides in the chroma channel.

Average Method

Use the average method when you want to replace each pixel value with the average
value of the pixels in the filter box. This improves the quality of images with impulse
noise, by mainly affecting pixels with values very different from those of their
neighbors.

Figure 192. Noise Reduction Filter Settings—Average Method

Number of Runs

Radius (Pixels)

Threshold

Enable. Check to use this method in the filter.
Number Of Runs. Enter the number of times to run the filter.

Radius (pixels). Use the slider to set the size of the filter box (or enter it manually).
Range:0to 7.

Threshold. Set the maximum pixel difference value, beyond which the filter should not
alter the filtered pixel if the difference between the and its environment is larger than
the threshold. This preserves text and other small objects with large contrast.

Temporal Method

Use the Temporal Method when you want to compare each pixel in the current frame
with the corresponding pixel in the previous frame. If the difference is less than the
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threshold value the pixel value is left unchanged; otherwise it is replaced by the pixel
value in the previous frame. This smooths a series of frames over time.

Figure 193. Noise Reduction Filter Settings—Temporal Method

Enable. Check to use this method in the filter.

Threshold. Select the threshold level (or enter it manually) for pixel value replacement.

Resize Filter

The resize filter performs conversions on the pixel frame dimensions of a clip. In
addition to crop and pad functions, resize also has controls for frame aspect ratio, pixel
aspect ratio, and display aspect ratio.

Size Settings

Figure 194. Resize Filter—Size Settings
Size

Image Size

Width [Pixels)

Height (Pixels)

Image Proportions

Aspect Width

Aspect Height

Maintain Proportion Width Letterbox (Pad)

Image Size. Select the output frame size from the options in the dropdown menu.
Select Custom to enter specific (non-standard) values in the Width and Height fields
and enable Image Proportions.

Width. When Custom is selected in Image Size, enter the width of the resized image in
pixels.

Height. When Custom is selected in Image Size, enter the height of the resized image in
pixels.

Image Proportions. Select the aspect ratio for the image. Width and Height settings
will automatically conform to the selected aspect ratio, unless you select None
(Unconstrained), in which case, you can enter any values for Width and Height.

Aspect Width and Aspect Height. Displays the aspect ratio width and height
dimensions.
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Maintain Proportional Width. Select the options to determine how to process the
original image to achieve the output size, from the dropdown menu. This affects the
ratio between the number of pixels in the horizontal and vertical dimensions. This is
not necessarily the same as the display aspect ratio, as explained in Picture Resolution
and Aspect Ratio.

Cut keeps the image proportions of the material by cropping away parts of the image.
For example, if encoding from a source clip with a 16:9 pixel relation to a clip with 4:3
pixel relation, the sides of the source are cut, leaving the resulting image undistorted.

Letterbox (Pad) pads the image with black borders to fit the destination proportions. For
example, a 16:9 clip encoded to 4:3 is padded at the top and bottom of the image.

None (Distort) stretches the output image to the desired size. This may cause distortion.
The value in the Initial crop field (see below) is used. When coding anamorphic MPEG-2
this is the option to use. Force the source material to PAL or NTSC size with this option,
then select 16:9 display aspect ratio for playback in the MPEG-2 codec.
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Initial Crop Settings

Before the image is scaled to the new size a cropping operation is applied to the source
material. This can be used to remove black borders or edge artifacts from the source
material.

Figure 195. Resize Filter—Initial Crop Settings
Initial Crop
Top (Pixeks)

Bottom (Pixels)

Left (Pixels)

Right (Pixels)

Top. Enter the number of pixels to trim from top of frame.
Bottom. Enter the number of pixels to trim from bottom of frame.
Left. Enter the number of pixels to trim from left of frame.

Right. Enter the number of pixels to trim from right of frame.

Scaling Details

Figure 196. Resize Filter—Scaling Details Settings

Interpolation Method. Select the interpolation method to use for resizing:
Automatic uses bilinear for downsizing and bicubic for upsizing.

Bilinear usually best when downsizing the image.

Bicubic usually best when upsizing the image.

Nearest Neighbor uses the fastest method but produces the lowest quality. It should
only be used when speed is more important than quality.

Bicubic Sharpening. Use the slider (or enter the value manually) to specify the amount
of post re-size edge sharpening to apply.

Preprocessing select how to implement lowpass filtering to reduce artifacts in
downscaled images.

Nothing performs no filtering.
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Lowpass for Large Downscales filters images where the ratio between in-size and out-
size is larger than 1.7 in either the horizontal or the vertical dimension. If the ratio is
larger than 3.8 the images are filtered more.

Always Lowpass Source filters all images regardless of the amount of scaling.
Interlace Handling. Select how to handle interlaced source.

Automatic selects between Progressive Output and Scale Fields Independently based
on the available field order information.

Progressive Output scales the image as a whole with no regard to interlacing. This is the
default mode and works well in most cases.

Only Crop/Pad to Size—No Scale crops or pads the image to the new size, without
stretching the image. This option is useful when scaling to a size which is only slightly
larger or smaller in height than the source, especially if the contents are interlaced.

For example, when converting from NTSC 720 x 486 to MPEG-2 NTSC 720 x 480 you do
not need to encode all the source lines to a format that does not use all the lines. By just
cropping the unnecessary 6 lines you do not have to interpolate lines which would lose
quality.

Scale Fields Independently divides the image into two fields which are then scaled
independently. This keeps the interlacing correct when, for example, downscaling from
HD to SD material.

Aspect Ratio Settings

Episode 6.5

See Picture Resolution and Aspect Ratio for a discussion of display aspect ratios and pixel
aspect ratios.

Figure 197. Resize Filter—Aspect Ratio Settings

Aspect Ratio

Input Display Aspect Ratio  Derive From Source

Output Display Aspect Automatic
Ratio

Output Pixel Aspect Rabio .o
MOV only)

Horizontal Pixel Spacing _
Vertical Pixel Spacing _

Input Display Aspect Ratio. Select how to compensate for odd frame sizes and/or
anamorphic source material, by indicating the actual display aspect ratio of the source
data. For example, Video CD (VCD) material is usually encoded with 480 x 480 pixels,
but displayed with 640 x 480 pixels, so you should indicate an input display aspect ratio
of 4:3.

Pass Through (Keep Display Aspect Ratio) uses the display aspect ratio that results from
the settings in the Size and Initial crop fields as explained above for Maintain
Proportion With.

Derive From Source uses the display aspect ratio information in the source file, if
available. D-10/IMX, DV, MPEG-2, and MPEG-4 contain display aspect ratio information.
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For all other formats, square pixels are assumed. For example, if the source material is
480 x 480 pixels with its display aspect ratio field set to 4:3, Image size is set to 480 x 480
and Maintain proportion with is set to Letterbox (Pad), the output is 480 x 480 pixels,
but with a visible area of 480 x 360 pixels with black margins above and below.

Assume Square Pixels assumes that the source material has square pixels and that its
display aspect ratio therefore is the same as width:height.

Assume 4:3 | Assume 5:4 | Assume 16:9 | Assume 2.21:1 use the selected value for the
source display aspect ratio. This display aspect ratio is then used in the same manner as
for Derive From Source.

Output Display Aspect Ratio. Select the display aspect ratio of the output file:
Same as Input Display Aspect Ratio uses the display aspect ratio of the source file.

Automatic sets the display aspect ratio to Width:Height if Maintain Proportion With has
been set to Cut or Letterbox (Pad), otherwise uses the display aspect ratio of the source
file (i.e. assumes square pixels).

Square Pixels sets the display aspect ratio to Width:Height.
4:3|5:4|16:9|2.21:1 explicitly set the display aspect ratio.

Output Pixel Aspect Ratio (MOV only). Select the pixel aspect ratio for QuickTime
output:

Custom enables you to explicitly set the Horizontal Pixel Spacing and Vertical Pixel
Spacing. For example, a value of one in each field specifies a square, or 1:1 pixel. In 480
SD video, you may use 10 horizontal, by 11 vertical pixels. In 576 SD video, you may use
59 horizontal by 54 vertical pixels.

Automatic determines the pixel aspect ratio from the Image size and Output display
aspect ratio.

Square sets a 1:1 pixel aspect ratio.

NTSCITU-R Rec. 601 | NTSC ITU-R Rec. 601 (16:9) | PAL ITU-R Rec. 601 | PAL ITU-R Rec. 601
(16:9) sets the appropriate pixel aspect ratios for television standards.

Horizontal Pixel Spacing. When Output Aspect Ratio is set to Custom, enter an integer
value to shape the pixel as a ratio of height to width, in conjunction with the Vertical
Pixel Spacing value.

Vertical Pixel Spacing. When Output Aspect Ratio is set to Custom, enter an integer
value to shape the pixel as a ratio of height to width, in conjunction with the Horizontal
Pixel Spacing value.

RGB Filter

The RGB filter adjusts the colors in the Red Green Blue color space. For each color
channel you specify how much to add or subtract from each pixel. 100% is the maximal
value for the given color value. This contrasts with the HSV Levels Filter, which makes
color adjustments in the Hue, Saturation and Value (Brightness) color space.
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Figure 198. RGB Levels Filter Settings

Red (%). User the slider (or enter value manually) to determine what percent of this
channel to add or subtract. Range: -100% to 100%.

Green (%). User the slider (or enter the value manually) to determine what percent of
this color channel to add or subtract. Range: -100% to 100%.

Blue (%). User the slider (or enter the value manually) to determine what percent of
this channel to add or subtract. Range: -100% to 100%.

Rotate Filter

Use the rotate filter to flip frames horizontally or vertically during encoding.

Figure 199. Rotate Filter Settings

Flip operation None v

Degrees Zero v

Flip Operation. Select None | Horiziontally | Vertically to determine how each frame is
rotated.

Sharpen Filter

Use the sharpen filter to increase the contrast (or sharpen) between contrasting areas
which appear as objects in the image, thereby creating a more crisp, differentiated
appearance.

Figure 200. Sharpen Filter Settings

Strength (%). Use the slider (or manually enter the value) to set the percent of
sharpening to apply. Range: 0 to 100. Higher values provide stronger sharpening.

Smoothing Filter

Episode 6.5

Use the smoothing filter to blur and interpolate the pixels. This makes the material look
smoother (but loses some contrast).
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Figure 201. Smoothing Filter Settings

Strength (%)

Radius (Pixels)

Strength (%). Use the slider (or manually enter the value) to set the amount of
smoothing to apply. Range: 0 to 100. Higher values provide stronger smoothing.

Size (Pixels). Select the size of the smoothing area: 3x3 | 5x5.

Timecode Converter

The timecode converter filter enables Episode to carry timecode over to encoded
outputs even when complex conversions have changed the encoded outputs frame
rate. The options provided allow the user to select different methods of timecode
calculation.

The filter is used when the encode contains a frame rate altering setting such as the
frame rate filter, the advanced frame rate filter, or certain de-interlace modes.

There are several options you can choose to determine output timecode start times in
the event the new start frame is not available based on the output timebase. In every
case the hours and minutes TC values stay the same.

Figure 202. Timecode Converter Settings

Method

Allow Drop Frame <-> D
Mon-Drop Frame
COMVersion

Scale. Episode scales the output TC start frame so that it starts on the same relative
frame as the input.

For example, if the input time code is 30NDF 01:00:00:27 and the new time base is
24NDF, the output timecode start would be 01:00:00:23. (27/30)*24 (rounded off to the
nearest frame)

Round Off. Episode rounds up to the next second as a new start frame. Using the
above example, the output timecode start would be 01:00:01:00 (27 rounded up to the
next second).

Keep Count. Adds the number of frames from the input to the output time base. Using
the above example, the output timecode start would be 01:00:01:03
(01:00:00:00+01:03) (27 frames at 24NDF timebase).

Allow drop frame <-> non-drop frame conversions. This allows the conversion
between drop and nondrop timecode.
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VBI Exporter Filter

Use the VBI exporter filter to add Vertical Blanking Interval (VBI) data to the output file.

Figure 203. VBI Exporter Filter Settings

Output Vertical Blanking  Game as Detected by Vertical Blanking Inter v
Interval (VBI) Size

Manual Vertical Blanking
Interval (VBI) Size (Pixels)

Output VBI Size. Select the method to specify the VBI size from the dropdown menu:

Same as Detected by Vertical Blanking Interval Importer causes the filter to determine the
VBI size automatically, based on the size determined by the VBI Importer Filter when it
ran earlier in the job.

Manually Specify Vertical Blanking Interval Size enables you to set the size for your own
requirements, in Manual VBI Size.

Manual VBI Size. When manually specifying VBI, use the slider (or manually enter the
value) to set the VBI size in pixels. Range: 0 to 64.

VBI Importer Filter

VBI Size

Episode 6.5

Use the VBI importer filter to remove Vertical Blanking Interval (VBI) lines from video
data. If necessary, use the VBI Exporter Filter to reinstate the VBI lines in the output. You
can also use the VBI Importer Filter to extract closed captions from the input VBI for
embedding on the output (see Caption Decoding below).

Figure 204. VBI Importer Filter—VBI Size Settings

Vertical Blanking Interval (VBI) Size

Automatic Vertical
Blanking Interval (VBI) Automatically Detect Vertical Blanking Inter | %

Size.

Manual Vertical Blanking
Interval (VBI) Size (Pixels)

Automatic VBI Size. Select the method to determine the VBI size from the dropdown
menu:

Automatically Detect Vertical Blanking Interval Size causes the filter to determine the VBI
size automatically, assuming the source video is NTSC or PAL. This option removes the
32 top video lines.

Manually Specify Vertical Blanking Interval Size enables you to set the number of lines to
remove for your own requirements, in Manual VBI Size. This option assumes the source
file has a non-standard VBI size or is neither NTSC nor PAL and removes the number of
lines specified in Manual VBI Size.
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Manual VBI Size. When Manually Specify VBI Size is selected, set the number of lines to
remove from the top of the source video.

Caption Decoding

Figure 205. VBI Importer Filter—Caption Decoding Settings
Caption Decoding
Decode captions v

Closed Captioning Location pgap, o
Mode

Closed Captioning Line 28

Decode Captions. Check to import in-band closed captions from VBI data. Episode can
write these closed captions to these codecs and containers: MPEG-2 Codec, H.264 (x264)
Codec, H.264 (MainConcept) Codec, MXF AS-11 (.mxf), MXF Op1a (.mxf), and MXF XDCAM
(.mxf). Refer to those topics for details regarding the encoder output caption settings.

Closed Captioning Location Mode. Select the mode for determining the closed
captioning line.

Automatic enables the filter to determine which line closed captioning is on.

Manual allows you to specify which line to pull closed captioning from, in Closed
Captioning Line.

Closed Captioning Line. When manually specifying the Closed Captioning Location
Mode, use the slider (or manually enter the value) to specify the closed captioning line
in the VBI. Range: 0 to 64.

Watermark Filter

Use the watermark filter to apply a brand, and mark your encoded clip to ensure that
the viewers are aware of the origin of the material that they are watching.

You can use the Watermark Resize Filter to resize your watermark to better fit in the
image.

Figure 206. Watermark Filter Settings

X Offset (Pocels)

¥ Offset (Pocels)

Opacity (%)
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File. Click Browse to navigate and select the file you intend to use as watermark. The
following file formats can be used as watermarks

Table 64. Supported Watermark File Formats

File Format Details
BMP 16/24-bit RGB
JPEG EXIF metadata also supported

QuickTime MOV
Targa 16/24/32-bit RGB
TIFF 16/24/32-bit RGB

Corner. Select the corner of the frame to place the watermark in: Top Left | Top Right |
Bottom Left | Bottom Right.

Loop Type. When the file is a clip, select how the watermark is burned into video
frames from the dropdown menu. When the file is static (a single image), this option is
ignored.

Play Once select to play through the animation once and stop on the last frame.
Loop select to play the animation repeatedly in the video.

X Offset (pixels). Enter the horizontal offset from the selected corner.

Y Offset (pixels). Enter the vertical offset from the selected corner.

Opacity (%). Set the opacity of the watermark. This is not to be confused with the
transparency (alpha channel) of the image object itself.

Start time. Check the option, and use the slider (or enter the value manually) to select
the time when to start applying the watermark from the start of the clip. If not set, the
watermark is applied at the start of the clip.

End time. Check the option, and use the slider (or enter the value manually) to select
the time when to stop applying the watermark. If not set, the watermark is applied to
the end of the clip.

Watermark Resize Filter

Episode 6.5

The watermark resize filter is a sub-filter of the watermark filter. Use the watermark
resize filter to modify the size of the image that is applied to the video in the Watermark
Filter.
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Size

Figure 207. Resize Filter—Size Settings
Size

Image Size

Width (Pixels)

Height [Pixels)

Image Proportions

Aspect Width

Aspect Height

Maintain Proportion Width Letterbox (Pad)

Image Size. Select the output frame size from the options in the dropdown menu.
Select Custom to enter specific (non-standard) values in the Width and Height fields
and enable Image Proportions.

Width. When Custom is selected in Image Size, enter the width of the resized image in
pixels.

Height. When Custom is selected in Image Size, enter the height of the resized image in
pixels.

Image Proportions. Select the aspect ratio for the image. Width and Height settings
will automatically conform to the selected aspect ratio, unless you select None
(Unconstrained), in which case, you can enter any values for Width and Height.

Aspect Width and Aspect Height. Displays the aspect ratio width and height
dimensions.

Maintain Proportional Width. Select the options to determine how to process the
original image to achieve the output size, from the dropdown menu. This affects the
ratio between the number of pixels in the horizontal and vertical dimensions. This is
not necessarily the same as the display aspect ratio, as explained in Picture Resolution
and Aspect Ratio.

Cut keeps the image proportions of the material by cropping away parts of the image.
For example, if encoding from a source clip with a 16:9 pixel relation to a clip with 4:3
pixel relation, the sides of the source are cut, leaving the resulting image undistorted.

Letterbox (Pad) pads the image with black borders to fit the destination proportions. For
example, a 16:9 clip encoded to 4:3 is padded at the top and bottom of the image.

None (Distort) stretches the output image to the desired size. This may cause distortion.
The value in the Initial crop field (see below) is used. When coding anamorphic MPEG-2
this is the option to use. Force the source material to PAL or NTSC size with this option,
then select 16:9 display aspect ratio for playback in the MPEG-2 codec.
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Initial Crop

Before the image is scaled to the new size a cropping operation is applied to the source
material. This can be used to remove black borders or edge artifacts from the source
material.

Figure 208. Resize Filter—Initial Crop Settings
Initial Crop
Top (Pixeks)

Bottom (Pixels)

Left (Pixels)

Right (Pixels)

Top. Enter the number of pixels to trim from top of frame.
Bottom. Enter the number of pixels to trim from bottom of frame.
Left. Enter the number of pixels to trim from left of frame.

Right. Enter the number of pixels to trim from right of frame.

Scaling Details

Episode 6.5

Figure 209. Resize Filter—Scaling Details Settings

Interpolation Method. Select the interpolation method to use for resizing:
Automatic uses bilinear for downsizing and bicubic for upsizing.

Bilinear usually best when downsizing the image.

Bicubic usually best when upsizing the image.

Nearest Neighbor uses the fastest method but produces the lowest quality. It should
only be used when encoding speed is more important than quality.

Bicubic Sharpening. Use the slider (or enter the value manually) to enhance object
edges in the image.

Preprocessing. Select how to implement lowpass filtering to reduce artifacts in
downscaled images.

Nothing performs no filtering.

o~
telestream



304 | Video Filters

Watermark Resize Filter

Lowpass for Large Downscales filters images where the ratio between in-size and out-
size is larger than 1.7 in either the horizontal or the vertical dimension. If the ratio is
larger than 3.8 the images are filtered more.

Always Lowpass Source filters all images regardless of the amount of scaling.
Interlace Handling. Select how to handle interlaced source.

Automatic selects between Progressive Output and Scale Fields Independently based
on the available field order information.

Progressive Output scales the image as a whole with no regard to interlacing. This is the
default mode and works well in most cases.

Only Crop/Pad to Size—No Scale crops or pads the image to the new size, without
stretching the image. This option is useful when scaling to a size which is only slightly
larger or smaller in height than the source, especially if the contents are interlaced.

For example, when converting from NTSC 720 x 486 to MPEG-2 NTSC 720 x 480 you do
not need to encode all the source lines to a format that does not use all the lines. By just
cropping the unnecessary 6 lines you do not have to interpolate lines which would lose
quality.

Scale Fields Independently divides the image into two fields which are then scaled
independently. This keeps the interlacing correct when, for example, downscaling from
HD to SD material.

Black Level. Sets video black level from 0 (super black) to 16 (7.5 IRE setup).

Aspect Ratio

See Picture Resolution and Aspect Ratio for a discussion of display aspect ratios and pixel
aspect ratios.

Figure 210. Resize Filter—Aspect Ratio Settings

Aspect Ratio

Input Display Aspect Ratio  Desive From Source

Output Display Aspect Automatic
Ratio

Output Pixel Aspect Rabio .o
MOV only)

Horizontal Pixel Spacing -
Vertical Pixel Spacing -

Input Display Aspect Ratio. Select how to compensate for odd frame sizes and/or
anamorphic source material, by indicating the source data actual display aspect ratio.
For example, since Video CD (VCD) material is usually encoded with 480 x 480 pixels,
but displayed with 640 x 480 pixels, indicate an input display aspect ratio of 4:3.

Pass Through (Keep Display Aspect Ratio) uses the display aspect ratio that results from
the settings in the Size and Initial crop fields as explained above for Maintain
Proportion With.
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Derive From Source uses the display aspect ratio information in the source file, if
available. D-10/IMX, DV, MPEG-2, and MPEG-4 contain display aspect ratio information.
For all other formats, square pixels are assumed. For example, if the source material is
480 x 480 pixels with its display aspect ratio field set to 4:3, Image size is set to 480 x 480
and Maintain proportion with is set to Letterbox (Pad), the output is 480 x 480 pixels,
but with a visible area of 480 x 360 pixels with black margins above and below.

Assume Square Pixels assumes that the source material has square pixels and that its
display aspect ratio therefore is width = height.

Assume 4:3 | Assume 5:4 | Assume 16:9 | Assume 2.21:1 use the selected value for the
source display aspect ratio. This display aspect ratio is then used in the same manner as
for Derive From Source.

Output Display Aspect Ratio. Select the display aspect ratio of the output file:
Same as Input Display Aspect Ratio uses the display aspect ratio of the source file.

Automatic sets the display aspect ratio to Width:Height if Maintain Proportion With has
been set to Cut or Letterbox (Pad), otherwise uses the display aspect ratio of the source
file (i.e. assumes square pixels).

Square Pixels sets the display aspect ratio to Width = Height.
4:3|5:4]16:9|2.21:1 explicitly sets the display aspect ratio.

Output Pixel Aspect Ratio (MOV only). Select the pixel aspect ratio for QuickTime
output:

Custom enables you to explicitly set the Horizontal Pixel Spacing and Vertical Pixel
Spacing. For example, a value of one in each field specifies a square, or 1:1 pixel. In 480
SD video, you may use 10 horizontal, by 11 vertical pixels. In 576 SD video, you may use
59 horizontal by 54 vertical pixels.

Automatic determines the pixel aspect ratio from the Image size and Output display
aspect ratio.

Square sets a 1:1 pixel aspect ratio.

NTSCITU-R Rec. 601 | NTSC ITU-R Rec. 601 (16:9) | PAL ITU-R Rec. 601 | PAL ITU-R Rec. 601
(16:9) sets the appropriate pixel aspect ratios for television standards.

Horizontal Pixel Spacing. When Output Aspect Ratio is set to Custom, enter an integer
value to shape the pixel as a ratio of height to width, in conjunction with the Vertical
Pixel Spacing value.

Vertical Pixel Spacing. When Output Aspect Ratio is set to Custom, enter an integer
value to shape the pixel as a ratio of height to width, in conjunction with the Horizontal
Pixel Spacing value.
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Audio Codecs

This chapter describes each of the audio codecs provided in Episode, including a
description of each user-configurable parameter.

Note: See Media Containers/Formats for a table of formats and supported codecs.

Some codecs require an Episode Pro or Episode Engine license, as indicated.
m AAC Codec
m AAC QuickTime Codec
m AES Codec
m AMR Codec
m AC-3 (ATSC A/52) Codec
m BWF Codec
m Discard Option
m DV Audio Codec
m Lame MP3 Codec
m MPEG Audio Codec
m Pass-through Option
m PCM Audio Codec
m QuickTime Audio Codecs
m Vorbis Codec
m Windows Media Audio 9 Codec

AAC Codec

Note: This codec is available only with the Pro Audio Option option. Episode’s Pro
Audio Option uses the Dolby AAC encoder, providing higher audio quality, in
particular for low bit rates.

S
telestream



308 | Audio Codecs
AAC Codec

You can also encode AAC without the Pro Audio Option, using the AAC QuickTime
Codec.

AAC (Advanced Audio Coding) is one of two audio codecs specified in the 3GPP
standard (the other is AMR). AAC is an excellent audio codec for music.

High Efficiency AAC HE-AAC, also known as aacPlus, is an extension of the AAC file
format using two new coding techniques: Spectral Band Replication (SBR) and
Parametric Stereo. HE-AAC is only partly backwards compatible, as playback of HE-AAC
files on AAC decoders is possible, but high frequencies are not reconstructed, and only
mono playback is performed, even if Parametric Stereo is used.

In High Efficiency mode, Spectral Band Replication is always used. SBR is a technique
which copies the lower half of the audio frequencies to the higher half. A small amount
of control data (about 2-4 Kbps) is added to make sure the reconstruction of the high
frequencies are correct, or at least perceived to be correct. By doing so, the AAC
encoder only has to encode the lower half of the spectrum, which enables encoding at
lower bit rates. SBR is recommended for source files with sample rates of 32 kHz or
higher, and target bit rates of 20-80 Kbps'. (At higher bit rates, reqular AAC yields
higher sound quality.)

Figure 211. AAC Codec Settings

Bit Rate. Select the output bit rate based on your input sample rate, determined by the
table below. The bit rate and sample rate should be matched according to the
following table.

1. Martin Dietz and Stefan Meltzer. CT-aacPlus—a state-of-the-art audio coding system. EBU Technical Review, July

2002
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Table 65. AAC Bit Rate and Sample Rates
Bit Rate (Kbps) Mono Sample Rate (kHz) Stereo Sample Rate (kHz)
8 8-12 Mono only
16 8-24 8-12
20 11-24 8-12
24 11-32 11-24
28 11-32 11-24
32 11-48 11-24
40 16-48 16-32
48 22-48 22-32
56 22-48 22-48
64 32-48 32-48

Mono sound is supported in the range 8-160 Kbps, 2-channel stereo sound in the range
16-320 Kbps, surround sound in the range 160-640 Kbps, and 7.1channel surround
sound in the range 224-640 Kbps.

AAC Mode. Select Low Complexity | High Efficiency.

Keep Codec Delay. Check to enable codec delay. By design, AAC players skip a
segment of data at the start of a file. This can be compensated by inserting empty data
at the beginning—codec delay. This option should normally be enabled, but if your
target player does not handle this well (your audio plays out of synch), test by encoding
with Keep Codec Delay unchecked.

Parametric Stereo. When AAC Mode is set to High Efficiency, check to enable
parametric stereo, an extension to SBR, which encodes stereo information in a very
compact way (about 1-3 kb/s). The source file is converted to mono and encoded to
AAC. Depending on the source material, parametric stereo can sometimes improve
audio quality at very low bit rates. PS is only available for bit rates up to 56 kb/s. As the
name implies, PS can only be applied to stereo source files. HE-AAC with PS is also
known as EAAC+.

The bit rate and sample rate have to be matched, according to Table 65, AAC Bit Rate
and Sample Rates.

Mono sound is supported in the range 8-160 Kbps, 2-channel stereo sound in the range
16-320 Kbps, surround sound in the range 160-640 Kbps, 7.1 surround sound in the
range 224-640 Kbps.
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AAC QuickTime Codec

AAC (Advanced Audio Coding) is one of two audio codecs specified in the 3GPP
standard (the other is AMR). AAC is an excellent audio codec for music.

Without the Pro Audio Option, Episode uses QuickTime for AAC encoding.

Figure 212. AAC QuickTime Codec Settings

Eit Rate 128 khitfs v

Bit Rate. Select the output bit rate from the dropdown menu.

AES Codec

Note: This codec is available only in Episode Pro and Episode Engine.

The AES codec was designed by the Audio Engineering Society for serial digital
transmission of stereo sound. Episode uses the SMPTE331M version.

Figure 213. AES Codec Settings

Bit Depth 16 bix v

Bit Depth. Select 76 bit | 24 bit from the dropdown menu.

AMR Codec

Note: This codec is available only with the Pro Audio Option option.

AMR is designed for use in cellular phones and mandatory in the 3GPP standard. It is a
speech codec that produces extremely low bit rates but does not work well for music.

Figure 214. AMR Codec Settings

Mode 12.2 kbitfs (Mode 7) v

SID

Mode. Select one of the following options—mode 0 through mode 7: 4.75 Kbps (mode
0) | 5.15 Kbits/s (mode 1) | 5.90Kbits/s (mode 2) | 6.70 Kbps (mode 3) | 7.40 Kbps (mode4) |
7.95 Kbps (mode 5) | 10.2 Kbps (mode 6) | 12.2 Kbps (mode 7).

SID. Check to use the Silence Descriptor to send less data during silent passages in the
audio track. Not all players support the SID option.
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AC-3 (ATSCA/52) Codec

AC-3 (ATSC A/52) is used on DVDs and is a leading format in movie theatres.

Figure 215. AC-3 (ATSC A/52) Settings

Dialog Normalization (dB)  -25

DVB Style PMT Descriptor

Bit Rate. Select the output bit rate from the dropdown menu. Range: 64 to 640 kbps.

Note: Only bit rates above 80 Kbps can be encoded as stereo or surround sound.
Recommended bit rates for encoding without audible artifacts are 192 Kbps for stereo
and 448 Kbps for 5.1 surround sound.

Dialog Normalization. Use the slider to select (or manually enter the value) to set the
average audio level so that media players can adjust the gain.

When combining material from different sources, ensure that the audio levels are
normalized across sources. Typically the audio level of speech is considered as the base
level. Set the value the average dialogue level in dB of full scale in the source material as
indicated by your editor.

A value of -31 is defined as a unit gain. For example, 0 dB attenuation, -1 =30 dB
attenuation.

Note: Setting the level does not modify audio content. It provides a gain value for the
media player. If you need to adjust the audio levels within the track, use the Volume
Filter.

DVB Style PMT Descriptor. Select for European System B standard audio coding for
terrestrial broadcasting according to the ITU-R BS.1196-1 recommendation.

BWF Codec

Episode 6.5

The Broadcast Wave Format is based on the WAV format, extended with metadata
fields.

Figure 216. BWF Codec Settings

Bit Depth 16 Bit v

Bit Depth. Select 76 bit | 24 bit from the dropdown menu.
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Discard Option

When the Discard option is selected from the Audio Codec dropdown menu, Episode
does not decode the audio or pass it to the encoder. Thus, there is no audio stream in
the output.

DV Audio Codec

DV Audio settings are dictated by the DV video settings.

Figure 217. DV Audio Codec Settings

Bit Depth 16 Bit v

Sample Size. Select 12 bit | 16 bit from the dropdown menu.

Lame MP3 Codec

MPEG-1 Layer Ill audio is popularly known as MP3. The Lame codec is one of the most
extensively used implementations—see lame.sourceforge.net.

Figure 218. LAME MP3 Codec Settings

Minimum Variable Bit Rate
{VER) Bitrate

Maximum Variable Bit Rate
(VBR) Bitrate

Stereo Mode

Copyright flag

Original flag

Lame tag

Error protection

Encoding Type. Select from these options:
Bit Rate Based. Sets the average bit rate of the data and make other adjustments.

Lame Preset. Enables the Preset menu. Choose one of the options in the Preset menu,
which sets all parameters to predefined values.

Preset. When encoding is set to Lame Preset, choose one of these options to set all
parameters to predefined values.
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R3Mix is a legacy setting used at http://www.r3mix.net/. It provides slightly better
quality than the Medium setting.

Medium is an acceptable audio quality for most uses.

Medium Fast is a faster algorithm than Medium, but should give almost as good audio
quality.

Standard is a good audio quality for normal use.

Fast Standard is a faster algorithm than Standard, but should give almost as good audio
quality.

Extreme is the best audio quality for high-quality equipment.

Fast Extreme is a faster algorithm than Extreme but usually provides almost as good
audio quality.

Insane is the absolutely best audio quality, requiring very high bandwidth.

Bit Rate. When encoding is set to Bit Rate Based, select the bit rate from the dropdown
menu. Range: 16 to 320 kbit/s.

Setting Type. Select from these options:

Standard Settings use suitable default settings for your chosen bit rate. and disable all
advanced settings in this codec.

Advanced Settings enable all advanced settings and allow you to adjust the following
parameters:

Quality. Use the slider (or manually enter the value) to set the quality of the encoding.
Better quality implies slower algorithms. Range: 0 (Best) to 9 (Worst), in Lame parlance.

Mode. Select Constant Bit Rate (CBR) | Variable Bit Rate (VBR).

Minimum VBR Bit Rate. When VBR is selected, select the minimum bit rate from the
dropdown menu.

Maximum VBR Bit Rate. When VBR is selected, select the maximum bit rate from the
dropdown menu.

Stereo Mode. Select from these options:
Stereo encodes each stereo channel separately.

MS Stereo Uses mid/side encoding, where the shared content of the stereo channels are
coded in higher resolution than the difference between them; this decreases the
bandwidth requirements for low bit rates (< 128 Kbps) and small stereo separations.

Joint Stereo decides, frame by frame, whether to use separated stereo or MS stereo.
Copyright Flag. Check to tag the material as copyrighted.

Original Flag. Check to tag the material as original, When unchecked, the material is
tagged as a copy.
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Lame Tag. Check to write metadata on the encoding to the output. The Lame tag is
backwards compatible with the Xing header.

Error Protection. Check to activate CRC error protection. This allows reconstruction of
lost packets, but requires slightly more bandwidth to encode the error protection data.

MPEG Audio Codec

The MPEG-1 standard defines three layers of audio encoding (ISO11172-3).The first two
layers, sometimes known as MP1 and MP2, are encoded with this codec. Layer Ill, MP3,
is encoded with the Lame encoder. See MP3 (.mp3).

An accessible introduction to MPEG audio encoding is provided in an MPEG tutorial by
Davis Pan'.

Figure 219. MPEG Audio Codec Settings

Bit Rate. Select the bit rate from the dropdown menu.

Note: Not all bit rates are available for both layers.

Layer. Select from these options:
Layer I uses a simpler encoding method that works best for higher bit rates.
Layer Il uses a more complex encoding method that compresses better.

Psycho model. The psycho-acoustic model is used to determine the features of the
sound that are inaudible and therefore can be compressed away. Select from these
options:

Model uses a simpler model which provides slightly lower quality results for less
computation.

Model 2 uses a model that requires more computation but provides better results.

The setting of the Sample Rate Filter determines the sample rates. Rates from 16 to 24
kHz are encoded as MPEG-2 audio, sample rates from 32 to 48 kHz are encoded as
MPEG-1.

Pass-through Option

When the Pass-through option is selected from the Audio Codec dropdown menu,
Episode extracts the audio stream from the input file, and passes it through untouched,

1. Davis Pan. A tutorial on MPEG/audio compression. IEEE Multimedia, 2(2):60—74, Summer 1995.
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and inserts it into the output file. That is, no decoding or encoding of the audio stream
occurs.

PCM Audio Codec

PCM is an uncompressed audio format.

Figure 220. PCM Audio Codec Settings

PCM Format 16 Bit Big Endian Integer v

Split channels in output Mo v

PCM Format. Select the PCM encoding format from the dropdown menu.

Note: Not all container formats support all forms of PCM encoding. The selected
encoding may be quietly converted into another encoding supported by the selected
output format.

Split Channels In Output. Select from the drop-down menu to place stereo and
surround sound channels in separate audio tracks. This applies only when producing
QuickTime (mov) files. For all other formats the setting is ignored.

No - Outputs audio with 7.1 labels
Yes - Outputs audio as discrete channels without labels (channel positions).

Yes, and flag as discrete - Outputs as discrete channels with labels (channel positions) as
Discrete- x where x is 0 to 7 (that is, Discrete-0, Discrete-1... Discrete-7).

Note: The Split Channels in Output feature should not be used with the Channel or
Channel Mapper audio filters.

QuickTime Audio Codecs

Episode 6.5

Which QuickTime codecs are installed on your computer depends on your installation.
For information on codecs you have installed, refer to the codec suppliers’
documentation.

Figure 221. QuickTime Audio Codec Settings

Options. Click to display the QuickTime codec dialog. Choose the codec from the
Format menu and modify the settings as appropriate. For help on this dialog, click the ?
icon in the bottom left corner.
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Figure 222. QuickTime Sound Settings dialog

Sound Settings

Format: |Linear PCM j
Channels: |Stereo (LR} j
Rate: | 44.100 j kHz

r

Render Settings:

Quality: | Mormal j

Linear PCM Settings:

Sample size: |16 | bits
v Little Endian
-
-
-
[o]4 | Cancel

Vorbis Codec

Vorbis is a free audio codec for lossy compression (Vorbis-I).

Figure 223. Vorbis Codec Settings
Enceding Type

Quality (%)
Bitrate (kbit/s)

Maximum Bitrate (kbit/s)

Minimum Bitrate (kbit/s)

Encoding Type. Select from the following options:

Bit Rate Based. Uses the average rate over the period set by the values specified in Bit
Rate, Max. Bit Rate, and Min. Bit Rate fields.

Quality based uses the value set in the Quality field.

Quality. When using quality-based encoding, use the slider (or enter the value
manually) to specify the audio quality as a percent, from 0 (most compression, lowest
quality) to 100 (least compressed, highest quality). A lower quality setting requires less
bandwidth, but lowers the quality of sound reproduction.

Bit Rate. When using bit rate-based encoding, use the slider (or enter the value
manually) to specify the target bit rate for the audio. The codec generates the best
audio quality possible for this bit rate.
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Max Bit Rate. When using bit rate-based encoding, use the slider (or enter the value
manually) to specify the maximum allowed bit rate.

Min Bit Rate. When using bit rate-based encoding, use the slider (or enter the value
manually) to specify the minimum allowed bit rate.

Windows Media Audio 9 Codec

Episode 6.5

Windows Media Audio 9 is an audio data compression technology developed by
Microsoft. It is a proprietary technology that forms part of the Windows Media
framework.

The original WMA codec, known simply as WMA, was conceived as a competitor to the
popular MP3 and RealAudio codecs. WMA Pro, a newer and more advanced codec,
supports multichannel and high resolution audio. WMA Lossless compresses audio
data without loss of audio fidelity (the regular WMA format is not lossless). WMA Voice,
targeted at voice content, applies compression using a range of low bit rates. Episode
does not support encoding in WMA Voice.

Figure 224. WMA9 Codec Settings

Windows Media Audio Windows Media Audio (WMA) 9 Sanda v
{WMA) Version

Method One-Pass, Constant Bt Rate (CER) W

Settings: Standard, One pass, CBR, 5 kbps, 8.0} W

Windows Media Audio Version. Select from the following options:

Windows Media Audio 9 Standard encodes the audio in WMA 9 Standard format. WMA 9
Standard supports One Pass, Constant Bit Rate (CBR) and One Pass, Variable Bit Rate (VBR)
encoding methods.

Windows Media Audio 9 Professional encodes the audio in WMA 9 Professional format.
WMA 9 Professional supports multiple channels, at sample rates above 48 kHz and
wider than 16 bit samples. However, it is often not available on lower-end platforms,
such as mobile phones. WMA 9 Professional supports One Pass, Constant Bit Rate (CBR)
and One Pass, Variable Bit Rate (VBR) encoding methods.

Windows Media Audio 9 Lossless encodes the audio as uncompressed, thus preserving
all of the original content. The final bit rate is dependent on the source. WMA 9 Lossless
supports One Pass, Variable Bit Rate (VBR) encoding.

Coding Method select One Pass, Constant Bit Rate (CBR) | One Pass, Variable Bit Rate (VBR).

Configuration Settings. Choose a profile, consisting of fixed combinations of audio
quality, bit rate, bit depth and sampling frequency.
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Audio Filters

This chapter describes each of the audio filters in Episode.
m Audio Speed Filter
m Balance Filter
m Channels and Channel Mapper Filters
m Channels Filter
m Equalizer Filter
m Fade Filter
m High Pass/Low Pass Filter
m Offset Filter
m Sample Rate Filter
m Volume Filter

m Appendix: Default Channel Maps

Audio filters apply transformations to the audio track(s) in the source file, before it is
encoded. Activated filters are applied to your audio in the order they are listed in the
Inspector panel, from top to bottom.

You select a filter to display its properties in the inspector. You activate a filter by
checking its checkbox, and de-activate it by unchecking the box. You can only alter the
values of an active filter.

Note: Codecs encode the output after audio filters have been applied to your input
media (as it is being decoded). Thus, if you set the channels filter to mono and your
codec is set to produce stereo, the audio track is first folded into mono, and this mono
track is then replicated to make two stereo tracks—probably not the result you
intended.

Click the question mark to display online help for the filter.
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Audio Filters are Applied Sequentially

Only activated filters are applied to your audio, and they are applied in the order they
are listed in the Inspector panel, from top to bottom.

This process is depicted in the figure below:

Figure 225. Audio Filter Application to Audio Stream

"

In this example, the High Pass, Low Pass, and Volume filters are activated (and
configured). First the High Pass filter is applied, knocking the high points off the audio.
Next, the Low Pass filter knocks the low points off. Finally the Volume filter increases the
overall volume of the altered audio stream.

With all the audio filters applied, the audio stream is passed to the encoder for
encoding into the output stream.

Audio Speed Filter

Use the audio speed filter to adjust the speed of the audio track to match the video
frame rate. In some cases, transcoding—decoding and encoding—may speed up or
slow down the video speed (see Frame Rate Filter and Advanced Frame Rate Filter).

Figure 226. Audio Speed Filter Settings

Speed Change To Match 24 = 25 fps Spead Up v

Custom Speed (Times
Original

Speed Change. Select a predefined speed conversion, or select Custom to specify a
conversion rate not predefined.

Custom Speed (times original). When Custom is selected, enter a real number or
integer multiplier for the speed change. Use negative values to slow the audio.

Balance Filter

Use the balance filter to increase or attenuate the volume of one side of stereo audio
over the other, to improve balance.
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Figure 227. Balance Filter Settings

Panning (%) [ : :
Left  Center  Right

Panning. Use the slider (or set the value manually) to set the stereo panning towards
the left or right audio channel, thus raising the volume of one pair over the other as
specified, to improve balance. Range: -100 to 100.

The results of panning surround sound are undefined.

Channels and Channel Mapper Filters

Episode automatically maps audio channels from source to output during encoding
according to the settings of the audio Channels filter and the audio Channel Mapper
filter. The Channels filter lets you select a standard input format and map it to a
standard output format. Generally, this is all you need to do, and you can ignore the
Channel Mapper, which is used only if you need to set up custom mapping.

Channels Filter

Episode 6.5

The Channels filter makes it easy to map standard input audio formats directly to
standard output audio formats without setting up individual channels. Formats such as
Stereo, 5.1, and 7.1 are already mapped for you and are available under the Input
Channel Layout (input) and Mix To (output) drop-down menus.
To map input audio to output audio, follow these simple steps:

1. Assign an encoder to the workflow Encoder task, if you have not already done so.

2. In the Inspector, select Audio, check the Channels box, and click Channels to open
the Channels menus.

3. Select an input audio format using the Input Channel Layout drop-down menu.

Auto detect is usually the best choice if the input is a standard audio format. Episode
detects the format automatically by examining the actual audio stream.

4. Select an output audio format from the Mix To drop-down menu.
That’s all there is to setting up audio channel mapping in most cases. Episode “knows”
all of the audio encoder formats and automatically maps the correct input channels to

the correct output channels. In most cases, if any input channels cannot be mapped to
output channels, mapping fails and an error message indicates the cause.
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Figure 228. Channels Filter Settings

V' 4} Channels ?

1)) Channel Mapper

Input Channel Layout Auto detect

Mix To Sterao

Input Channel Layout. Select Auto detect to let Episode automatically discover the
source audio format by examining incoming audio, or select an input audio format:
Auto detect | Mono | Stereo | Dual Stereo | 5.0 | 5.1 | Triple Stereo | 7.1 | 5.1 + Stereo | Quad
Stereo | Discrete channels.

Mix to. Select an audio output format from the dropdown menu: Mono | Stereo | Dual
Stereo | 5.0 | 5.1 | Triple Stereo | 7.1 | 5.1 + Stereo | Quad Stereo | Discrete channels. Not all
selections are available for all codecs.

Under the Hood of the Channels Filter

Audio mapping can be confusing with so many different formats in the audio world. A
brief discussion of Episode audio mapping “under the hood” may make this topic easier
to understand.

Episode is a batch encoding system, not a one-shot conversion application. Its purpose
is to allow users to set up the audio conversion in a workflow one time and then forget
it. The audio mapping in the workflow should “just work” every time.

Even though different input formats have different channel orders, all different input
orders are transformed within Episode into a single internal format which is the same as
AAC. That way the encoder always knows exactly what it's getting. When processing is
complete, the audio channels are mapped back to each encoder’s native format.

Thus, no matter what your input format (such as PCM, AAC, or AC-3) and no matter
what your target format, Episode handles the conversion automatically—no channel-
altering filters are needed. You simply set the Channel filter to auto detect or specify the
input format and set the output format, and Episode handles the conversion and
channel mapping automatically.

Note: Multiple track output is currently only supported by the PCM, AES and BWF
audio codecs. If you choose a different codec, only the first track will be used. For
example, if you choose 5.1 + Stereo in AAC, only a 5.1 track will be created.

For a complete listing of the default Channels filter mappings, please see Appendix:
Default Channel Maps at the end of this chapter. For those who understand audio
channel mapping, a quick look at the map list will tell you whether you can use the
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default Channels filter map or you must create your own map using the Channel
Mapper filter.

Channel Mapper Filter

Generally, you should not have to use the Channel Mapper filter, since the Channel filter
includes virtually all the audio formats you need, enabling automatic conversion and
mapping from any standard input format to any standard output format. However, you
may have workflows where you want to alter the channel mapping in a non-standard
way. That is the purpose of the Channel Mapper filter. It allows you to map each input
channel to each output channel and track.

CAUTION: Unless you must map custom channels, Telestream recommends that you
use the Channels filter to map one audio standard to another, eliminating the need for
individual channel mapping. If you choose to use the Channel Mapper filter instead,
you must manually map each channel. Channels that are not mapped are lost. Also, it
is recommended that you do not combine the Channel Mapper filter with the Channels
filter; use one or the other but not both.

To create mappings for audio channels, follow these steps:
1. Assign an encoder to the workflow Encoder task, if you have not already done so.

2. In the Inspector, select Audio, check the Channel Mapper box, and click Channel
Mapper to open the Channel Mapper menus.

3. Select the number of inputs from the Input Channels drop-down menu.

The standard channel assignments for the number of channels you select is dis-
played. If your input channels do not match these standard 7.1 channel assign-
ments, map them to the outputs according to their actual functions and your
desired output configuration.

4. Select the number of output channels per track from the Output Channels Per Track
drop-down menu.

5. Select the number of output tracks from the Output Tracks drop-down menu.

6. Click +/Add Mapping to add as many mappings as the number of input channels
you want to map. For eight audio inputs, add eight mappings.

7. For each mapping, select the input channel you want to map. Typically, for 8
channels, your input selections will be 1-8.

8. For each input channel, select the output channel and track to which you want the
input mapped.
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Figure 229. Channel Mapper Filter Settings
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Channel order for 8 channels: C, L R, Ls, Rs, Lsd, Rsd, LFE

Input Channels/Output Channels/Output Tracks. Select the number of input and
output channels and output tracks you intend to map. If the source has more channels
than specified, additional channels are ignored; if the source has fewer channels than

specified, only the ones actually mapped are used.

Add Mapping. Each click adds another channel mapping. For eight channels, click this

button until 8 mappings are added, and then map each channel.

Delete Mapping (X). Click to delete the selected channel map.

Channel In/Channel Out/Track Out. Select the input channel number and then select

the output channel number and track to which you want the input mapped.
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Equalizer Filter

Use the equalizer filter to boost or cut each frequency band individually. The Equalizer
Filter is a set of five filters, each with a fixed center frequency that cannot be changed.

Figure 230. Equalizer Filter Settings

0.1 kiHz (dB)

0.3 kiHz (dB)

1.0 kiz (dB)

3.0 kiHz (dB)

10 kHz (dB)

Frequency Band (dB). Use the slider (or enter the value manually) to control the
amount of boost (peak) or cut (notch) in each frequency band: 0.1, 0.3, 1.0, 3.0, and 10
kHz. Range: -12 to 12.

Fade Filter

Use the fade filter to fade the audio in or out in the output file, up to 10 seconds at the
beginning and end of the file.

Figure 231. Fade Filter Settings

Fade-In Time (Seconds)

Fade-Out Time {Seconds)

Fade In Time. Use the slider (or set the integer value manually) to set the fade-in time
in seconds from the beginning of the clip.

Fade Out Time. Use the slider to set the fade-out time in seconds from the end of the
clip.

High Pass/Low Pass Filter

Episode 6.5

Use the high pass/low pass filter to trim selected frequency thresholds from your
output audio file. For example, you may want to enable high pass filtering and trim
frequencies near the top range to eliminate hiss in the recording.

Figure 232. High Pass/Low Pass Filter Settings.

"4 High Pass (Hz) 100

v Low Pass (kHz) 10
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High Pass. Check to activate high pass filtering and cut off all frequencies below the
specified threshold value you enter. Range: 10 Hz to 1000 Hz.

Low Pass. Check to activate low pass filtering, and cut off all frequencies above the
threshold value you enter. Range: 1 to 20 kHz.

Offset Filter

Use the offset filter to advance or retard the audio track in the output file.

If the audio in your source is ahead or behind the video track, you can synch it using
this filter.

Figure 233. Offset Filter Settings

Offset (ms). Use the slider (or enter the value manually) to provide a negative or
positive offset (in milliseconds) to the audio track to compensate for timing differences
between audio and video tracks.

Sample Rate Filter

Use the sample rate filter to specify the audio sample rate in the output file. The audio
sample rate is the number of samples per second in the audio track. Higher sample
rates allow higher sound frequencies to be reproduced.

The Nyqvist frequency is the highest reproducible sound frequency, which is half the
frequency at which the clip is sampled. For example, choosing 16 kHz as the sample
frequency allows you to encode audible frequencies up to 8 kHz.

Note: Not all formats allow all sample rates supported by a given codec.

Figure 234. Sample Rate Filter Settings

Sample Rate 24100 Hz v

Sample Rate. Select the audio sample rate to use in the output file from the options in
the dropdown menu.

Volume Filter

Use the volume filter to modify the volume of the audio tracks in the file.
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Figure 235. Volume Filter Settings

Adjustment Mode. Select Normalize | Adjust in Percent | Adjust in dB from the dropdown
menu.

Normalize. Select to analyze the audio stream by looking for the loudest peak in the
audio channel and then encodes with this value as a reference, to avoid any clipping or
distortion in the sound. Specify the percent in the slider below. For example, if set to
90%, this option sets the highest peak in any audio channel at 90% of full volume and
adjusts the rest of the channels in linear correspondence.

Adjust in percent. Select to change the volume by the percent you specify in the
percent slider below. Set the slider to select the percent of change. The default value is
0% (no change).

Adjust in dB. Select to change the volume by the dB you specify. Set the slider to select
the dB of change. The default is 0 dB (no change).
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Appendix: Default Channel Maps

Channels Filter and Channel Mapper Notes
o Multiple track output is only supported by PCM, AES, and BWF audio.

For advanced users who want the details of audio channel mapping, the following

appendix presents the default mappings of the Channels filter.

» The Channels Filter should always be preferred over the Channel Mapper.

Channels Filter Notes

» When converting to Dual or Triple Stereo from sources that have more than 4 or 6

channels, those extra channels will be dropped.

Channels Filter Mappings

The following pages list the default mappings built into the Channels filter selections.

MONO source to MONO:
1 =>Track 1, Channel 1 (Unused)

MONO source to STEREO:
1 =>Track 1, Channel 1 (Left)
1 =>Track 1, Channel 2 (Right)

MONO source to DUAL STEREO:
1=>Track 1, Channel 1 (Left)

1 =>Track 1, Channel 2 (Right)

1 =>Track 2, Channel 1 (Left)

1 => Track 2, Channel 2 (Right)

MONO source to 5.0:

1=>Track 1, Channel 1 (Left)

1 =>Track 1, Channel 2 (Right)

1 =>Track 1, Channel 3 (Center)

1 =>Track 1, Channel 4 (Left Surround)

1 =>Track 1, Channel 5 (Right Surround)
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MONO source to 5.1:

1=>Track 1, Channel 1 (Left)

1 =>Track 1, Channel 2 (Right)

1 =>Track 1, Channel 3 (Center)

1 =>Track 1, Channel 5 (Left Surround)

1 =>Track 1, Channel 6 (Right Surround)
Channel 4 (LFE) out is empty (silent)

MONO source to TRIPLE STEREO:
1=>Track 1, Channel 1 (Left)

1 =>Track 1, Channel 2 (Right)

1 =>Track 2, Channel 1 (Left)

1 => Track 2, Channel 2 (Right)

1 =>Track 3, Channel 1 (Left)

1 => Track 3, Channel 2 (Right)

MONO source to 7.1:

1=>Track 1, Channel 1 (Left)

1 =>Track 1, Channel 2 (Right)

1 =>Track 1, Channel 3 (Center)

1 =>Track 1, Channel 5 (Left Surround)

1 =>Track 1, Channel 6 (Right Surround)
1=>Track 1, Channel 7 (Left Surround Direct)

1 =>Track 1, Channel 8 (Right Surround Direct)

Channel 4 (LFE) out is empty (silent)

MONO source to 5.1+Stereo:
1=>Track 1, Channel 1 (Left)

1 =>Track 1, Channel 2 (Right)

1 =>Track 1, Channel 3 (Center)

1 =>Track 1, Channel 5 (Left Surround)

1 =>Track 1, Channel 6 (Right Surround)
1 =>Track 2, Channel 1 (Left)

Audio Filters
Appendix: Default Channel Maps
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1 => Track 2, Channel 2 (Right)
Channel 4 (LFE) out is empty (silent).

MONO source to QUAD STEREO:
1=>Track 1, Channel 1 (Left)

1 =>Track 1, Channel 2 (Right)

1 =>Track 2, Channel 1 (Left)

1 => Track 2, Channel 2 (Right)

1 =>Track 3, Channel 1 (Left)

1 => Track 3, Channel 2 (Right)

1 =>Track 4, Channel 1 (Left)

1 => Track 4, Channel 2 (Right)

STEREO source to MONO:
1 =>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)

STEREO source to STEREO:
1 =>Track 1, Channel 1 (Left)
2 =>Track 1, Channel 2 (Right)

STEREO source to DUAL STEREO:
1 =>Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left)
2 =>Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right)

STEREO source to 5.0:

1 =>Track 1, Channel 1 (Left) + Channel 3 (Center) + Channel 4 (Left Surround) +
Channel 5 (Right Surround)

2 =>Track 1, Channel 2 (Right) + Channel 3 (Center) + Channel 4 (Left Surround) +
Channel 5 (Right Surround)

STEREO source to 5.1:

1 =>Track 1, Channel 1 (Left) + Channel 3 (Center) + Channel 5 (Left Surround) +
Channel 6 (Right Surround)

2 =>Track 1, Channel 2 (Right) + Channel 3 (Center) + Channel 5 (Left Surround) +
Channel 6 (Right Surround)
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Channel 4 (LFE) out is empty (silent)

STEREO source to TRIPLE STEREO:
1 =>Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left) + Track 3, Channel 1 (Left)
2 =>Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right) + Track 3, Channel 2 (Right)

STEREO source to 7.1:

1 =>Track 1, Channel 1 (Left) + Channel 3 (Center) + Channel 5 (Left Surround) +
Channel 7 (Left Surround Direct) + Channel 8 (Right Surround Direct)

2 =>Track 1, Channel 2 (Right) + Channel 3 (Center) + Channel 6 (Right Surround) +
Channel 7 (Right Surround Direct) + Channel 8 (Right Surround Direct)

Channel 4 (LFE) out is empty (silent).

STEREO source to 5.1+Stereo:

1 =>Track 1, Channel 1 (Left) + Channel 3 (Center) + Channel 5 (Left Surround) +
Channel 6 (Right Surround) + Track 2, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Channel 3 (Center) + Channel 5 (Left Surround) +
Channel 6 (Right Surround) + Track 2, Channel 2 (Right)

Channel 4 (LFE) out is empty (silent).

STEREO source to QUAD STEREO:

1 =>Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left) + Track 3, Channel 1 (Left) +
Track 4, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right) + Track 3, Channel 2 (Right)
+ Track 4, Channel 2 (Right)

DUAL STEREO source to MONO:
1=>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)
3 =>Track 1, Channel 1 (Unused)
4 =>Track 1, Channel 1 (Unused)

DUAL STEREO source to STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 (Left)
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4 => Track 1, Channel 2 (Right)

DUAL STEREO source to DUAL STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

DUAL STEREO source to 5.0:
1=>Track 1, Channel 1 + Channel 3

2 =>Track 1, Channel 2 + Channel 3

3 =>Track 1, Channel 4

4 =>Track 1, Channel 5

DUAL STEREO source to 5.1:
Not supported; Episode job will fail.

DUAL STEREO source to TRIPLE STEREO:
1=>Track 1, Channel 1 (Left) + Track 3, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Track 3, Channel 2 (Right)
3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

DUAL STEREO source to 7.1:
Not supported; Episode job will fail.

DUAL STEREO source to 5.1+Stereo:
Not supported; Episode job will fail.

DUAL STEREO source to QUAD STEREO:

1=>Track 1, Channel 1 (Left) + Track 3, Channel 1 (Left) + Track 4, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Track 3, Channel 2 (Right) + Track 4, Channel 2 (Right)
3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)
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5.0 source to MONO:

1=>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)
3 =>Track 1, Channel 1 (Unused)
4 =>Track 1, Channel 1 (Unused)
5=>Track 1, Channel 1 (Unused)

5.0 source to STEREO:
1 =>Track 1, Channel 1 (Left)
2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 (Left) + Channel 2 (Right)
4 =>Track 1, Channel 1 (Left) + Channel 2 (Right)
5=>Track 1, Channel 1 (Left) + Channel 2 (Right)

5.0 source to DUAL STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 + Channel 2

4 =>Track 2, Channel 1 (Left)
5=>Track 2, Channel 2 (Right)

5.0 source to 5.0:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (Left Surround)
5 =>Track 1, Channel 5 (Right Surround)

5.0 source to 5.1:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 5 (Left Surround)

Audio Filters
Appendix: Default Channel Maps
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5 =>Track 1, Channel 6 (Right Surround)
Channel 4 (LFE) out is empty (silent).

5.0 source to TRIPLE STEREO:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left) + Track 2, Channel 2 (Right)
4 => Track 3, Channel 1 (Left)

5 => Track 3, Channel 2 (Right)

5.0 source to 7.1:

1=>Track 1, Channel 1 (Left)+ Channel 7 (Left Surround Direct)

2 =>Track 1, Channel 2 (Right) + Channel 8 (Right Surround Direct)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 5 (Left Surround) + Channel 7 (Left Surround Direct)

5 =>Track 1, Channel 6 (Right Surround) + Channel 8 (Right Surround Direct)
Channel 4 (LFE) out is empty (silent).

5.0 source to 5.1+Stereo:

1=>Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right)
3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 5 (Left Surround)

5 =>Track 1, Channel 6 (Right Surround)

Channel 4 (LFE) out is empty (silent).

5.0 source to QUAD STEREO:

1=>Track 1, Channel 1 (Left) + Track 4, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Track 4, Channel 2 (Right)
3 =>Track 2, Channel 1 (Left) + Track 2, Channel 2 (Right)
4 => Track 3, Channel 1 (Left)

5 => Track 3, Channel 2 (Right)
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5.1 source to MONO:

1=>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)
3 =>Track 1, Channel 1 (Unused)
4 =>Track 1, Channel 1 (Unused)
5=>Track 1, Channel 1 (Unused)
6 => Track 1, Channel 1 (Unused)

5.1 source to STEREO:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 (Left) + Channel 2 (Right)
4 => Track 1, Channel 1 (Left) + Channel 2 (Right)
5=>Track 1, Channel 1 (Left) + Channel 2 (Right)
6 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5.1 source to DUAL STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)
Channels 5 and 6 are dropped.

5.1 source to 5.0:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

5 => Track 1, Channel 4 (Left Surround)
6 => Track 1, Channel 5 (Right Surround)
Channel 4 (LFE) is dropped.

5.1 source to 5.1:
1 =>Track 1, Channel 1 (Left)

Audio Filters
Appendix: Default Channel Maps
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2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround)
6 => Track 1, Channel 6 (Right Surround)

5.1 source to TRIPLE STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 =>Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

5.1 sourceto 7.1:

1=>Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

2 =>Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround) + Channel 7 (Left Surround Direct)

6 => Track 1, Channel 6 (Right Surround) + Channel 8 (Right Surround Direct)

5.1 source to 5.1+Stereo:

1=>Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right)
3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

5.1 source to QUAD STEREO:
1 =>Track 1, Channel 1 (Left) + Track 4, Channel 1 (Left)
2 =>Track 1, Channel 2 (Right) + Track 4, Channel 2 (Right)

VAT
telestream Episode 6.5



Episode 6.5

3 =>Track 2, Channel 1 (Left)
4 => Track 2, Channel 2 (Right)
5 =>Track 3, Channel 1 (Left)
6 => Track 3, Channel 2 (Right)

TRIPLE STEREO source to MONO:
1=>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)
3 =>Track 1, Channel 1 (Unused)
4 =>Track 1, Channel 1 (Unused)
5=>Track 1, Channel 1 (Unused)
6 => Track 1, Channel 1 (Unused)

TRIPLE STEREO source to STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 (Left)

4 => Track 1, Channel 2 (Right)

5 =>Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

TRIPLE STEREO source to DUAL STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5 and 6 are dropped.

TRIPLE STEREO source to 5.0:
1 =>Track 1, Channel 1 (Left) + Channel 3 (Center)

2 =>Track 1, Channel 2 (Right) + Channel 3 (Center)

(
3 =>Track 1, Channel 1 (Left)
4 => Track 1, Channel 2 (Right)

Audio Filters
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5=>Track 1, Channel 4 (Left Surround)
6 => Track 1, Channel 5 (Right Surround)
Channel 4 is dropped.

TRIPLE STEREO source to 5.1:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5=>Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

TRIPLE STEREO source to TRIPLE STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 =>Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

TRIPLE STEREO sourceto 7.1:
1 =>Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

2 =>Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

3 => Track 1, Channel 3 (Center)
4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround) + Channel 7 (Left Surround Direct)

6 => Track 1, Channel 6 (Right Surround) + Channel 8 (Right Surround Direct)

TRIPLE STEREO source to 5.1+Stereo:
1 =>Track 1, Channel 1 (Left) + Track 2, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Track 2, Channel 2 (Right)

3 => Track 1, Channel 3 (Center)
4 =>Track 1, Channel 4 (LFE)
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5 => Track 1, Channel 5 (Left Surround)
6 => Track 1, Channel 6 (Right Surround)

TRIPLE STEREO source to QUAD STEREO:
1=>Track 1, Channel 1 (Left) + Track 4, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right) + Track 4, Channel 2 (Right)
3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 =>Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

7.1 source to MONO:

1=>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)
3 =>Track 1, Channel 1 (Unused)
4 =>Track 1, Channel 1 (Unused)
5=>Track 1, Channel 1 (Unused)
6 => Track 1, Channel 1 (Unused)
7 =>Track 1, Channel 1 (Unused)
8 =>Track 1, Channel 1 (Unused)

7.1 source to STEREO:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 (Left) + Channel 2 (Right)
4 => Track 1, Channel 1 (Left) + Channel 2 (Right)
5 =>Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

7 =>Track 1, Channel 1 (Left) + Channel 2 (Right)
8 => Track 1, Channel 1 (Left) + Channel 2 (Right)

7.1 source to DUAL STEREO:
1 =>Track 1, Channel 1 (Left)
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2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)
Channels 5, 6, 7, and 8 are dropped.

7.1 source to 5.0:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

5=>Track 1, Channel 1 (Left) + Channel 4 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 5 (Right Surround)
7 =>Track 1, Channel 4 (Left Back)

8 => Track 1, Channel 5 (Right Back)

7.1 source to 5.1:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5=>Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)
7 =>Track 1, Channel 5 (Left Surround)

8 => Track 1, Channel 6 (Right Surround)

7.1 source to TRIPLE STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 =>Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

Channels 7 and 8 are dropped.
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7.1 sourceto 7.1:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 =>Track 1, Channel 7 (Left Surround Direct)
8 => Track 1, Channel 8 (Right Surround Direct)

7.1 source to 5.1+Stereo:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround)
6 => Track 1, Channel 6 (Right Surround)
7 =>Track 2, Channel 1 (Left)

8 => Track 2, Channel 2 (Right)

7.1 source to QUAD STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 =>Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

7 => Track 4, Channel 1 (Left)

8 => Track 4, Channel 2 (Right)

5.1+STEREO source to MONO:
1 =>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)
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3 =>Track 1, Channel 1 (Unused)
4 =>Track 1, Channel 1 (Unused)
5=>Track 1, Channel 1 (Unused)
6 => Track 1, Channel 1 (Unused)
7 =>Track 1, Channel 1 (Unused)
8 =>Track 1, Channel 1 (Unused)

5.1+STEREO source to STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 (Left) + Channel 2 (Right)
4 =>Track 1, Channel 1 (Left) + Channel 2 (Right)
5 =>Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

7 =>Track 1, Channel 1 (Left) + Channel 2 (Right)

8 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5.1+STEREO source to DUAL STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5, 6, 7, and 8 are dropped.

5.1+STEREO source to 5.0:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

5 =>Track 1, Channel 1 (Left) + Channel 4 (Left Surround)
6 => Track 1, Channel 2 (Right) + Channel 5 (Right Surround)

7 => Track 1, Channel 4 (Left Surround)
8 => Track 1, Channel 5 (Right Surround)
Channel 4 (LFE) is dropped.
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5.1+STEREO source to 5.1:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

5=>Track 1, Channel 1 (Left) + Channel 5 (Left Surround)
6 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)

7 => Track 1, Channel 5 (Left Surround)
8 => Track 1, Channel 6 (Right Surround)
Channel 4 (LFE) is dropped.

5.14+STEREO source to TRIPLE STEREO:

1=>Track 1, Channel 1 (Left)
2 =>Track 1, Channel 2 (Right)
3 =>Track 2, Channel 1 (Left)
4 => Track 2, Channel 2 (Right)
5 =>Track 3, Channel 1 (Left)
6 => Track 3, Channel 2 (Right)
Channels 7 and 8 are dropped.

5.1+STEREO source to 7.1:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 =>Track 1, Channel 7 (Left Surround Direct)
8 => Track 1, Channel 8 (Right Surround Direct)

5.1+STEREO source to 5.1+Stereo:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

Audio Filters
Appendix: Default Channel Maps
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4 =>Track 1, Channel 4 (LFE)

5=>Track 1, Channel 5 (Left Surround)
6 => Track 1, Channel 6 (Right Surround)
7 =>Track 2, Channel 1 (Left)

8 => Track 2, Channel 2 (Right)

5.1+STEREO source to QUAD STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 =>Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

7 =>Track 4, Channel 1 (Left)

8 => Track 4, Channel 2 (Right)

QUAD STEREO source to MONO:
1=>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)
3 =>Track 1, Channel 1 (Unused)
4 =>Track 1, Channel 1 (Unused)
5=>Track 1, Channel 1 (Unused)
6 => Track 1, Channel 1 (Unused)
7 =>Track 1, Channel 1 (Unused)

8 => Track 1, Channel 1 (Unused)

QUAD STEREO source to STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 (Left)

4 => Track 1, Channel 2 (Right)

5 =>Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)
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7 => Track 1, Channel 1 (Left)
8 => Track 1, Channel 2 (Right)

QUAD STEREO source to DUAL STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5, 6, 7, and 8 are dropped.

QUAD STEREO source to 5.0:

1=>Track 1, Channel 1 (Left) + Channel 3 (Center)

2 => Track 1, Channel 2 (Right) + Channel 3 (Center)
3 =>Track 1, Channel 1 (Left)

4 => Track 1, Channel 2 (Right)

5 =>Track 1, Channel 4 (Left Surround))

6 => Track 1, Channel 5 (Right Surround)

7 =>Track 1, Channel 4 (Left Surround)

8 => Track 1, Channel 5 (Right Surround)

Channel 4 is dropped.

QUAD STEREO source to 5.1:

1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5=>Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)
7 =>Track 1, Channel 5 (Left Surround)

8 => Track 1, Channel 6 (Right Surround)

Audio Filters
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QUAD STEREO source to TRIPLE STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 =>Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

Channels 7 and 8 are dropped.

QUAD STEREO source to 7.1:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 =>Track 1, Channel 7 (Left Surround Direct)
8 => Track 1, Channel 8 (Right Surround Direct)

QUAD STEREO source to 5.1+Stereo:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

(
7 => Track 2, Channel 1 (Left)
8 => Track 2, Channel 2 (Right)

QUAD STEREO source to QUAD STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)
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4 => Track 2, Channel 2 (Right)
5 =>Track 3, Channel 1 (Left)
6 => Track 3, Channel 2 (Right)
7 => Track 4, Channel 1 (Left)
8 => Track 4, Channel 2 (Right)

8 CHANNEL DISCRETE source to MONO:
1=>Track 1, Channel 1 (Unused)
2 =>Track 1, Channel 1 (Unused)
3 =>Track 1, Channel 1 (Unused)
4 =>Track 1, Channel 1 (Unused)
5=>Track 1, Channel 1 (Unused)
6 => Track 1, Channel 1 (Unused)
7 =>Track 1, Channel 1 (Unused)
8 =>Track 1, Channel 1 (Unused)

8 CHANNEL DISCRETE source to STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 1 (Left) + Channel 2 (Right)

4 => Track 1, Channel 1 (Left) + Channel 2 (Right)

5 =>Track 1, Channel 1 (Left)

6 => Track 1, Channel 2 (Right)

7 =>Track 1, Channel 1 (Left) + Channel 2 (Right)

8 => Track 1, Channel 1 (Left) + Channel 2 (Right)

8 CHANNEL DISCRETE source to DUAL STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

Channels 5, 6, 7, & 8 are dropped
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8 CHANNEL DISCRETE source to 5.0:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

5=>Track 1, Channel 1 (Left) + Channel 4 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 5 (Right Surround)
7 =>Track 1, Channel 4 (Left Surround)

8 => Track 1, Channel 5 (Right Surround)

Channel 4 is dropped.

8 CHANNEL DISCRETE source to 5.1:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 => Track 1, Channel 4 (LFE)

5=>Track 1, Channel 1 (Left) + Channel 5 (Left Surround)

6 => Track 1, Channel 2 (Right) + Channel 6 (Right Surround)
7 =>Track 1, Channel 5 (Left Surround)

8 => Track 1, Channel 6 (Right Surround)

8 CHANNEL DISCRETE source to TRIPLE STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 => Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 =>Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

Channels 7 and 8 are dropped.

8 CHANNEL DISCRETE source to 7.1:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)
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4 =>Track 1, Channel 4 (LFE)

5=>Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)

7 =>Track 1, Channel 7 (Left Surround Direct)
8 => Track 1, Channel 8 (Right Surround Direct)

8 CHANNEL DISCRETE source to 5.1+Stereo:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 1, Channel 3 (Center)

4 =>Track 1, Channel 4 (LFE)

5 =>Track 1, Channel 5 (Left Surround)

6 => Track 1, Channel 6 (Right Surround)
7 =>Track 2, Channel 1 (Left)

8 => Track 2, Channel 2 (Right)

8 CHANNEL DISCRETE source to QUAD STEREO:
1=>Track 1, Channel 1 (Left)

2 =>Track 1, Channel 2 (Right)

3 =>Track 2, Channel 1 (Left)

4 => Track 2, Channel 2 (Right)

5 => Track 3, Channel 1 (Left)

6 => Track 3, Channel 2 (Right)

7 =>Track 4, Channel 1 (Left)

8 => Track 4, Channel 2 (Right)

Channel Mapper Filter Details

Episode 6.5

Episode stores multichannel audio in AAC format:
e AAC5.1-C LR, Ls,Rs, LFE
e AAC7.1-CL,R, Ls,Rs, Lsd, Rsd, LFE

QuickTime format for multichannel audio is different. Center is usually channel 3, and
LFE is channel 4.

e QT5.1-L,R,C LFE Ls,Rs
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e QT 7.1-L,R,C LFE, Ls,Rs, Lsd, Rsd

A rule of thumb when mapping channels is that Center channel is first, and LFE is
always last.

When mapping channels, consider the channel labels and not the specific channel
numbers.

Channel Mapper Examples

When mapping 5.1 to 5.1, or 7.1 to 7.1, while no channel mapper is needed, you would
map all channels 1 to 1:

1=>Track 1, Channel 1
2 =>Track 1, Channel 2
3 =>Track 1, Channel 3
4 =>Track 1, Channel 4
5=>Track 1, Channel 5
6 => Track 1, Channel 6
7 =>Track 1, Channel 7
8 =>Track 1, Channel 8

Example Mapping 7.1 to 5.1+Stereo:

The Channel filter should be used. The mappings would be as follows:
1=>Track 1, Channel 1 (Center)

2 =>Track 1, Channel 2 (Left)

3 =>Track 1, Channel 3 (Right)?

4 =>Track 1, Channel 4 (Left Surround)

5 =>Track 1, Channel 5 (Right Surround)

6 => Track 2, Channel 1 (Left Surround Direct)

7 => Track 2, Channel 2 (Right Surround Direct)

8 =>Track 1, Channel 6 (LFE)

Example Mapping 8 Channels to 8 Tracks, 1 Channel Each:
1=>Track 3, Channel 1

2 =>Track 1, Channel 1
3 =>Track 2, Channel 1
4 =>Track 5, Channel 1
5 =>Track 6, Channel 1
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6 => Track 7, Channel 1
7 => Track 8, Channel 1
8 => Track 4, Channel 1
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Troubleshooting
Episode

The following topics explain how to resolve typical troubleshooting questions. If the
suggested fixes don't resolve an issue, or if you have an issue that is not listed below,
please contact Telestream Customer Service (see Preface for contact information).

m Episode won't install.

m Episode won't run from my user account.

m Episode won't transcode some of my files.

m Episode supports my file type but won't transcode it.

m Episode reports a license error, but | have a valid license.

m A preview error occurred: Could not find DefaultSource.mov.
m Access Denied |OServer issues

m Where should | direct my Pipeline stream?

m Episode clustering and file sharing don’t work.

Episode won't install.

Before you can install Episode, your system must meet certain prerequisites, including
the correct operating system and supporting application versions. Review Installing
Episode or the Episode download page at Telestream.net for a list of prerequisites, and
make sure the required OS and software are installed before you attempt to install
Episode.

Episode won’t run from my user account.

If Episode indicates you do not have the proper privileges to run it, see the
Configuration topic in Installing Episode.

S
telestream


http://www.telestream.net

354 | Troubleshooting Episode
Episode won't transcode some of my files.

Episode won’t transcode some of my files.

See Media Containers/Formats for a list of file types supported by Episode. Episode
includes a very wide variety of codecs for most formats, but the file format you are
attempting to decode or encode may not be supported.

Episode supports my file type but won’t transcode

it.

If the file type is listed in Media Containers/Formats and the file still wont transcode,
verify that the file itself is not damaged by playing it in the appropriate player
application. If the file is good, try transcoding it in Episode to a different output file
format. Then transcode the resulting file in Episode to the desired output file format.

Episode reports a license error, but | have a valid

license.

The license file may be corrupted.

First, deactivate your license—select Preferences > License menu. Then, close Episode.
Next, delete the Episode Node. XML file from the Episode application data folder.
Windows 7|8 & Server 2008|2012: C:\ProgramData\Telestream\Episode 6\Node.xml|

Now, restart Episode, and reactivate your license using Preferences > License.

A preview error occurred: Could not find
DefaultSource.mov.

Go to Episode Preferences and change Default Preview Source to DefaultSource.mov.

The DefaultSource.mov file is stored in this folder on Windows: C:\Program Files
(x86)\Telestream\Episode 6\bin\resources\DefaultSource.mov.

Access Denied IOServer issues

Active watch folder workflows may have their IOServer (the service that handles the
actual sharing of locations in the cluster) time out because of inactivity if they are
completely idle and haven't picked up any files for extended periods of time (default 7
days). If this occurs, files dropped into the monitored location are picked up by the
monitor service, but the |OServer no longer recognizes the location as a valid share and
fails to process the files, causing an Access Denied error in the job.

To resolve this issue, modify the <dynamic-share-keep-time> option in the
I0Server.xml file to a higher value (in seconds).
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Where should | direct my Pipeline stream?

The I0Server.xml file resides in these locations:

* MacOS X: ~/Library/Application Support/Episode/
(Lion users: if your library is hidden, run this terminal command:
chflags nohidden ~/Library)

» Windows 7|8|Server 2008|2012: C:\ProgramData\Telestream\Episode 6\|0S-
erver.xml
Change the number in this line of the 10Server.xml file to specify a timeout greater than
604800 seconds (7 days—the current default value):
<dynamic-share-keep-time>604800</dynamic-share-keep-time>

For example, to set this option to one year, change it to 31449600.

Where should | direct my Pipeline stream?

Point your Pipeline output, which must be set to deliver TIFO files, to the same folder
that will be watched by your Episode workflow. Episode's watch folder must be
configured with the Encode While Ingest option enabled so it will pick up the TIFO file
right away instead of waiting for it to be completed first. These are the steps:

1. Set Pipeline to deliver TIFO wrapped content.
2, Point the TIFO Pipeline output to the folder monitored by Episode.

3. Set your Episode workflow to watch the Pipeline output folder, and select the
Encode While Ingest option. This ensures the file is transcoded by Episode while it is
being built by Pipeline instead of waiting until the file is complete.

Episode clustering and file sharing don’t work.

If the ports Episode uses for file sharing and clustering are blocked by the firewall,
clustering and 10 server file sharing are prevented. Episode may display, “Node Won't
Connect Error”.

Episode uses many ports between 40410 and 40440. Open your computer’s firewall
configuration and set it to open these ports for Episode. The easiest way to do this is to
specify that the range of ports from 40410 to 40440 should be open to Episode.

Also, try uninstalling and re-installing Bonjour to solve this problem if it is not a firewall
issue.
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.Net Framework 3.5, required 34

Numerics

3G 142

3g2 file extension 148, 151
3gp file extension 145

3GPP 155, 308, 310
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3GPP2 (3gp2) format 148
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a52 file extension 152

AAC audio 162

AAC Audio codec 307
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aac file extension 153
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AC-3 (ATSC A/52) audio codec 311
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Advanced Audio Coding
See AAC audio codec 308
advanced frame rate filter 277
Advanced Preferences 124
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AES Codec 310
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AIFF format 154
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AMR 310
AMR audio codec 310
AMR Codec 310
amr file extension 155
AMR format 155
anamorphic MPEG2, in Resize filter 293
anamorphic, compensating for in Resize filter 295
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anamorphic, in Watermark Resize filter 302, 304
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aspect ratio, setting in some formats 139
ATSCA/52 Format 152
ATSC A/52, see AC-3 audio codec 311
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audio filters, how applied 320
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audio sample rate filter 326

audio speed filter 320

Audio Video Interleave format 156
audio volume filter 326

Autodesk Wiretap bookmarks, configuring 68
AVC (H.264) video codec 212

AVC (x264) video codec 218
AVC-Intra video codec 199

avi file extension 156
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balance (audio) filter 320

black and white restoration filter 279
Blackmagic video codec 200
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BMP 113

Bonjour for Windows, required 34
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BWF audio codec 311

BWF Codec 311
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Configuring Episode 38
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D
D 246
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D-10, setting display aspect ratio in 139
D-10/IMX video codec 201

DASH streaming video codec 157
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Default Audio Channel Maps 328
deinterlace filter 282
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deinterlacing 98, 137
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Deployments, System 103
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Discard video option 202

display aspect ratio 293, 302
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DV video codec 205
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EIA 246
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File List Source Task 80

File Menu 129

File Views 70

Files to a Workflow 70
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H.264 (x264), codec 218

HDV 246
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HE-AAC, see AAC audio codec. 308
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Media Browser Men 131
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mobile phone, use of 3GPP2 in 148
mobile phones, use of 3GPP in 145
Monitor Watch Folder 81

Motion JPEG video codec 240

mov file extension 164

MOV Format 164

MOV format 164

mp3 file extension 170

MP3 format 170

MP4 (MPEG-4) format 171

mp#4 file extension 171, 189

MPEG 245, 246

MPEG Audio Codec 314

MPEG Audio format 173

MPEG disclaimers 9

MPEG Program Stream 176

MPEG-1 170, 174, 243, 314

MPEG-1 audio codec 314

MPEG-1 Audio Layer lll 170

MPEG-1 elementary stream 173, 174
MPEG-1 Layer lll audio codec 312

MPEG-1 video codec 241

MPEG-2 314

MPEG-2 anamorphic, Watermark Resize 302
MPEG-2 elementary stream 175

MPEG-2 transport stream 177

MPEG-2 video codec 243

MPEG-2 VOD video codec 248

MPEG-2, anamorphic, in Resize filter 293
MPEG-2, better used in 1500 Kbps and above 241
MPEG-2, compression, used in HDV codec 230
MPEG-2, display aspect ratio 295

MPEG-2, display aspect ratio information in 305
MPEG-2, form of D-10/IMX 201

MPEG-2, setting display aspect ratio in 139
MPEG-2, writing closed captions to 300

VT
telestream

MPEG-2, XDCAM HD based on 273

MPEG-4 163
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PCM Codec 315

Picture resolution 138

PlayStation Portable 189

PNG 113
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Preview Menu 132

Preview Window 112
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ProRes video codec 253
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QuickTime 296, 310, 315

QuickTime AAC audio codec 310

QuickTime audio codecs 315

QuickTime Codec 315

QuickTime format 164

QuickTime video codecs 254
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QuickTime, pixel aspect in Watermark Resize 305
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resize filter 292
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RGB Levels video codec 255
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SBR 308
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Shortcuts 133
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SMPTE 278M 181
SMPTE 356M 201
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SMPTE 377M 181
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SMPTE331M, see AES audio codec 310
Sony 273
Sony XDCAM unique MXF version 186
Source Task Template 79
Source Task, Watch Folder 80
Source Tasks, configuring 92
space converter filter 281
Spectral Band Replication 308
Split-and-Stitch Encoding, defined 49
Split-and-Stitch Panel 100
SSL 58, 69, 84, 107
Status Panel 109
Supplemental Enhancement Information 216
SVCD 139
swf file extension 160
SWF format 160
System Deployments 103
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technical support 27
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Telestream Intermediary Format 190

Telestream, contacting 27
TGA 257

TGA sequence codec 257
TIFF 113, 259

tifo file extension 190
TIFO format 190
timecode converter filter 298
timecode, configuring 98
TLS 68

Tools Menu 131

Touring Episode 45
trademark notices 2
transparency 290
troubleshooting 353

ts file extension 177
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Uncompressed 4:2:2 137
Update Preferences 123
Upgrading Episode 43
user deployments 103
Using Episode 45

Vv

VBI 299

VBI exporter filter 299

VBI Importer Filter 299

VBl importer filter 299

VC-1 video codec 268

VCD 295, 304

Vertical Blanking Interval 299
VHS 291

Video Buffer Verifier 141
video fade filter 285

video field order filter 286
Video Filters Panel 99

video filters, generally 276
video filters, how applied 276
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Video scan 137

video sharpen filter 297

video watermark filter 300
video watermark resize filter 301
View Menu 130

volume (audio) filter 326
Vorbis audio codec 316

Vorbis Codec 316

VP-6 (Flash 8) video codec 206
VP8 video codec 261
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w

warranty 10

Warranty and Disclaimers 10

Watch Folder 81

Watch Folder Source Task 80

Watch Folder, using FTPS 68
watermark filter 300

watermark resize filter 301

WAV 311

wav file extension 192

WAV format 192

webm file extension 193

WebM format 193

Windows Media Audio 9 Codec 317
Windows Media Audio 9 codec 317
Windows Media format 194

Windows Media VC-1 video codec 268
Windows Media Video 9 video codec 264
Windows RGB video codec 271
Windows share bookmarks, configuring 68
Wiretap bookmarks, configuring 68
wma file extension 194

WMA format 194

Workflow Context Menu 77

Workflow Editor 63, 75

Workflow Priority 88

Workflows, defined 47

Workflows, submitting 88

X
X264 H264 codec 218
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